Notices

For details, see the following topics:

• Documentation copyright notice

Documentation copyright notice

©2013 Progress Software Corporation and/or its subsidiaries or affiliates. All rights reserved.

These materials and all Progress® software products are copyrighted and all rights are reserved by Progress Software Corporation. The information in these materials is subject to change without notice, and Progress Software Corporation assumes no responsibility for any errors that may appear therein. The references in these materials to specific platforms supported are subject to change.
Apama, Business Empowerment, Business Making Progress, Corticon, Corticon (and design), DataDirect (and design), DataDirect Connect, DataDirect Connect64, DataDirect XML Converters, DataDirect XQuery, Empowerment Center, Fathom, Making Software Work Together, OpenEdge, Powered by Progress, PowerTier, Progress, Progress Control Tower, Progress Dynamics, Progress Business Empowerment, Progress Empowerment Center, Progress Empowerment Program, Progress OpenEdge, Progress Profiles, Progress Results, Progress RPM, Progress Software Business Making Progress, Progress Software Developers Network, ProVision, PS Select, RulesCloud, RulesWorld, SequeLink, SpeedScript, Stylus Studio, Technical Empowerment, WebSpeed, Xcalia (and design), and Your Software, Our Technology—Experience the Connection are registered trademarks of Progress Software Corporation or one of its affiliates or subsidiaries in the U.S. and/or other countries. AccelEvent, Apama Dashboard Studio, Apama Event Manager, Apama Event Modeler, Apama Event Store, Apama Risk Firewall, AppsAlive, AppServer, BusinessEdge, Cache-Forward, DataDirect Cloud, DataDirect Spy, DataDirect SupportLink, Future Proof, High Performance Integration, OpenAccess, ProDataSet, Progress Arcade, Progress ESP Event Manager, Progress ESP Event Modeler, Progress Event Engine, Progress RFID, Progress Responsive Process Management, Progress Software, PSE Pro, SectorAlliance, SeeThinkAct, SmartBrowser, SmartComponent, SmartDataBrowser, SmartDataObjects, SmartDataView, SmartDialog, SmartFolder, SmartFrame, SmartObjects, SmartPanel, SmartQuery, SmartViewer, SmartWindow, WebClient, and Who Makes Progress are trademarks or service marks of Progress Software Corporation and/or its subsidiaries or affiliates in the U.S. and other countries. Java is a registered trademark of Oracle and/or its affiliates. Any other marks contained herein may be trademarks of their respective owners.

See Table of Contents for location of Third party acknowledgements within this documentation.
Table of Contents

Preface...........................................................................................................................................13
   About this documentation..............................................................................................................13
   User types.....................................................................................................................................13
   Information on documentation.....................................................................................................14
   Conventions used in this manual.................................................................................................15
   Product support contact information............................................................................................16

Chapter 1: OpenEdge Business Process Server overview......................17
   Business Process Server components..........................................................................................19
   How Business Process Server works..........................................................................................21
   Business Process Server user types.............................................................................................22

Chapter 2: Getting started...........................................................................25
   Logging in to Business Process Portal..........................................................................................27
   Using themes..................................................................................................................................28
   Exploring Business Process Portal...............................................................................................28
      Business Process Portal page layout........................................................................................29
      Business Process Portal keyboard shortcuts...........................................................................30
      Using filter bars........................................................................................................................31
      Sorting a column.......................................................................................................................32
      Grid Search..............................................................................................................................33
      Rearranging column order.........................................................................................................34
      Navigating through the list.........................................................................................................34
      Drilling down............................................................................................................................35
      Selecting and clearing rows.......................................................................................................35
      Printing.....................................................................................................................................36
   Getting support............................................................................................................................36
   Accessing help...............................................................................................................................37
   Finding Business Process Server details......................................................................................37
   Logging out of Business Process Portal.........................................................................................37

Chapter 3: Basic Operations..........................................................................39
   Specifying a Date..........................................................................................................................39
   Searching Users............................................................................................................................40
      Searching Group.......................................................................................................................41
Chapter 4: Introducing the Administration module.................................43
  Starting all servers.........................................................................................44
    Starting all servers in Windows.................................................................44
    Starting all servers in UNIX.................................................................44
  Starting individual servers...........................................................................45
    Starting Business Process Server from Windows........................................45
    Starting Business Process Servers from Administration..........................45
    Using the application server Admin Console..........................................46
  Single sign-on in Business Process Portal....................................................46
    Accessing Administration module.............................................................47
  Running Business Process Server as a Windows service.................................47
  Customizing Business Process Server..........................................................48
  Exploring the Administration module interface..........................................48
  Accessing Business Process Server components.........................................48
  Suspending/Resuming individual Business Process Servers..........................50
  Stopping individual Business Process Servers............................................51
    From Windows............................................................................................51
    From Business Process Portal.................................................................51
  Logging out of Business Process Portal.........................................................51
  Stopping all servers.........................................................................................51
    Stopping in Windows...................................................................................52
    Stopping in UNIX.......................................................................................52
    Signed applets............................................................................................52

Chapter 5: Configuring Business Process Server........................................55
  Using the OEBPS configuration interface.......................................................55
    Updating OEBPS configuration.................................................................55
  SSL security for Business Process Portal modules........................................57
    SSL security Features..................................................................................57
    Securing network communication between Business Process Server components..................................................................................58

Chapter 6: Configuring BPM Workflow.......................................................59
  Using the BPM Workflow configuration interface.........................................59
    Configuration parameters for BPM Workflow in Business Process Portal........60
    Troubleshooting BPM Workflow configuration.........................................61

Chapter 7: Configuring Business Process Portal........................................63
  Using the Business Process Portal configuration interface...........................64
    Configuration parameters for Business Process Portal.............................64
    Troubleshooting Business Process Portal configuration.............................66
    Troubleshooting the Home module.........................................................66
Chapter 8: Configuring BP Server..............................................................69
Understanding the role of BP Server.............................................................70
BP Server property files......................................................................................70
Publishing BP Server applications......................................................................71
  Understanding the process flow........................................................................71
  Suspending the BP Server................................................................................71
Using the BP Server configuration interface......................................................72
  BP Server configuration parameters...............................................................72
Using the BPM Process Store configuration interface......................................75
  Configuring BPM Process Store....................................................................75
  Reloading the configuration parameters.........................................................77
Using the email server configuration interface................................................77
  Email server configuration parameters..........................................................78
Using BP Server admin......................................................................................79
Troubleshooting BP Server configuration.........................................................79

Chapter 9: Configuring BPM Events...........................................................81
Using the BPM Events configuration interface...............................................81
  BPM Events configuration parameters........................................................82
Loading applications and recovering applications............................................83

Chapter 10: Using the Log Viewer...............................................................85
Viewing log files...............................................................................................86
Configuring the log...........................................................................................87
  Setting log levels with log4j............................................................................87
  The logging appenders..................................................................................87
Using the log configuration interface...............................................................87
  Configuring the log from Business Process Portal.........................................88
Log configuration.............................................................................................88

Chapter 11: Managing event channels............................................................93
Managing event channels................................................................................93
  Displaying information about an event channel..........................................93
  Adding event channels...............................................................................94
  Deleting channels.......................................................................................95
  Updating event channel information.........................................................96

Chapter 12: Working with administrative filters..............................................97
Managing administrative filters........................................................................97
<table>
<thead>
<tr>
<th>Chapter 17: Using the audit events page</th>
<th>137</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit events page</td>
<td>137</td>
</tr>
<tr>
<td>Viewing an audit trail of events</td>
<td>138</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 18: Managing users</th>
<th>143</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring user management</td>
<td>143</td>
</tr>
<tr>
<td>Using OEHybrid realm for Single Point of Authentication</td>
<td>145</td>
</tr>
<tr>
<td>Using the LDAP realm</td>
<td>148</td>
</tr>
<tr>
<td>Using the LDAP hybrid realm</td>
<td>150</td>
</tr>
<tr>
<td>Modifying the realm type</td>
<td>151</td>
</tr>
<tr>
<td>Using setupOEBPS to clean or set up component data</td>
<td>152</td>
</tr>
<tr>
<td>Managing user accounts</td>
<td>152</td>
</tr>
<tr>
<td>Displaying user information</td>
<td>153</td>
</tr>
<tr>
<td>Creating users</td>
<td>154</td>
</tr>
<tr>
<td>Deleting users</td>
<td>156</td>
</tr>
<tr>
<td>Updating user information</td>
<td>156</td>
</tr>
<tr>
<td>Viewing group memberships</td>
<td>158</td>
</tr>
<tr>
<td>Viewing queue memberships</td>
<td>158</td>
</tr>
<tr>
<td>Managing user permissions</td>
<td>159</td>
</tr>
<tr>
<td>Refreshing user cache</td>
<td>160</td>
</tr>
<tr>
<td>Password policy</td>
<td>161</td>
</tr>
<tr>
<td>Delegating tasks to users</td>
<td>161</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 19: Managing groups</th>
<th>163</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managing group accounts</td>
<td>163</td>
</tr>
<tr>
<td>Displaying group information</td>
<td>164</td>
</tr>
<tr>
<td>Creating groups</td>
<td>165</td>
</tr>
<tr>
<td>Deleting groups</td>
<td>166</td>
</tr>
<tr>
<td>Updating group information</td>
<td>166</td>
</tr>
<tr>
<td>Managing group permissions</td>
<td>167</td>
</tr>
<tr>
<td>Managing members in groups</td>
<td>168</td>
</tr>
<tr>
<td>Managing favorites</td>
<td>171</td>
</tr>
<tr>
<td>Displaying list of favorites</td>
<td>171</td>
</tr>
<tr>
<td>Adding favorite links</td>
<td>172</td>
</tr>
<tr>
<td>Deleting favorites</td>
<td>173</td>
</tr>
<tr>
<td>Updating favorites information</td>
<td>174</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 20: Managing work item queues</th>
<th>175</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding work item queue management</td>
<td>175</td>
</tr>
<tr>
<td>Managing work item queues</td>
<td>176</td>
</tr>
<tr>
<td>Displaying work item queues</td>
<td>176</td>
</tr>
</tbody>
</table>
Chapter 21: Managing access control........................................183
  Butterfly model of security..................................................184
  Accessing access control parameters....................................184
    Business Process Server resource hierarchy......................184
    Business Process Server user and group permissions...........189
  Listing all permissions.....................................................189
  Creating permissions.......................................................190
  Removing permissions......................................................191
  Granting/Revoking permissions to users or groups................192
  Granting application permission to managers......................192
  Working with permissions................................................193
    Business Process Server permissions..............................193
    BPM Events permissions................................................196
    Management permissions................................................197
    Administration permissions..........................................201
    Dashboard permissions................................................206

Chapter 22: Managing applications........................................209
  Managing Business Process Server applications..................209
    Installing Business Process Server applications.................211
    Viewing installed BP Server applications..........................212
  Suspending and resuming applications................................213
    Suspending installed Business Process Server applications...213
    Resuming suspended applications....................................213
  Publishing Business Process Server applications as Web Services...214
    Unpublishing Business Process Server application Web Services...214
  Versioning of Business Process Server applications..............215
  Managing BPM Workflow applications................................215
    Installing BPM Workflow applications..............................216
    Uninstalling BPM Workflow applications..........................217

Chapter 23: Migrating instances..............................................219
  Using Business Process Portal interface..............................220
    Defining a migration map...............................................220
    Rules and restrictions for mapping..................................223
    Defining an instance filter.............................................224
  Migrating instances........................................................225
    Viewing migration map’s execution history.......................226
Using the migration utility.................................................................227
instancemigration.................................................................................227
undoinstancemigration.......................................................................228

Appendix A: Third-party acknowledgments..........................................229

Glossary.................................................................................................265
Preface

For details, see the following topics:

• About this documentation
• User types
• Information on documentation
• Conventions used in this manual
• Product support contact information

About this documentation

This guide is part of the documentation set for Progress OpenEdge Business Process Server.

User types

Progress OpenEdge Business Process Server is a business process management system that can be used by the following types of users:
<table>
<thead>
<tr>
<th>User type</th>
<th>Responsibilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Manager</td>
<td>Responsible for automating business processes in a particular business domain. Business Process Portal’s Management module serves as the primary interface to Business Process Server for the Manager, enabling the manager to monitor, analyze, and control business processes. Also uses the Business Process Modeler for modeling and simulation.</td>
</tr>
<tr>
<td>Application Developer</td>
<td>Responsible for creating customized applications for implementing business processes and developing interfaces associated with tasks. Application developers may work closely with Managers to define the requirements of an application, and determine the business processes.</td>
</tr>
</tbody>
</table>

Information on documentation

This documentation includes information for the entire range of Progress OpenEdge Business Process Server users. In the following table, we recommend the guides that are most relevant to each type of user.

<table>
<thead>
<tr>
<th>If you are the …</th>
<th>Read the …</th>
</tr>
</thead>
</table>
                      *First Steps Guide*  
                      *Terminology Guide* |
| Manager          | *Business Process Portal Manager’s Guide*  
                      *Business Process Portal User's Guide*  
                      *Terminology Guide* |
If you are the ... | Read the ...
--- | ---
Application Developer | Application Developer’s Guide
BP Server Developer’s Guide
BPM Events User’s Guide
Business Process Portal Manager’s Guide
Business Process Portal User’s Guide
OpenEdge Getting Started: Developing BPM Applications with Developer Studio
Customization Guide
Managed Adapters Guide
First Steps Guide
Terminology Guide
Server Administrator’s Guide
Web services Developer’s Guide

Business Process Server Administrator | BPM Events User’s Guide
Business Process Portal Administrator’s Guide
Business Process Portal Manager’s Guide
Business Process Portal User’s Guide
OpenEdge Getting Started: Installation and Configuration Guide
Managed Adapters Guide
Terminology Guide
Server Administrator’s Guide
Troubleshooting Guide for Administrators

For the latest Business Process Server documentation updates, see OpenEdge Product Documentation on PSDN (http://communities.progress.com/pcom/docs/DOC-16074).

Conventions used in this manual

This document uses the following conventions and terminology notations.

<table>
<thead>
<tr>
<th>Convention (styles and terms)</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold</strong></td>
<td>Indicates titles of command buttons, check boxes, options, lists, dialog boxes, and portal page names.</td>
</tr>
<tr>
<td>file path</td>
<td>Indicates folder paths and filenames.</td>
</tr>
<tr>
<td><em>italic</em></td>
<td>Indicates book titles.</td>
</tr>
</tbody>
</table>
### Convention (styles and terms)

<table>
<thead>
<tr>
<th>Represented as</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>monospace</code></td>
<td>Represents code segments or examples.</td>
</tr>
<tr>
<td><code>\</code> or <code>%</code></td>
<td>Indicates the path in Windows environment. For UNIX environment, replace with forward slash <code>/</code>.</td>
</tr>
<tr>
<td><code>OEBPS_HOME</code> or <code>%OEBPS_HOME%</code></td>
<td>Represents the installation folder of Business Process Server, <code>C:\Progress\OpenEdge\oebpm\server</code>.</td>
</tr>
<tr>
<td><code>STUDIO_HOME</code> or <code>%STUDIO_HOME%</code></td>
<td>Represents the installation folder of OpenEdge BPM components, <code>C:\Progress\OpenEdge\oebpm\studio</code>.</td>
</tr>
<tr>
<td><code>JBOSS_HOME</code> or <code>%JBOSS_HOME%</code></td>
<td>Represents the installation folder of JBOSS server, <code>C:\Progress\OpenEdge\oebpm\jboss</code>.</td>
</tr>
</tbody>
</table>

### Product support contact information

If the product documentation does not provide a solution to your specific issue, or if you need clarification on the issue, then contact our Product Support team. You can contact the team through the Internet, telephone, or postal mail, as per the details provided in Table 1 on page 16.

**Table 1: Product Support Contact Information**

<table>
<thead>
<tr>
<th>To contact by</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web site</strong></td>
<td><a href="http://progresslink.progress.com/supportlink">http://progresslink.progress.com/supportlink</a></td>
</tr>
<tr>
<td></td>
<td>If you are an existing customer, then you can log in to the above site for product support. If you are a first time user, then you need to create an account first.</td>
</tr>
<tr>
<td><strong>Telephone</strong></td>
<td>1-781-280-4999 for US, Latin America and Canada</td>
</tr>
<tr>
<td></td>
<td>1-781-280-4543 for the Product Support Fax Line</td>
</tr>
<tr>
<td><strong>Postal Address</strong></td>
<td>Progress Software Corporation</td>
</tr>
<tr>
<td></td>
<td>14 Oak Park Drive</td>
</tr>
<tr>
<td></td>
<td>Bedford, MA 01730, USA.</td>
</tr>
</tbody>
</table>

To enable us to quickly answer your questions, please provide the following information:

- Your name, installation site address and the license key for Business Process Server software.
- Your Business Process Server version and build number.
- Your operating system, application server and browser, with version and service pack details, if any.
- Your database management system and version, and information on JVM and JDBC used.

---

1 For support telephone numbers and offices in your region, visit the support web site above. This contact information is for customer support only.
OpenEdge Business Process Server overview

Progress Software Corporation is a leading global provider of automated business process management solutions. The company’s product, Progress OpenEdge Business Process Server (henceforth referred to as Business Process Server or BP Server), is a comprehensive business process management platform, which enables companies to quickly transform their business processes into flexible and manageable Web applications, distributed over intranets, extranets, and the Internet.
Business Process Server addresses every stage in the business life cycle: define, integrate, publish, monitor, analyze, improve, and control. By adopting an end-to-end approach, Business Process Server incorporates all the key elements required to meet the ever-changing demands of e-business while ensuring e-business success. By providing integrated management tools, Business Process Server lets you monitor operations proactively, modifying automated processes dynamically based on changing external operations online. An overview of a typical automated business process management solutions is shown in Figure 1 on page 18.

**Figure 1: Business Process Server overview**
Business Process Server is a suite of integrated components that enables you to easily build intranet, extranet, and Internet applications and manage your e-business. Business Process Server consists of the following components as in Figure 2 on page 19:

**Figure 2: Business Process Server components**
### Table 2: Business Process Server components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Process Portal Home</td>
<td>The Home module of Business Process Portal is the primary interface for application users, enabling them to interact with Business Process Server applications. Users can complete entries to various tasks and applications, and link to the support infrastructure required to complete these tasks.</td>
</tr>
<tr>
<td>Business Process Portal Management</td>
<td>The Management module enables managers to query, report on, and control processes and resources, visible only to the managers.</td>
</tr>
<tr>
<td>Business Process Portal Administration</td>
<td>The Administration module enables Business Process Server Administrators to modify configuration parameters, manage user or group access control, and install or uninstall Business Process Server applications.</td>
</tr>
<tr>
<td>Web services</td>
<td>This component allows application developers to: publish their applications as Web services, and find and convert other available Web services on the Internet into Business Process Server applications.</td>
</tr>
<tr>
<td>BPM Workflow</td>
<td>This component provides a framework for developing and implementing Web-enabled workflow applications.</td>
</tr>
<tr>
<td>Progress Developer Studio for OpenEdge</td>
<td>This is the primary application development tool for Business Process Server, which provides an Eclipse-based integrated development environment in which users can create BPM projects, processes, Web applications, and rule files.</td>
</tr>
<tr>
<td>Business Process Modeler</td>
<td>This tool is used to design templates for basic business processes, and to run simulations of processes and individual worksteps.</td>
</tr>
<tr>
<td>BP Server</td>
<td>This is a flexible, lightweight, scalable workflow process engine for intranets, extranets, and the Internet.</td>
</tr>
<tr>
<td>BPM Events</td>
<td>This open, event-driven rule engine is used to formulate and enforce policies in business applications.</td>
</tr>
</tbody>
</table>
How Business Process Server works

Figure 3 on page 21 provides an overview of the interaction between Business Process Server components.

Figure 3: How Business Process Server works

The following explanations correspond to the labels shown in Figure 3 on page 21, and describe how the components operate.

1. Progress Developer Studio for OpenEdge and Business Process Modeler provide an integrated development environment (IDE) for Business Process Server, where you can design and publish business processes. The application developer designs a process template (with the ".spt" or ".swt" extension) in the IDE that reflects the business flow and other business process requirements. Business rules for the process template can be defined using the Rule Editor, a BPM Events component that is launched with Progress Developer Studio for OpenEdge.


3. Once the process template is defined, Business Process Server Administrators use the Administration module to install the business process on the BP Server. Administrators can also configure Business Process Server components, manage user or group access control,
and publish Business Process Server applications as Web services. Once installed, users access applications through servlets that pass the requests over an RMI/IIOP connection to the BP Server within an EJB Container.

4. The EJB Container provides a runtime environment that executes and manages Java-based program components that run on the server side of a client/server network. Within the EJB Container are the BP Server and BPM Events server.

5. The BP Server writes events to event tables in the database. Each Business Process uses JDBC to connect to database server as well as store events in the database. Within the BP Server, BPM Process Store uses JDBC to connect to the database server process and retrieve the events deposited by the BP Server process. BPM Process Store interprets the events and populates the process tables. These populated tables are used by Business Process Portal modules.

6. Once the process template is installed as a Business Process Server application, application users can use the Home module to do the following:
   - Access applications
   - Obtain information to perform their tasks
   - Launch the application to start process instances from the BP Server

7. Once the process template is installed as an Business Process Server application, managers can use the Management module (if they have access privileges) to monitor execution of process instances and create reports. Servlets receive requests from managers and pass them onto the BP Server over an RMI/IIOP connection. Managers use the Report Builder to define management reports that retrieve information through JDBC to the database server.

8. BPM Events is a rule-based event or message processing server that loads application rules and executes them against the BP Server and/or external events or messages. This server persists data in the database for recovery and with the help of JDBC connects to the database.

9. Managed Adapters exchange information between Business Process Server applications and external applications by converting Business Process Server-specific protocol to the protocol of an external system such as a database or ERP system. When users add a Managed Adapter to a workstep, they can define complex mapping between Business Process Server dataslots and adapter inputs or outputs of the external application. At runtime when the workstep is executed, the Managed Adapter sets the adapter inputs and configuration, and maps the outputs to the appropriate output dataslots.

10. BPM Workflow is a run-time component that executes the presentation flows. This component provides a Model, View, Controller (MVC) paradigm for developing presentation flow-based applications and executing them in a Web container.

11. Business Process Servers Web services component allows BP Server applications to be published as Web services.


Business Process Server user types

There are four user types within Business Process Server, Application users, Managers, Application developers, Business Process Server administrators.
User types
Each Business Process Server user type is defined below:

- **Application users** — Application Users use Business Process Server applications to coordinate specific business tasks with another department within their company, with another company within their organization, and/or with a business partner in another organization. The Home module in Business Process Portal serves as the primary interface in which Application Users run Business Process Server applications.

- **Managers** — Managers are typically experts in a particular business domain, such as quality assurance or human resources. They might need to work with managers from other groups in automating some of the business procedures that these groups share. The Management module in Business Process Portal serves as the primary Business Process Server interface for business managers to coordinate and integrate business processes, enabling them to exchange information with one another, and to share functionality over such standard communication channels as the Internet or e-mail.

- **Application developers** — Application developers are responsible for analyzing business processes and developing interfaces associated with creating tasks or processes. Application developers are often not domain experts themselves, but work closely with Managers to define business processes and determine the requirements of an application. Application developers use Progress Developer Studio for OpenEdge or Business Process Modeler to define the business process; the resulting process template file is tested, simulated, published, and run as a Business Process Server application.

- **Business Process Server administrators** — Business Process Server administrators are responsible for configuring Business Process Server components, managing user or group profiles and access control, and installing or uninstalling Business Process Server applications. The Administration module in Business Process Portal serves as the primary interface for Business Process Server Administrators to administer applications.

All Business Process Server user types can communicate by using one or more Business Process Server applications. They can also communicate with external applications.
Getting started

Business Process Server provides primary Web-based user interface in the form of Business Process Portal. It is a complete portal through which you can interact with Business Process Server applications.

When you log into Business Process Portal, it displays the Home module tab for all users, irrespective of your user type and your user permissions. As an application user, you can display and modify tasks assigned to you, and manage your preferences. Depending on your user type and permissions, you can view and access other module tabs namely, Management and Administration.

If you have Manager rights, then the Management module is also available to you, where you can query, report, and control processes and resources for users.

If you also have administrative rights, in the Administration module, then you can modify configuration parameters controlling Business Process Server operations, manage components, and install/uninstall applications.

Business Process Portal appears as in Figure 4 on page 26.
Note: Though all modules are shown to you in the figures in this guide, you can view and access only those modules for which you have access rights.

Figure 4: Overview of Business Process Portal

Table 3: Business Process Portal modules

<table>
<thead>
<tr>
<th>Module name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>As an application User, view you tasks and instance.</td>
</tr>
<tr>
<td>Management</td>
<td>As a Manager, control your processes and resources</td>
</tr>
<tr>
<td>Administration</td>
<td>As an Administrator, configure and manage components and users.</td>
</tr>
</tbody>
</table>

This chapter describes how to log into and out of Business Process Portal, the screen layout, and how to explore the Home module’s interface. As the interface is uniform for all modules, this information is helpful for other modules also.
For details, see the following topics:

- Logging in to Business Process Portal
- Using themes
- Exploring Business Process Portal
- Getting support
- Accessing help
- Finding Business Process Server details
- Logging out of Business Process Portal

Logging in to Business Process Portal

To access Business Process Portal and use it, you need to log in to it. Your Business Process Server administrator typically adds you as a new Application User, and assigns you a User Name and Password. To log in to Business Process Portal, you need to use this User Name and Password.

To log in to Business Process Portal:

1. Start the Login page according to your platform:

<table>
<thead>
<tr>
<th>Using . . .</th>
<th>Perform the following . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows 2003/XP</td>
<td>From the Start menu, choose Programs &gt; Progress &gt; OpenEdge &gt; BP Server &gt; BP Servers &gt; Start Business Process Server if you are using the installation machine (For windows only). Otherwise enter <a href="http://machine_name.domain.com:port_number/sbm/bpmportal/login.jsp">http://machine_name.domain.com:port_number/sbm/bpmportal/login.jsp</a> in your browser.</td>
</tr>
<tr>
<td>UNIX</td>
<td></td>
</tr>
</tbody>
</table>

The Login page is displayed as shown in Figure 5 on page 27.

Figure 5: Business Process Portal Login page
Note: If you are using a theme other than the default one, then the screens will look different than shown in this document. For more details, see Using themes on page 28.

2. Type your User Name and Password
3. Click Login.

Business Process Portal displays the Task List page Figure 6 on page 28.

**Figure 6: Task list**

As a typical Application User, you will have access only to the Home module. Other modules to which you may have access are displayed along with Home, as additional tabs depending on your user type and user permissions.

Tip: You can change your password any time by using Home > Profile.

---

**Using themes**

Business Process Server provides five predefined themes for Business Process Portal and for applications in the portal. Your Business Process Server administrator can select one of them. For more details, see Customization Guide.

**Exploring Business Process Portal**

When you log in to Business Process Portal for the first time, you can see the default Home tab, with the My Task page listing tasks assigned to you.

It is displayed as shown in Figure 7 on page 29.
Note: Use the Profile menu to select the language you prefer and use the Preferences menu to select a filter that sets the page's display. After configuring the Home tab, your selections are displayed the next time you log in to Business Process Portal.

Business Process Portal page layout

The terminology used for a typical Business Process Portal page is explained in Figure 7 on page 29.

Default home page

Figure 7: Default home page

The following table describes the screen terminology used for Business Process portal.

Table 4: Business Process Portal page terminology

<table>
<thead>
<tr>
<th>User interface elements</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global links</td>
<td>Located at the top right corner of every page such as Support or Help, these links are available at all times during the session. It also displays the welcome message for the user who has logged in.</td>
</tr>
<tr>
<td>Module tabs</td>
<td>For your convenience, features of different modules are grouped in sections. All features of a particular group are located in its own Module tab.</td>
</tr>
<tr>
<td>Module menus</td>
<td>Each tab has a set of specific menus. At the right side, a welcome message is displayed to the user.</td>
</tr>
<tr>
<td>Page name</td>
<td>This shows the current page name.</td>
</tr>
<tr>
<td>Link trail</td>
<td>This shows the pages you navigated through to reach the current page. You can click any link in the link trail and go back to that page. If you click a link in the link trail without first saving contents of the current page, then the data in the current page is not saved.</td>
</tr>
</tbody>
</table>
User interface elements

Workspace

Your data is displayed in this area. Generally it is displayed in one of the following ways:

- **Form**: This lets you interact with the portal. Typically, forms contain text boxes, checkboxes, and options that help you enter data. Forms can be in read-only or editable mode depending upon the contents and access privileges.

- **List**: This lets you view your data in a tabular format. Typically, lists contain filter bars, search options, and page controls that manage which data is displayed and how it should be displayed.

Command buttons and Links:

The commands that help you interact with the data are represented by buttons. Buttons that help you accomplish some task but do not change the data values are typically located below the link trail. The links (for instance, My Collaborative Tasks and Next Available Task) are located above the workspace, on the right side. Buttons that operate on the data (for instance, Complete and Reassign) shown in the current page and change their values, are located below the workspace.

---

### Business Process Portal keyboard shortcuts

Business Process Portal provides the following keyboard shortcuts to access its various module menus and menu options.

**Shortcuts**

The following table lists the keyboard shortcuts available in Business Process Portal.

#### Table 5: Keyboard shortcuts

<table>
<thead>
<tr>
<th>Module</th>
<th>Module / Menu option</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home</td>
<td>My Tasks</td>
<td>CTRL+SHIFT+T</td>
</tr>
<tr>
<td></td>
<td>My Instances</td>
<td>CTRL+SHIFT+M</td>
</tr>
<tr>
<td></td>
<td>Applications</td>
<td>CTRL+SHIFT+S</td>
</tr>
<tr>
<td></td>
<td>Dashboard</td>
<td>CTRL+SHIFT+D</td>
</tr>
<tr>
<td></td>
<td>Profile</td>
<td>CTRL+SHIFT+O</td>
</tr>
<tr>
<td></td>
<td>Preferences &gt; Filters</td>
<td>CTRL+SHIFT+F</td>
</tr>
<tr>
<td>Management</td>
<td>Overview &gt; Instances</td>
<td>CTRL+SHIFT+I</td>
</tr>
<tr>
<td></td>
<td>Overview &gt; Applications</td>
<td>CTRL+SHIFT+A</td>
</tr>
<tr>
<td></td>
<td>Reports &gt; My Reports</td>
<td>CTRL+SHIFT+R</td>
</tr>
<tr>
<td></td>
<td>Instance Manager &gt; Instances</td>
<td>CTRL+SHIFT+N</td>
</tr>
<tr>
<td></td>
<td>Instance Manager &gt; Tasks</td>
<td>CTRL+SHIFT+K</td>
</tr>
<tr>
<td></td>
<td>Instance Manager &gt; Worksteps</td>
<td>CTRL+SHIFT+W</td>
</tr>
<tr>
<td></td>
<td>Balanced Scorecard &gt; Console</td>
<td>CTRL+SHIFT+C</td>
</tr>
</tbody>
</table>
You can customize these shortcuts by adding a new one or changing an existing one as per your requirement. For more details, see the *Customization Guide*.

### Using filter bars

A filter allows you to reduce clutter and focus on the relevant data by displaying only selected data in the workspace.

**To apply a filter using the Filter bar:**

1. Specify values by either entering text in the provided text boxes or selecting them from the lists [Figure 8](#) on page 31.
2. Click Search.

The combination of these values forms a filter.

**Figure 8: Filter bar**

![Filter bar image]

### Global filters

Business Process Server now provides global filters for most common filtering conditions. They are:

**Filter names**

- Overdue Tasks
- Tasks Due Today
- Tasks Due This Week
- Tasks Due This Month
- Tasks Due This Quarter
- Tasks Due This Year
• Critical Priority Tasks
• High Priority Tasks

Note: You can select a global filter as your default filter from the Home > Profile menu. Alternately, you can use it as required.

Sorting a column

In the Home module, a downward pointing triangle beside the column header indicates that the listed items can be sorted on that column header.

To sort a column:

1. Click the column to display the sorting options.
   Refer Figure 9 on page 32.

   Figure 9: Sorting options - Task list page

   ![Figure 9: Sorting options - Task list page](image)

2. Choose the required sorting option.
   - A downward pointing triangle beside the column header indicates that the items are sorted in descending order. To sort them in ascending order, click the column header again.
   - An upward pointing triangle beside the column header indicates that the items are sorted in ascending order.

Note: From the Sorting options, you can choose only the required columns to be displayed and thus you can reduce the screen clutter.

The column sorting operation is performed differently in the Management and Administration modules.

• A column header is underlined only when you move the mouse over the column name.
• In the Management and Administration modules, if a column header is underlined, then you can click it to sort the listed items on that column header.
Grid Search

The Grid Search Text toolbar will allow you to search and highlight the given text in the current page of the grid. And this is enabled for all portal grids.

Grid Toolbar Fields

- Textbox
  You can enter the search text in this field. The search functionality is executed on every change of this textbox, so that it is not required to click search for start the searching process. All the occurrences of the given text are highlighted and the row containing the first occurrence is selected by default. A ‘clear’ button is displayed beside the textbox which enables you to clear the textbox. By default, this textbox supports regular expressions. Therefore, if your search conforms with the regular expression syntax, then Business Process Portal considers it as a regular expression, and searches accordingly.

- Previous Row and Next Row Buttons
  These buttons are enabled only when given text is found in the grid, otherwise they are disabled. These buttons help you to navigate and select one of rows which is highlighted. Tooltips are configured to indicate the use case of these buttons.

- Match Case checkbox
  You can use the ‘Match Case’ checkbox to enable case-sensitive search. By default, this checkbox is unchecked.

- Status Bar
  The ‘Status Bar’ displays the number of occurrences or matches found. The icons ‘status ok’ and ‘error status’ indicate the status of the search.
Rearranging column order

You can change the order in which the columns are displayed as per your requirement.

To change the order of columns:

Drag the column header and drop it on the column header which should succeed the selected column.

The new position of the selected column is indicated by two arrows.

Whether a particular position is permissible or not is indicated by green check mark on the selected column.

Refer Figure 12 on page 34.

Figure 12: Rearranging column order

Note: You can change the order of columns in this way only in the Home module.

Navigating through the list

The paging controls allow you to navigate through pages of the current list. These controls are located immediately above and below the list.

The number of items to be displayed per page is specified by the Business Process Server administrator in the Administration module. For more details, refer to the "Using the Portal Configuration Interface" section of the Business Process Portal Administrator's Guide. If the total number of items cannot be displayed in a page, then the exceeded items are displayed on the subsequent pages.

Refer Figure 13 on page 34.

Figure 13: Paging control - Task list page

Navigating through the pages in Home Module:

• First Page control displays the first page
• Previous Page control displays the previous page
• Next Page displays the next page
• Last Page displays the last page
• You can directly display a particular page by specifying its page number in the Page text box and pressing the Enter key.

You can click the Refresh control to reload the current page.
The top right corner of the list shows the item numbers displayed on the current page out of the total number of items.

The paging controls in the Management and Administration modules are different.

Refer Figure 14 on page 35.

**Figure 14: Paging control**

![Paging control](image)

In the Management and Administration modules, if the number of pages are 10 or less, then all page numbers up to the last page are displayed below the list.

Navigating through the pages in Management and Administration modules:

- You can click a page number to display the corresponding page.
- If the number of pages is more than 10, then, click
  - **Next** helps to access the set of next 10 pages.
  - **Previous** helps to access the set of previous 10 pages.
- The total at the far right of the paging controls represents the total number of items in the list across all pages.

**Drilling down**

If more information is available about an item in the list, then such an item is displayed with a hyperlink.

You can click the hyperlink to drill down to the next level of data and view details of that item.

Refer Figure 15 on page 35.

**Figure 15: Drilling down**

![Drilling down](image)

**Selecting and clearing rows**

**To select and clear rows:**

1. Perform either of the following to select rows:
   - You can select one or more rows of items from the list of items displayed on the current page by clicking their respective checkboxes in the first column.
   - To select all rows in the current page, select the check box in the header row.

Selected rows are indicated by different color.
Refer Figure 16 on page 36.

**Figure 16: Rows**

<table>
<thead>
<tr>
<th>No.</th>
<th>Assignment</th>
<th>Instance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Assignment</td>
<td>Assignment (2995)</td>
</tr>
<tr>
<td>2</td>
<td>Assignment</td>
<td>Assignment (2996)</td>
</tr>
<tr>
<td>3</td>
<td>Assignment</td>
<td>Assignment (2997)</td>
</tr>
<tr>
<td>4</td>
<td>Assignment</td>
<td>Assignment (2998)</td>
</tr>
<tr>
<td>5</td>
<td>Assignment</td>
<td>Assignment (2999)</td>
</tr>
<tr>
<td>6</td>
<td>Assignment</td>
<td>Assignment (3000)</td>
</tr>
<tr>
<td>7</td>
<td>Assignment</td>
<td>Assignment (3001)</td>
</tr>
<tr>
<td>8</td>
<td>Assignment</td>
<td>Assignment (3002)</td>
</tr>
<tr>
<td>9</td>
<td>Assignment</td>
<td>Assignment (3003)</td>
</tr>
<tr>
<td>10</td>
<td>Assignment</td>
<td>Assignment (3004)</td>
</tr>
<tr>
<td>11</td>
<td>Assignment</td>
<td>Assignment (3005)</td>
</tr>
<tr>
<td>12</td>
<td>Assignment</td>
<td>Assignment (3006)</td>
</tr>
<tr>
<td>13</td>
<td>Assignment</td>
<td>Assignment (3007)</td>
</tr>
<tr>
<td>14</td>
<td>Assignment</td>
<td>Assignment (3008)</td>
</tr>
<tr>
<td>15</td>
<td>Assignment</td>
<td>Assignment (3009)</td>
</tr>
</tbody>
</table>

2. Perform either of the following to clear rows:
   - To clear a particular row, click its checkbox again.
   - To clear all rows uncheck the header row, all selected rows in the page are cleared.

**Printing**

The Print icon (⎙) displays the contents of the current page in a printable format. You can use your browser’s print feature to print it.

**Getting support**

If you do not find the solution to your problem in the product documentation, then you can contact the support team.

**To contact Progress OpenEdge support team:**

1. Click **Support** from the global links.

   Your default mail tool is launched to send a mail to the support team.

2. Add your query and send the mail.
Accessing help

You can access online help from the global links.

To access online help:

• Click Help from the global links.

The help is launched in a separate browser window.

Business Process Portal provides context-sensitive help, displaying the help topic that is relevant to the current module.

Finding Business Process Server details

You can find out details about the Business Process Server using, About from the global links.

To view Business Process Server details:

• Click About from the Global links.

It displays the following details about Application Server, Database Type, Database Version, Business Process Server Version, and Build number in a pop-up window.

You need this information while contacting our support team.

Logging out of Business Process Portal

You can log out of the Business Process Server using the global links.

To quit Business Process Portal:

• Click Logout on the global links.

Basic Operations

This chapter explains the basic operations you can perform while using Business Process Portal. You can perform some or all of these operations in various Business Process Portal screens. However, all these operations may not be available in each Business Process Portal screen. For details, see the following topics:

- Specifying a Date
- Searching Users

Specifying a Date

You can specify a date by typing it in the various text boxes involving a Date (for example, Due Date, Start Date, End Date) or select using Select Date icon, which is generally located beside the Date text box.

**To specify a date using Select Date icon, perform the following:**

1. Click the Select Date icon (📅) beside the Date box.

   For a blank Date box, the Select Date window displays the current month’s calendar and by default, highlights today’s date and the current time.
Refer Figure 17 on page 40.

Figure 17: Specifying a Date

![Calendar Image]

2. You can select a date by performing one or more of the following operations from Select Date dialog:

   - To select a date from the displayed month, click the desired date. To select today’s date, click **Today**.
   - To display the calendar for another month, use the single arrows provided above the days of the week. Click the arrow pointing right for the next month, or the arrow pointing left for the previous month. Alternatively, to select any other month, you can click and hold the mouse on either of the arrows and then drag it to the desired month.
   - Similarly, to display the calendar for another year, click the double-arrow pointing right for the next year, or the double-arrow pointing left for the previous year. Alternatively, to select any other year, you can click and hold the mouse on either of the double-arrows and then drag it to the desired year.
   - To change the default time, click the hour and minute boxes in the **Time** section, to increment the value by 1 unit. Alternatively, to decrement the value, hold down **SHIFT** and then click the respective boxes. To change the value by multiple units, point to the respective boxes and then drag to the right to increment or to the left to decrement the value.

3. Select time from the **Time** drop down.

The selected date and time is displayed in the Date box.

**Note:** By default, the Select Date window displays the calendar with each week starting Sunday. To change this setting to another day of the week, click the day in the calendar header.

---

**Searching Users**

You can specify a user by typing it in the various text boxes involving a users (for example, User Name, Reassign, Delegated to) or select using Select User icon, which is generally located beside the User text box.

**To search a user using Select user icon, perform the following:**

1. Click the Search User icon (🔍) is displayed beside the text box.

   **Search Users** page is displayed where you can search for the users.
2. You can select a user by performing one or more of the following operations from Select User page.

   • You can search for the users by specifying either the user name, or the first name or the last name. If you specify the group name, then it searches for the users in that group, otherwise it searches in all groups.
   • After typing the user name, first name, last name, and optionally, group, click Go. You can also use the * as a wild card. Type in the first letter and then the asterisk (example, a*) and all users beginning with that letter will display. It also works for portions of names; e.g., type in *son and all names ending in son (Jackson, Peterson, etc.) is displayed. Type Mc*son and users such as McPherson and Mcwilliamson is displayed.

   Business Process Portal lists all the users satisfying your search criteria. You can navigate through this list as explained in the Getting started on page 25

   • To go directly to the list of users starting with a particular letter, click that letter in the Quick Search bar.

3. Depending on the page and current operation, Business Process Portal allows you to select one or more users. Select users by clicking the options in the first column of those users, and then click Add.

   The selected users’ user names are entered in the User Name text box.

   **Note:** Depending on the page and current operation, the Save and Create New button may also be available. Click this button to add the current user and continue adding more users.

---

**Searching Group**

Searching for a group is similar to searching for a user. While searching for a group, you need to specify the group name in the Group Name box by typing it. Alternatively, use the Search Bar to locate the specific group by performing a procedure similar to the one explained above for searching the users.
Introducing the Administration module

The Administration module allows you to control the operation of Business Process Server, install and uninstall applications, and manage all users and groups. This chapter describes how to start the Business Process Server servers, log into and out of Business Process Portal, explore the Administration interface, and stop the Business Process Servers.
For details, see the following topics:

- Starting all servers
- Starting individual servers
- Single sign-on in Business Process Portal
- Running Business Process Server as a Windows service
- Customizing Business Process Server
- Exploring the Administration module interface
- Accessing Business Process Server components
- Suspending/Resuming individual Business Process Servers
- Stopping individual Business Process Servers
- Logging out of Business Process Portal
- Stopping all servers

Starting all servers

To start Business Process Portal with JBoss start the EJB server first, then the Portal server, and finally the Business Process Server.

Starting all servers in Windows

The order in which you must start the servers for Business Process Portal, is different for JBoss. You must start the servers in the specified order to start Business Process Portal.

Starting JBoss server

To start all the Business Process Servers with JBoss as your application server using Windows, follow the step:

1. From the Start menu, choose Programs > Progress > OpenEdge > BP Server > App Servers > Start Portal Server.
   This procedure may take some time. Wait until the server starts before proceeding to the next step.

2. From the Start menu, choose Programs > Progress > OpenEdge > BP Server > BP Servers > Start Business Process Server.
   Wait until the servers start before you log in to Business Process Portal.

Starting all servers in UNIX

To start Business Process Portal with JBoss start the EJB server first, then the Portal server, and finally the Business Process Servers.
For systems with X-Windows server

If your system supports X-Windows server:

1. Ensure that the DISPLAY environment variable is set properly in the shell where the portal server starts from.
2. Enter `setenv DISPLAY <machine_name>:<number>` to set the environment variable before starting the servers.

For systems without X-Windows server

If your system does not support X-Windows server:

If the DISPLAY variable is not set for it, then you should modify the `startPortalServer.sh` and add the property `-Djava.awt.headless=true` as shown in the following example, to start the portal server in headless mode.

```
VM_ARGS=$JAVA_OPTIONS" -Djava.awt.headless=true ..."
```

Tip: Make sure the server processes do not exit when you logout or disconnect.

Important: Complete each command before executing the next one.

Starting JBoss in Unix

To start the Portal, EJB, and OEBPS servers for JBoss, enter the following:

```
cd OEBPS_HOME/JBoss/bin
./startEjbServer.sh
./startPortalServer.sh
cd OEBPS_HOME/bin
./startOEBPS.sh
```

Starting individual servers

In Windows, you can start Business Process Servers from the start menu without using Business Process Portal or the Administration module of Business Process Portal.

Starting Business Process Server from Windows

To start Business Process Server:

- Start the BP Server from the Windows Start menu by choosing Programs > Progress > OpenEdge > BP Server > BP Servers > Start Business Process Server.

The Business Process Server is started.

Starting Business Process Servers from Administration

You can start the Business Process Servers from the Administration module also.
To start Business Process Servers from the Administration module:

1. Click **Administration** to open the **System Status** page, the start page of the Administration module.

   It displays the current status of various servers used by Business Process Server.

2. To start the BP Server and BPM Events Server, if they are not running, select the corresponding checkboxes and then click **Start**.

   Business Process Portal starts the selected servers and updates the **System Status** page.

**Figure 19: Starting the Business Process Servers**

```
<table>
<thead>
<tr>
<th>No.</th>
<th>Server</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>BP Server</td>
<td>Running</td>
</tr>
<tr>
<td>2</td>
<td>BPM Events</td>
<td>Running</td>
</tr>
<tr>
<td>3</td>
<td>Event Publisher</td>
<td>Stopped</td>
</tr>
</tbody>
</table>
```

**Using the application server Admin Console**

Optionally, you may obtain application server status for JBoss from Windows as follows:

- For JBoss, from the Start menu, choose **Programs > > Progress > > OpenEdge > > BP Server > > Admin Consoles > > Business Process Console > >**. Enter the user name "guest" and the password "guest".

**Note:** For the application servers the userid and password provided are default user details. You can provide valid user details.

**Single sign-on in Business Process Portal**

Business Process Server provides the BPM Sign-on API servlet, which provides a single sign-on capability to other portals that are configured to work with BPM Sign-on API. In Business Process Server, BPM Sign-on API enables users to log into the Home module of Business Process Portal, and then open other modules in Business Process Portal to which they have been granted access, without having to log in again. With BPM Sign-on API, you do not have to log in to each configured module separately.
The BPM Sign-on API servlet uses the user name and password information from the Login page to create a session and redirects the user to his/her Home page. Subsequent references to all the modules of Business Process Portal pass through the BPM Sign-on API servlet, which first verifies if the user session is valid and then redirects the user to the selected module or feature.

**Note:** If BPM Sign-on API finds a session invalid (for example, due to time-out), then the user is redirected to the Login page to log in again by entering the user name and password.

---

**Accessing Administration module**

After starting the servers, you can log into Business Process Portal. For more details, see Logging in to Business Process Portal on page 27.

**To access Administration module:**

1. Click the Administration tab.

   Business Process Server automatically authenticates your user name and password and displays the System Status page, as shown in the Figure 19 on page 46.

2. Click the View System Status Details link to view the details of each server.

**Note:** Business Process Server’s Access Control Management feature displays an error message, if you were not granted permission to use this or any other module.

To access features in the Administration module, use appropriate module menus.

To access other Business Process Server modules that are available to you, click a module tab to display a range of menus under that tab. Click a menu and select a submenu item to open the feature.

**Note:** Once you log in to Business Process Portal, no further authentication is required when you click a new module.

---

**Running Business Process Server as a Windows service**

You may run Business Process Server as a Windows service in JBoss application server. For more information, see “Installing Business Process Server as a Windows Service” section in the OpenEdge Getting Started: Installation and Configuration Guide.
Customizing Business Process Server

Business Process Server provides you the resources to customize Business Process Server components. Customization enables you to make changes to suit your requirements, make Business Process Server more flexible, and consistent with your corporate identity. This in turn reduces the learning curve and thereby increases productivity. For more information, refer to Customization Guide.

Exploring the Administration module interface

The basic elements of the interface for the Administration module are the same as that of the Home module. The basic operations you must perform while using the Administration module are also the same as those performed while using the Home module. This information is covered in Getting started on page 25 and Basic Operations on page 39.

Note: The tabs, menus, and corresponding submenus you see in Business Process Portal Navigation bar depend on the permissions granted with the ACLManager feature. See Managing access control on page 183 for more information.

Module tabs

You may see one or more of the following module tabs, depending on your access control permissions:

- Home
- Management
- Administration

The Administration module contains the following menus:

- System — Enables you to startup, shutdown, and reconfigure the Business Process Server servers and modules.
- User Management — Enables you to manage Business Process Server users, groups, queues, and permissions.
- Applications — Enables you to manage BP Server and BPM Workflow applications, and Web services.

Each module tab contains several module menus. Click each module menu to view its submenu options. You may access the resources listed in each submenu.

Accessing Business Process Server components

The following table describes how to open Business Process Portal modules and other Business Process Server components on both Windows and UNIX:
Table 6: Accessing Business Process Portal modules and Business Process Server components

<table>
<thead>
<tr>
<th>To open ...</th>
<th>Perform the following ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Progress Developer Studio for Openedge</td>
<td>On Windows from the Start menu: Choose Programs &gt; Progress &gt; OpenEdge &gt; Progress Developer Studio 3.7 for OpenEdge. The Progress Developer Studio for OpenEdge window appears.</td>
</tr>
<tr>
<td>Business Process Server Admin</td>
<td>On Windows from the Start menu: Choose Programs &gt; Progress &gt; OpenEdge &gt; BP Server &gt; Admin Consoles &gt; Business Process Server Console Or in Windows Explorer: %OEBPS_HOME%/bin\StartBPServerAdmin.cmd On UNIX: Enter OEBPS_HOME/bin and startBPServerAdmin.sh. To create and install the process templates for the sample applications, enter the same commands used for BP Server Admin.</td>
</tr>
<tr>
<td>BPM Events Admin</td>
<td>On Windows from Windows Explorer: %OEBPS_HOME%/bin\StartBPMEventsAdmin.cmd On UNIX: Enter OEBPS_HOME/bin and startBPMEventsAdmin.sh.</td>
</tr>
<tr>
<td>Home</td>
<td>On Windows from the Start menu: Choose Programs &gt; Progress &gt; OpenEdge 11.3 &gt; BP Server &gt; Start Business Process Portal, if you are using the installation machine. Otherwise, enter <a href="http://machine_name.domain.com:port_number/mbpmportal/login.jsp">http://machine_name.domain.com:port_number/mbpmportal/login.jsp</a> or http://machine_name:port_number/mbpmportal/login.jsp If you are accessing Business Process Portal from a client. Enter your user name and password. You log into Home. On UNIX: Enter <a href="http://machine_name.domain.com:port_number/mbpmportal/login.jsp">http://machine_name.domain.com:port_number/mbpmportal/login.jsp</a> in your browser. This initiates a login to the Home module.</td>
</tr>
</tbody>
</table>
To open . . .

<table>
<thead>
<tr>
<th>To open . . .</th>
<th>Perform the following . . .</th>
</tr>
</thead>
<tbody>
<tr>
<td>Management</td>
<td><strong>On Windows from the Start menu:</strong> Choose <em>Programs</em> &gt; <em>Progress</em> &gt; <em>OpenEdge</em> &gt; <em>BP Server</em> &gt; <em>Start Business Process Portal</em>, then select the Management module if you are using the installation machine. Otherwise enter <a href="http://machine_name.domain.com:port_number/sbm/bpmportal/management/overview_all.jsp">http://machine_name.domain.com:port_number/sbm/bpmportal/management/overview_all.jsp</a> if you are accessing Management from a client. Enter your user name and password. This initiates a login to the Management module. <strong>On UNIX:</strong> Enter <a href="http://machine_name.domain.com:port_number/sbm/bpmportal/management/overview_all.jsp">http://machine_name.domain.com:port_number/sbm/bpmportal/management/overview_all.jsp</a> in your browser. This initiates a login to the Management module.</td>
</tr>
<tr>
<td>Administration</td>
<td><strong>On Windows from the Start menu:</strong> Choose <em>Programs</em> &gt; <em>Progress</em> &gt; <em>OpenEdge</em> &gt; <em>BP Server</em> &gt; <em>Business Process Portal</em>, then select the Administration module if you are using the installation machine. Otherwise enter <a href="http://machine_name.domain.com:port_number/sbm/bpmportal/administration/system_status.jsp">http://machine_name.domain.com:port_number/sbm/bpmportal/administration/system_status.jsp</a> in your browser if you are accessing the Administration module from a client. Enter your user name and password. This initiates a login to Administration, the main administration module for Business Process Server. <strong>On UNIX:</strong> Enter <a href="http://machine_name.domain.com:port_number/sbm/bpmportal/administration/system_status.jsp">http://machine_name.domain.com:port_number/sbm/bpmportal/administration/system_status.jsp</a> into your browser. This initiates a login to the Administration module.</td>
</tr>
</tbody>
</table>

Suspending/Resuming individual Business Process Servers

You can suspend/resume BP Server and/or BPM Events Servers from Business Process Portal only.

**To do this, perform the following:**

1. Click **Administration** to open the **System Status** page, the start page of the Administration module.

   It displays the current status of various servers used by Business Process Servers.

2. To suspend or resume the servers, perform the appropriate step.

   - To suspend the BP Server and/or BPM Events Server, select the desired server(s) and then click **Suspend**.

     Business Process Portal suspends the selected servers and updates the **System Status** page.

   **Note:** If you suspend the servers then, internal process such as BPM Process Store operation, due date calculation will run alive in BP Server. However, portal client cannot access the servers.

   - To resume the suspended BP Server and/or BPM Events Server, select the desired server(s) and then click **Resume**.
Stopping individual Business Process Servers

You can stop Business Process Servers from windows as well as Business Process Portal.

**Note:** If you stop the servers, then no process will run and portal client cannot access the servers.

From Windows

**To stop Business Process Server from windows:**

Stop the BP Server from the Windows Start menu by choosing *Programs > Progress > OpenEdge > BP Server > BP Servers > Stop Business Process Server*.

The BP Server is stopped.

From Business Process Portal

**To stop Business Process Servers from Business Process Portal:**

1. Click *Administration* to open the *System Status* page, the start page of the Administration module.

   It displays the current status of various servers used by Business Process Server.

2. To stop the BP Server and BPM Events Server, select them and then click *Stop*.

   Business Process Portal stops the selected servers and updates the *System Status* page.

Logging out of Business Process Portal


Stopping all servers

To stop Business Process Portal, you must first Log out, and then for JBoss stop the Business Process Servers first, followed by the EJB server, and then the Portal server.

**Note:** Always stop the servers using the appropriate command; do not kill the servers.
Stopping in Windows

The order in which you stop all the Business Process Servers is different for JBoss. You must stop the JBoss server before you stop all the Business Process Servers.

Stopping Business Process Portal servers in JBoss server for Windows

To stop all the Business Process Servers with JBoss using Windows, complete the following:

1. From the Start menu, choose Programs > Progress > OpenEdge > BP Server > BP Servers > Stop Business Process Server.
   You may also stop the Business Process Servers individually by selecting them, and then clicking Stop in the System Status page of the Administration module, or by running the stopOEBPS utility in OEBPS_HOME\bin.
   Wait until the servers stop before proceeding to the next step.

2. From the Start menu, choose Programs > Progress > OpenEdge > BP Server > App Servers > Stop Portal server.
   This procedure may take some time. Wait until the server stops before proceeding to the next step.

Stopping in UNIX

To stop Business Process Portal for JBoss, you must log out, then stop the Business Process Servers first, next the EJB server, and then the Portal server.

Important: Complete each command before executing the next one.

Stopping Business Process Portal servers in JBoss for Unix

To stop the Portal, EJB, and OEBPS servers for JBoss, enter the following:

```
cd OEBPS_HOME/bin
./stopOEBPS.sh
cd OEBPS_HOME/JBoss/bin
./stopEjbServer.sh
./stopPortalServer.sh
```

Signed applets

Business Process Portal uses signed applets to perform some operations. A Business Process Server User's user account in the Operating System needs to have permissions to approve the use of these signed applets. However, if your organization's policy does not allow you to grant such permissions, then you can adopt one of the following strategies to allow a user to use signed applets without compromising the security.
Modifying the java.policy file

Perform the following in java.policy file:

1. On each user machine, modify the java.policy file in the <JRE_Install>\lib\security directory and add the lines to grant permissions to run Business Process Server applets.
   
   For example:
   
   ```java
   grant codeBase "http://<host_name>:<port_number>/sbm/bpmportal/applet/*" {
     permission java.security.AllPermission;
   };
   ```

2. Please note that if you change the Business Process Server location, then you must update all users' java.policy files with the new server location.

Modifying the java.security file

Perform the following in java.policy file:

1. On each user machine, modify the java.security file in the <JRE_Install>\lib\security directory and add the lines to point to the java policy file.
   
   For example:
   
   ```java
   policy.url.3=http://<host_name>:<port_number>//applet.policy
   ```

2. This policy URL should be a static location pointing to a remote policy file as a source of java security policies.

3. This java policy file (in this case, applet.policy) should contain the lines to grant permissions to run Business Process Server applets. For example:
   
   ```java
   grant codeBase "http://<host_name>:<port_number>/sbm/bpmportal/applet/*" {
     permission java.security.AllPermission;
   };
   ```

4. In this case, if you change the Business Process Server location, then you must update the java policy file (in this case, applet.policy) only on the static server instead of every user machine.
Configuring Business Process Server

The Business Process Server Administration module enables you to fine-tune the performance of your system using configuration files. This chapter explains how to configure Business Process Server using Business Process Portal’s Administration module, and describes the Secure Socket Layer (SSL) for security purposes.

For details, see the following topics:

- Using the OEBPS configuration interface
- SSL security for Business Process Portal modules

Using the OEBPS configuration interface

Business Process Server stores the configuration parameters for various Business Process Server modules, as well as for its overall operation, in various .conf files, located in the OEBPS_HOME\conf directory. Business Process Server provides a simple interface that allows you to change the parameters of a selected module. To see additional parameters that are not visible in the interface, refer to the respective .conf file.

Updating OEBPS configuration

To update OEBPS configuration, perform the following:

1. In the Administration module, click System > Configuration > General, to view the OEBPS Configuration page.

   This page displays your current configuration settings for Business Process Server.
An example of this page is shown in the following figure.

**Figure 20: Using the OEBPS configuration page**

2. You can scroll through the listed parameters and modify values, as required. Refer to **Table 7** on page 56 for a description of the parameters.

3. Click **Save**.

Business Process Server updates the configuration after your confirmation.

**Available configuration parameters in Business Process Portal**

The following table presents the configuration parameters for Business Process Server and a description of its usage, along with default values, if appropriate.

**Business Process Server configuration**

**Table 7: Business Process Server configuration**

<table>
<thead>
<tr>
<th>Configuration name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Day Start Time</td>
<td>9</td>
<td>The start of the business day (using a 24-hour clock).</td>
</tr>
<tr>
<td>Business Day End Time</td>
<td>17</td>
<td>The end of the business day (using a 24-hour clock).</td>
</tr>
<tr>
<td>Holidays</td>
<td>None</td>
<td>Specifies a comma-separated list of holidays to exclude when performing business time calculations. Format: &lt;month as a string&gt; &lt;day as an integer&gt; &lt;year as an integer&gt; Example: Jan 4 1999, Mar 10 1998, Apr 29 1997</td>
</tr>
<tr>
<td>SMTP mail server port</td>
<td>25</td>
<td>The port number of the SMTP mail server for outgoing e-mail.</td>
</tr>
<tr>
<td>SMTP mail server sender e-mail address</td>
<td><a href="mailto:mail@apac.progress.com">mail@apac.progress.com</a></td>
<td>Where the e-mail address broadcast reports are sent from.</td>
</tr>
</tbody>
</table>
The email address broadcast reports are sent from.

SMTP mail server sender email address

The email address broadcast reports are sent from.

SMTP charset

SMTP character set to be used.

Note: To customize the date format, you must specify the new date format using the Date_Format parameter in the bpmportal.properties and the language specific properties file; for example, for English, you must specify it in the bpmportal_en.properties file.

SSL security for Business Process Portal modules

Business Process Server relies on the Secure Socket Layer (SSL) protocol to provide secure connections for Business Process Portal modules. SSL provides server authentication, data encryption, and message integrity. With SSL implemented on both client and server, your Internet communications are transmitted in encrypted form, so that information arrives unaltered at the specified server. Generally, Business Process Server allows dual types of connections across all its portal modules (Home, Management and Administration). For example, a user logs into Administration using HTTPS protocol, while another user logs in non-securely using HTTP protocol:

https://<hostName>:<HTTPS_PortNumber>/...

or

http://<hostName>:<HTTP_PortNumber>/...

No adjustment is required on your part as switching between these two connection types is the user's choice at the Web browser level. The default protocol is selected during Business Process Server installation, which forces the connection type for Business Process Server menu shortcuts only.

Business Process Server uses the SSL protocol as part of the Web server to enforce a high level of security in addition to the login and password security features in Business Process Portal modules.

SSL security Features

SSL security is common for Business Process Portal modules accessible through the Web, such as Home, Management, and Administration.

Safeguarding features

To guard against the previously listed threats, SSL protocol provides several safeguarding features:

- **Confidentiality.** Guaranteed through encryption, the process of disguising information so that it can't be deciphered by anyone but the intended recipient.

- **Integrity.** Ensured through encryption.

- **Authentication.** Provided through digital authenticity certificates, which are very difficult to falsify.

The Business Process Portal modules support a secure connection for users who request it. If the user connects to Business Process Server by typing the URLs, then SSL protocol provides security which is embedded in the Web server at the URL level. For example, enter:
https://<hostName>:<SSLportNumber>

Instead of: http://<hostName>:<portNumber>

In general, the Business Process Server menu provides the right link whether the connection is secure or not.

**Note:** SSL availability depends on the application server.

You must configure your application server to avail its SSL security features. The exact procedure to configure it varies from server to server. Please refer to your application server documentation for this procedure.

### Securing network communication between Business Process Server components

Business Process Server supports RMI over IIOP (RMI/IIOP) protocol to communicate between EJB and portal components. This protocol is not encrypted. To make the network communication more secure by encryption, RMI over IIOP can be sent through SSL protocol. This technique is called RMI over IIOP over SSL (RMI/IIOP/SSL). SSL is standard industry protocol to provide authentication, non-repudiation and encryption functionality.

Business Process Server does not provide RMI/IIOP/SSL functionality but relies on J2EE compliant application servers to provide this functionality. Since RMI/IIOP/SSL is not a standard part of J2EE, this functionality may not be available to all application servers. Refer to your application server documentation on enabling this functionality.

RMI/IIOP is supplied via object request brokers (ORB). Security standards do not exist for interoperability between ORBs. When RMI/IIOP/SSL is enabled, a client ORB from one vendor will not work with a server ORB from another vendor.

For more information about RMI/IIOP/SSL for your application server, refer to your application server documentation.
Configuring BPM Workflow

BPM Workflow is a mechanism for process designers and application developers to develop more customizable, sophisticated interfaces for individual worksteps within their flow applications. This chapter explains how to configure BPM Workflow using Business Process Portal’s Administration module.

For details, see the following topics:

- Using the BPM Workflow configuration interface
- Troubleshooting BPM Workflow configuration

Using the BPM Workflow configuration interface

Business Process Server stores the configuration parameters for BPM Workflow in the bpmworkflow.conf file, located in the OEBPS_HOME\conf directory. To see additional parameters that are not visible in the interface, refer to the bpmworkflow.conf file. You use the Administration module to configure these parameters using the interface presented in Figure 21 on page 60.

To update BPM Workflow configuration:

1. In the Administration module, click System > Configuration > BPM Workflow, to view the BPM Workflow Configuration page.

   This page displays your current configuration settings for BPM Workflow.
2. You can scroll through the listed parameters and modify values, as required. Refer to Table 8 on page 60 for a description of the parameters.

3. Click Save. Business Process Server updates the configuration after your confirmation.

Configuration parameters for BPM Workflow in Business Process Portal

The following table presents the configuration parameters for BPM Workflow, along with default values and a description of use.

**BPM Workflow configuration**

<table>
<thead>
<tr>
<th>Configuration name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BPM Workflow Root</td>
<td>%OEBPS_HOME%BPMWorkflow</td>
<td>The root directory for Web applications.</td>
</tr>
<tr>
<td>BPM Workflow task URL</td>
<td>/sbm/bpmportal/login.jsp</td>
<td>This is the URL for the BPM Workflow task. The pattern ${WORKITEM_NAME} needs to be replaced with proper work item name.</td>
</tr>
<tr>
<td>UseXSL</td>
<td>True</td>
<td>Enables XSL support.</td>
</tr>
<tr>
<td>WSCode</td>
<td>True</td>
<td>Generates additional code. Required only when the application is invoked as a Web Service.</td>
</tr>
</tbody>
</table>
### Troubleshooting BPM Workflow configuration

This section answers the most frequently asked troubleshooting questions about BPM Workflow configuration.

#### Table 9: Troubleshooting BPM Workflow

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>What happens to the customized jsp files when I uninstall BPM Workflow?</td>
<td>The modified jsp files are copied to the jsp.bak subdirectory of the application.</td>
</tr>
</tbody>
</table>
| How can I save Java class files before or after publishing a BPM Workflow application? | If you published the BPM Workflow application, then save the class files in one of the following directories (AppServer refers to BP Server webapps directory):  
  - %AppServer%/sbm.war/bpmworkflow/common/classes  
  - %AppServer%/sbm.war/bpmworkflow/<Application Name>/classes  
  If the application was not published, then save the class files under the following directories:  
  - %OEBPS_HOME%/BPMWorkflow/common/classes  
  - %OEBPS_HOME%/BPMWorkflow/<Application Name>/classes  
  You may also save the files to the following directory:  
  - %AppServer%/sbm.war/WEB-INF/classes                                                                 |
| Where are the log files generated?                                       | Logs are generated under OEBPS_HOME/logs/bpmworkflow.log or you may access the log viewer for BPM Workflow by clicking System > Configuration > Log Viewer and then by selecting the BPM Workflow option from the Log file to view list. |
Configuring Business Process Portal

The Business Process Portal enables users to interact with Business Process Server applications. You can interact with Business Process Server applications by using the Home, Management, and Administration modules. Out of these modules, you can configure the Home and Management modules using Business Process Portal’s Administration module.

The Home module enables users to interact with Business Process Server applications. Home is a module in Business Process Portal that not only provides entries to various tasks and applications, but also supplies links to all supporting resources required to complete these tasks including documents, external URLs, as well as additional applications and services. Home is the application user’s primary interface to Business Process Server.

The Management module in Business Process Portal enables managers to query, report, and control processes and resources. As the primary interface for the business manager, the Management module allows you to define, view, query, and analyze management data in the form of reports, graphs, and spreadsheets, to name a few. For example, the Management module allows business managers to query and select current active processes based on their state and attributes; and supports dynamic modification of business policies and priorities.

This chapter explains how to configure Portal using Business Process Portal’s Administration module and offers answers to the most frequently asked questions about troubleshooting configuring Business Process Portal.

For details, see the following topics:

- Using the Business Process Portal configuration interface
- Troubleshooting Business Process Portal configuration

### Using the Business Process Portal configuration interface

Business Process Server stores the configuration parameters for the Home module in the `bpmportal.conf` file, located in the `OEBPS_HOME\conf` directory. You use the Configuration interface in the Administration module to configure these parameters. To see additional parameters that are not visible in the interface, refer to the `bpmportal.conf` file.

To configure Business Process Portal using the Configuration interface in the Administration module:

1. In the Administration module, click `System > Configuration > Business Process Portal`, to view the Business Process Portal page.

   This page displays your current configuration settings for the Home module.

   An example of this page is shown in the following figure.

   **Figure 22: Using the Business Process Portal configuration page**

   ![Using the Business Process Portal configuration page](image)

   You can scroll through the listed parameters and modify values, as required.

   Refer to Table 10 on page 65 for a description of the parameters.

   3. Click **Save**.

      Business Process Server updates the configuration after your confirmation.

### Configuration parameters for Business Process Portal

Table 10 on page 65 presents the configuration parameters for Business Process Portal, a description of use, along with default values, if appropriate.
## Business Process Portal configuration

**Table 10: Business Process Portal configuration**

<table>
<thead>
<tr>
<th>Configuration name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Size For Document Uploads</td>
<td>5</td>
<td>The size limit for uploaded documents, specified in megabytes. Note that you can specify only integer values for size.</td>
</tr>
<tr>
<td>Business Process Portal page size</td>
<td>15</td>
<td>Specify the number of entries in Business Process Portal page. This should be between 1 and 50 (both inclusive).</td>
</tr>
<tr>
<td>Caching of API Templates</td>
<td>False</td>
<td>When this value is enabled, all templates used by the Home API are cached. This improves performance. However, when using this setting, restart the servlet engine/web server for any template changes to take effect.</td>
</tr>
<tr>
<td>Crystal Report Server URL</td>
<td>None</td>
<td>The URL of the Crystal Report server.</td>
</tr>
<tr>
<td>ReportBuilderApplet JAR files</td>
<td>processreportbuilder.jar, CalAndMaskField.jar</td>
<td>List of JAR files used by the ReportBuilder applet.</td>
</tr>
<tr>
<td>Report User Name</td>
<td>OpenEdge</td>
<td>The report engine user name</td>
</tr>
<tr>
<td>Report License Key</td>
<td>License number</td>
<td>The report engine license key.</td>
</tr>
<tr>
<td>Disable Confirmation Messages</td>
<td>False</td>
<td>Enables or disables confirmation pages for Business Process Portal. It is not applicable for JavaScript confirmation messages.</td>
</tr>
<tr>
<td>Flag to enable password security in portal</td>
<td>False</td>
<td>If this value is set to true, then password security is enabled in portal</td>
</tr>
<tr>
<td>Name of class implementing the IPasswordSecurityData interface</td>
<td>com.savvion.sbm.bpmportal.security.PortalPasswordSecurityData</td>
<td>User should define the implementing class and specify the name here. Custom data handler can be created by extending com.savvion.sbm.security.password.IPasswordSecurityData interface.</td>
</tr>
<tr>
<td>Name of class implementing the IPasswordSecurityService interface</td>
<td>com.savvion.sbm.bpmportal.security.PortalPasswordSecurityService</td>
<td>User should define the implementing class and specify the name here. Custom service handler can be created by extending com.savvion.sbm.security.password.IPasswordSecurityService interface.</td>
</tr>
<tr>
<td>Flag to enable change password during first login</td>
<td>True</td>
<td>If the value is set to true, then the user is prompted with change password window during first login.</td>
</tr>
<tr>
<td>Duration in days after which the password for the user expires</td>
<td>30</td>
<td>Duration in days for which the password is valid. The value should be between 1 and 365, if set to -1 longevity will be infinite, that is the password never expires.</td>
</tr>
</tbody>
</table>

---

Using the Business Process Portal configuration interface
<table>
<thead>
<tr>
<th>Configuration name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of days prior to password expiry to notify the</td>
<td>3</td>
<td>Specifies number of days before password expiry for notification. The value</td>
</tr>
<tr>
<td>user about password expiration</td>
<td></td>
<td>should be between 1 and 30, if set to -1 notifyexpiration is disabled, that</td>
</tr>
<tr>
<td></td>
<td></td>
<td>is the user is not notified before password expiry.</td>
</tr>
<tr>
<td>Local Store for Task Page</td>
<td>False</td>
<td>When this value is enabled, task data is cached and also grid pagination and</td>
</tr>
<tr>
<td></td>
<td></td>
<td>sorting is performed locally. This improves performance.</td>
</tr>
</tbody>
</table>

# Troubleshooting Business Process Portal configuration

Troubleshooting questions about the Home and Management modules in the Business Process Portal configuration are answered in the following sections.

# Troubleshooting the Home module

This section answers the most frequently asked troubleshooting questions about the Home module in the Business Process Portal configuration.

## Home module

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
</table>
| I cannot connect to Home.                                               | Check that the Web server is running properly by typing http://<machine_name>:<webserver_port_number>.
| I cannot log in to Home.                                                | 1. Check if the BP Server is running from the System page.  
2. Check if Business Process Server is running.  
3. Check whether the bpserver.conf configuration file is using LDAPRealm for authentication or not. |
| I cannot see my applets when I try to run Business Process Server       | Check the version of your browser. The Release Notes contain information concerning the list of supported browsers. |
| applications.                                                           |                                                                                                                                                                                                 |

---

Chapter 7: Configuring Business Process Portal
When you install Business Process Server from the Installation CD, you are licensed for 15 concurrent Home sessions. Business Process Server counts each user logged in as using a single license; a user logged in multiple times using the same user name uses the corresponding number of licenses. A license remains in use until the user logs out. If the user forgets to log out, then the session expires after 360 minutes by default, and the license is available for use by someone else. To change the session time, see the next question below. If your organization needs to support a larger number of concurrent users, then contact Progress OpenEdge to add to your existing license. Progress OpenEdge will e-mail you a new binary license file that you can place in the OEBPS_HOME\conf directory. Restarting the Apache web server resets the licenses.

When attempting to log in, I receive the message "Home concurrent user license limit exceeded."

You may adjust the display of process instances in the Home Task list with one of three values: short, extended and tooltip. ‘Short’ presents the basic application template name. ‘Extended’ displays a longer name which includes information about parent applications if they exist. ‘Tooltip’ displays the short name, but provides additional information in pop-up form. To change the instance display format value, open the bpmportal.conf file and find the bpmportal.instance.display.format parameter and indicate short, extended or tooltip.

How do I adjust the instance display format in Home?

How do I change the time-out value in my system?

Please refer to your application server documentation.

If you are using an evaluation version of Business Process Server, then contact Progress OpenEdge to upgrade to a full license.

When attempting to log in, I receive the message "Home license expired."

When attempting to log in, I receive the message "Can’t find BP Server."

This happens when the BP Server is down or not responding. Use the System menu in the Administration module to check the status of the Business Process Server.

Troubleshooting the Management module

This section answers the most frequently asked troubleshooting questions about the Management module in the Business Process Portal configuration.
### Management module

#### Table 12: Troubleshooting the Management module

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>When using Internet Explorer, the screen does not refresh when the page changes.</td>
<td>Ensure that in Internet Explorer the portal page gets loaded whenever you visit the webpage. You can set this using <strong>Tools</strong> menu, <strong>Internet Options</strong>, in that select <strong>Check for newer versions of stored pages</strong> &gt; <strong>Every time I visit the webpage</strong>. For more information check Internet Explorer documentation.</td>
</tr>
<tr>
<td>What is the difference between Removed and Suspended?</td>
<td>Removed: The process instance was removed and is no longer available to the user. Suspended: The process instance was stopped but can be reactivated.</td>
</tr>
<tr>
<td>When attempting to log in, I receive the message &quot;Management concurrent user license limit exceeded.&quot;</td>
<td>When you install Business Process Server from the Installation CD, you are licensed for five concurrent Management sessions. Business Process Server counts each user logged in as using a single license. A user logged in multiple times using the same user name uses the corresponding number of licenses. A license remains in use until the user logs out. If the user forgets to log out, then the session expires after 360 minutes, by default, and the license is available for use by someone else. To change the session time, see the next question below. If your organization needs to support a larger number of concurrent users, then contact Progress OpenEdge to add to your existing license. Progress OpenEdge will e-mail you a new binary license file that you can place in the OEBFS_HOME\conf directory.</td>
</tr>
<tr>
<td>When trying to get the Process Status Viewer, I receive an &quot;Internal Server Error&quot; after I click PI URL in BPM SQL report.</td>
<td>The Process Status Viewer requires four parameters to work properly: process template name, process template ID, process instance name, and process instance ID. The error occurs when the BPM SQL server does not select all columns (except for process instance name, where the URL link to the Process Status Viewer won’t show). Those parameters are supplied by the SQL query and are mapped to the following columns: <code>process_template_name</code>, <code>process_template_id</code>, <code>process_instance_name</code>, and <code>process_instance_id</code>.</td>
</tr>
<tr>
<td>When attempting to log in, I receive the message &quot;Business Process Portal Management license expired.&quot;</td>
<td>If you are using an evaluation version of Business Process Server, then contact Progress OpenEdge to upgrade to a full license.</td>
</tr>
<tr>
<td>Cannot generate a report.</td>
<td>Make sure the database server is still running and application is still accessible by the current user.</td>
</tr>
<tr>
<td>How do I change the time out value in my system?</td>
<td>That depends on your application server. Please refer to your application server documentation.</td>
</tr>
</tbody>
</table>
Configuring BP Server

As the Business Process Server administrator, you are responsible for loading business processes and maintaining BP Server. The BP Server executes the business process flow and provides the following components:

• BPM Process Store. An open repository of e-business information collected from different modules of Business Process Server as well as processing events and populating the Business Process Server system tables.

• Email Server. The location where BP Server stores e-mail account information and parameters.

• Event Publisher. The JMS-based framework used in BP Server for publishing events to a user defined queue or topic.

• BP Server Admin. The command line interface for administering BP Server.

This chapter explains the role of BP Server in Business Process Server and describes how to configure BP Server, BPM Process Store, Email Server, and Event Publisher using the Configuration interface in the Administration module of Business Process Portal. This chapter also describes how to publish BP Server applications using BP Server Admin and presents a list of commands along with a troubleshooting section.

Note: To install applications using the Administration module, refer to Managing applications on page 209 for more details.
For details, see the following topics:

• Understanding the role of BP Server
• BP Server property files
• Publishing BP Server applications
• Using the BP Server configuration interface
• Using the BPM Process Store configuration interface
• Using the email server configuration interface
• Using BP Server admin
• Troubleshooting BP Server configuration

Understanding the role of BP Server

BP Server is transparent to Business Process Server end users, who use Business Process Portal modules (Home, Management and Administration) as clients of BP Server. The Application Developer, on the other hand, uses BP Server for defining and creating the business processes. This requires knowledge of BP Server and its API in order to write the external performers and to integrate third party applications with Business Process Server.

Business Process Server Application Developers define the process and information flow for an application using Progress Developer Studio for OpenEdge, saving the process definition as a Business Process Template file (in SPT or XML).

BP Server property files

The following BP Server properties are found in the OEBPS_HOME\conf directory.

\oebpsjndi.properties. Defines the properties of target application servers. For each application server, a set of properties is defined, such as initial_factory, provider_url, principal, credentials, jndi-prefixes, and others. The default application server and default JMS server names specified in the property file by the installer applies to the current installation.

This file also contains for JMS provider.

You can also use this file to specify for Local EJB or Remote EJB invocations. The format of the entries in this file is as follows:

<jndiName>=<fully qualified class name>

For example:

\ejb/myJndiName=com.savvion.sbm.PurchaseOrder
\testJndiName=com.savvion.sbm.PurchaseOrder

\oebpsdb.properties. This file specifies the database properties of the target database set for the current installation. The name of transactional data source of BP Server, database user and password and other properties is also specified in this document.

\oebpsemail.properties. This file defines data for e-mail protocol, the IMAP server, e-mail ids, and the temporary location for document downloading and other properties.
Publishing BP Server applications

You must publish a BP Server application before it can be used. This involves using the Administration module of Business Process Portal or issuing commands and/or macros in BP Server Admin.

Perform the following:

1. Create the process using the Business process template XML file.
   
   This is done by the Business Process Server Application Developer using OpenEdge. For more information refer to OpenEdge Getting Started: Developing BPM Applications with Developer Studio.

2. Install the process.
   
   This step validates the process definition. If there is any problem in the process definition, for example, or if the flow of the process is not correct, then you can see either warnings or error messages.

3. Create and activate a process instance.
   
   This starts an instance of the process.

Note: The Business Process Server administrator completes the first two steps and Business Process Server end-users generally perform the final step.

Understanding the process flow

Once a process instance is activated, the first workstep defined in the process is run. For each workstep, BP Server creates workitems for the performers. BP Server then assigns tasks to the performers as specified in the process flow. The performer of an activity workstep can be an individual, any member of a group, all members of a group, or any member of a queue.

When a task is assigned to a user, it shows up in the person’s Task List. Once all the workitems of a workstep (meaning all the tasks) are completed, the server activates the next workstep defined in the process flow.

Suspending the BP Server

Occasionally, the BP Server may exit immediately due to any database error, including lack of space in the database. Subsequently, events generated by BP Server are enabled for posting into the database and an SQL exception is thrown. The BP Server then automatically goes into suspend mode for the server, as well as the database connections, the external connections, and the external performer executions. While in suspend mode, the server periodically monitors database availability and creates a new database connection when the server becomes available. The BP Server is also restored to the previous state without losing the event that caused the database failure.
Using the BP Server configuration interface

Business Process Server stores the configuration parameters for BP Server in the `bpserver.conf` file, located in the `OEBPS_HOME\conf` directory. You can use the Configuration interface in the Administration module to configure these parameters. To see additional parameters that are not visible in the interface, refer to the `bpserver.conf` file. For specific information on changing log levels for BP Server, see Using the log configuration interface on page 87.

Perform the following to view BP Server configuration page:

1. In the Administration module, click **System > Configuration > BP Server**, to view the **BP Server Configuration** page.

   This page displays your current configuration settings for BP Server.

   An example of this page is shown in the following figure.

   **Figure 23: Using the BP Server configuration page**

   ![BP Server Configuration Page](image)

   2. You can scroll through the listed parameters and modify values, as required.

      Refer to **Table 13** on page 73 for a description of the parameters.

   3. Click **Save**.

      Business Process Server updates the configuration after your confirmation.

BP Server configuration parameters

**Table 13** on page 73 presents the configuration parameters for BP Server, a description of each parameter, and any default values, if applicable.

**Note:** Configuration parameters cannot reload until you restart the server.
### Parameters

**Table 13: BP Server configuration parameters**

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID of BP Server &lt;sup&gt;2&lt;/sup&gt;</td>
<td>True</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server API.</td>
</tr>
<tr>
<td>BP Server Debug Flag for API</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server API.</td>
</tr>
<tr>
<td>BP Server Debug Flag for Utilities</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server utilities.</td>
</tr>
<tr>
<td>BP Server Debug Flag for Session Beans</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server Session Beans.</td>
</tr>
<tr>
<td>BP Server Debug Flag for Entity Beans</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server Entity beans.</td>
</tr>
<tr>
<td>BP Server Debug Flag for Server Engine</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server Engine.</td>
</tr>
<tr>
<td>BP Server Debug Flag for User Session</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server User Session.</td>
</tr>
<tr>
<td>BP Server Debug Flag for Data Access Objects (DAO)</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server Data Access Objects.</td>
</tr>
<tr>
<td>BP Server Debug Flag for External Performers</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server External Performers.</td>
</tr>
<tr>
<td>BP Server Debug Flag for Timer Action</td>
<td>False</td>
<td>If set to true, then the debug (trace) information is written to the log file for the BP Server timer action support.</td>
</tr>
<tr>
<td>BP Server Debug Flag for ProcessTemplate creation</td>
<td>False</td>
<td>If set to true, then it prints the debug information of process template creation and initialization.</td>
</tr>
<tr>
<td>BP Server Debug Flag for printing the jst.writeLog in scripts</td>
<td>False</td>
<td>If set to true, it prints the statements mentioned within jst.writeLog in scripts.</td>
</tr>
<tr>
<td>BP Server Debug Flag for FileClassLoader</td>
<td>False</td>
<td>If true, the server writes the debug information of FileClassLoader used for adapter loading.</td>
</tr>
<tr>
<td>Debug Flag</td>
<td>False</td>
<td>If set to true, it prints the debug information.</td>
</tr>
<tr>
<td>Timeout for User Session</td>
<td>360</td>
<td>The time in minutes after which the session expires if left idle.</td>
</tr>
</tbody>
</table>

---

<sup>2</sup> Configuration parameters CANNOT be reloaded until you restart the server.
<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sending Email notifications</td>
<td>False</td>
<td>The option to send e-mail notifications upon various events. This property is false by default.</td>
</tr>
<tr>
<td>Start Email Reader</td>
<td>False</td>
<td>The option to start the Email Reader at BP Server startup to listen to e-mails sent to BP Server for completing tasks etc.</td>
</tr>
<tr>
<td>Sending Email notifications when work item is completed</td>
<td>False</td>
<td>Option to send email notifications to performers when work item is completed.</td>
</tr>
<tr>
<td>Sending Email notifications to other performers in a group when one of the</td>
<td>False</td>
<td>Option to send email notifications to other group performers when one of the group assigns task to self.</td>
</tr>
<tr>
<td>group performers assigns task to himself/herself</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Start Running Dashboard</td>
<td>True</td>
<td>Option to start collection of Dashboard information at BP Server startup.</td>
</tr>
<tr>
<td>BP Server tracking work item performer flag</td>
<td>True</td>
<td>If set to true, all the work item performers of the activated process instance are remembered by BP Server. Note: Turning on/off the flag only affects the process instance activated after it.</td>
</tr>
<tr>
<td>BP Server Callback notification</td>
<td>False</td>
<td>If set to true, change of BP Server states is notified by invoking registered callback adapters.</td>
</tr>
<tr>
<td>BP Server Calendar</td>
<td>True</td>
<td>If set to true, uses calendar to compute due date.</td>
</tr>
<tr>
<td>Event Trace</td>
<td>False</td>
<td>If set to true, prints event information in the log file.</td>
</tr>
<tr>
<td>Comma separated list of senders</td>
<td>com.savvion.sbm.eventpublisher.sender.JMSSender</td>
<td>Comma separated fully qualified class names of senders. For example: com.savvion.sbm.eventpublisher.sender.JMSSender,</td>
</tr>
<tr>
<td></td>
<td></td>
<td>com.savvion.sbm.eventpublisher.sender.SimpleSender, common.externalperformers.SimpleEPSender</td>
</tr>
<tr>
<td>Default filter class name</td>
<td>com.savvion.sbm.eventpublisher.filter.ANDFilter</td>
<td>Fully qualified class name for Default Filter Class.</td>
</tr>
<tr>
<td>Event Publisher Sender Location</td>
<td></td>
<td>The location where user defined Sender or Filter Classes are kept. When no values are specified, $OEBPS_HOME/ebmsapps directory is assumed as the default location.</td>
</tr>
</tbody>
</table>

---

3 These parameters are used by the Event Publisher.
Using the BPM Process Store configuration interface

The BPM Process Store configuration file specifies how the BPM Process Store daemon is running. You specify the time interval that the daemon wakes up, the number of events processed for each execution, and what kind of logging is necessary. Another parameter is included to control how often the dashboard population thread wakes up.

Business Process Server stores the configuration parameters for BPM Process Store in the `bpmprocessstore.conf` file, located in the `OEBPS_HOME\conf` directory.

If you want to change the log level for BPM Process Store, then you can change it in the `oebpslog.conf` file in the `OEBPS_HOME\conf` directory, but you must also make sure to navigate to the `bpmprocessstore.conf` file in the `OEBPS_HOME\conf` directory, and change the settings for the following parameters to ‘true’, as shown in the following example (for more information, see Using the log configuration interface on page 87):

```
bpmprocessstore.debug.engine=true
bpmprocessstore.printEvent=true
bpmprocessstore.printStack=true
bpmprocessstore.debug.sql=true
```

By default, BPM Process Store does not send queries and perform calculations related to resources, worktime, and wait time to improve performance by avoiding unnecessary calculations. However, if you want BPM Process Store to perform these calculations, then in the `bpmprocessstore.conf` file set the `bpmprocessstore.resource.usage` parameter to `true`.

After you make these changes, you can reload these parameters without restarting the server by using the BPM Process Store utility. For more details, see Reloading the configuration parameters on page 77.

Configuring BPM Process Store

You can also use the Configuration interface in the Administration module to configure visible BPM Process Store parameters. To see additional parameters that are not visible in the interface, refer to the `bpmprocessstore.conf` file.
To configure BPM Process Store using Business Process Portal:

1. In the Administration module, click **System > Configuration > BPM Process Store**, to view the **BPM Process Store Configuration** page.

   This page displays your current configuration settings for BPM Process Store as shown in the following figure.

   **Figure 24: Using the BPM Process Store configuration page**

   ![BPM Process Store Configuration Page](image)

2. You can scroll through the listed parameters and modify values, as required.
   Refer to **Table 14** on page 76 for a description of the BPM Process Store parameters.

3. Click **Save**.

   Business Process Server updates the configuration after your confirmation.

**BPM Process Store configuration parameters**

**Table 14** on page 76 presents the configuration parameters for BPM Process Store and a description of each, along with the default values, when applicable.

**Parameters**

**Table 14: BPM Process Store configuration parameters**

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BPM Process Store Server Debug Control Flag</td>
<td>False</td>
<td>If set to True, the debug (trace) information is written to the log file for the BPM Process Store engine.</td>
</tr>
<tr>
<td>BPM Process Store Server Debug SQL Flag</td>
<td>False</td>
<td>If set to True, all the SQL statements used in BPM Process Store engine are written to the log file while starting up.</td>
</tr>
<tr>
<td>BPM Process Store Server Event Trace</td>
<td>False</td>
<td>If set to true, server writes the various events in the log file.</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Timer Interval for BPM Process Store</td>
<td>10000</td>
<td>The number of milliseconds BPM Process Store sleeps when it is idling. The values should be in range of 5000-60000 milliseconds.</td>
</tr>
<tr>
<td>Sending Email Notifications</td>
<td>True</td>
<td>If set to True, then an email notification containing details is sent to the system administrator when an error occurs.</td>
</tr>
</tbody>
</table>

**Reloading the configuration parameters**

After you change the configuration parameters either by editing the `bpmprocessstore.conf` file, or by using the BPM Process Store Configuration interface, you can reload the updated configuration parameters without restarting the server. Business Process Server contains a BPM Process Store utility to do this, in the `OEBPS_HOME/bin` folder.

**For Windows:**
bpmProcessStore.cmd refresh

**For UNIX:**
bpmProcessStore.sh refresh

**Note:** If you have changed the Batchsize parameter, then you must restart the server to reload it.

**Using the email server configuration interface**

Business Process Server stores e-mail account information in the `oebpsemail.properties` file, located in the `OEBPS_HOME/conf` directory. To adjust any of these parameters you must access the `oebpsemail.properties` file. The parameters you may adjust in this file are described in Table 15 on page 78.

**To configure email server using Business Process Portal:**

1. In the Administration module, click **System > Configuration > Email**, to view the Email Configuration page.

   This page displays your current configuration settings for Email Server.
An example of this page is shown in the following figure.

Figure 25: Using the email server configuration page

2. You can scroll through the listed parameters and modify values, as required. Refer to Table 15 on page 78 for a description of the Email Server parameters.

3. Click **Save**. Business Process Server updates the configuration after your confirmation.

### Email server configuration parameters

Table 15 on page 78 presents the configuration parameters for Email server, a description of use, along with default values, if applicable.

#### Parameters

**Table 15: Email server configuration parameters**

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP Server Email ID</td>
<td><a href="mailto:oebpsadmin@apac.progress.com">oebpsadmin@apac.progress.com</a></td>
<td>The e-mail ID for BP Server to send e-mail notifications and receiving the user’s e-mail for completing the work item.</td>
</tr>
<tr>
<td>System Admin Email ID¹</td>
<td><a href="mailto:oebpsadmin@apac.progress.com">oebpsadmin@apac.progress.com</a></td>
<td>The email ID of system administrator to send email notifications during some system problems.</td>
</tr>
<tr>
<td>protocol¹</td>
<td>imap</td>
<td>The protocol used to receive the mails from the mail server, i.e. values could be IMAP/POP3. An optional property, the default is IMAP if a default property is not specified.</td>
</tr>
<tr>
<td>Port number for outgoing mail server</td>
<td>25</td>
<td>The port number of the outgoing mail server.</td>
</tr>
<tr>
<td>User customized Email Adapter Sender Class¹</td>
<td>None</td>
<td>The full name of the class used as an Email Adapter’s sender class.</td>
</tr>
<tr>
<td>Parameter name</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Email Server¹</td>
<td>mail.apac.progress.com</td>
<td>The name of the mail server where the mailbox of bpserver.email.id is located.</td>
</tr>
<tr>
<td>Check e-mail frequency</td>
<td>60000</td>
<td>The e-mail check frequency in milliseconds.</td>
</tr>
<tr>
<td>Temporary attachment path¹</td>
<td>OEBPS_Home\BPServer\tmp\</td>
<td>The path for temporarily saving the documents attached in e-mail.</td>
</tr>
<tr>
<td>Debug flag for Email Session</td>
<td>False</td>
<td>The flag that controls the e-mail session logging.</td>
</tr>
<tr>
<td>Debug flag Email Components</td>
<td>False</td>
<td>The flag that controls the e-mail component logging.</td>
</tr>
</tbody>
</table>

### Using BP Server admin

You can choose to publish Business Process Server applications using a command-oriented interface known as BP Server Admin. You can use BP Server Admin commands to create and install process templates. Refer to the "Using BP Server Admin" chapter in the BP Server Developer's Guide.

### Troubleshooting BP Server configuration

This section answers the most frequently asked questions about troubleshooting BP Server configuration.

#### Troubleshooting

<table>
<thead>
<tr>
<th>Question</th>
<th>Answer</th>
</tr>
</thead>
<tbody>
<tr>
<td>I cannot start BP Server.</td>
<td>Check the version of your JDK and make sure that the CLASSPATH for the JDK is set properly.</td>
</tr>
<tr>
<td>The Web API was deprecated for version 3.0. What can I use for similar</td>
<td>The three Web API servlets were BLPT (completing a step from the Web), BLST (checking the status of the Web process) and BLCP (creating a Web process instance). Use the WebApp worksteps with e-mail performers to replace BLPT functionality. Implement BLST as a Web application using Progress Developer Studio for OpenEdge. A Web application designed by OpenEdge can use the PAKcreatePI adapter to implement similar functionality to BLCP.</td>
</tr>
<tr>
<td>functionality?</td>
<td></td>
</tr>
<tr>
<td>BP Server generates a core dump or presents a java.lang.StackOverflow error when working with large XML files.</td>
<td>Sun's implementation of the Java Virtual Machine in JDK releases 1.0.2 and 1.1, and the Java 2 SDK, Standard Edition v1.2, allocate fixed-size native method stacks of a single size. You can set the size of the native method stacks on virtual machine start-up using the &quot;-ss&quot; flag.</td>
</tr>
<tr>
<td>Question</td>
<td>Answer</td>
</tr>
<tr>
<td>-------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Applications created through BP Server Admin could not be uninstalled through Administration, even though I received a Done message.</td>
<td>Check if instances are still running, otherwise the application will not uninstall. Remove instances using BP Server Admin and remove the application using Administration.</td>
</tr>
<tr>
<td>Security properties are not found using defaults after starting BPM Process Store, BP Server, or BP Server Admin.</td>
<td>Check if you have entered the utility startOEBPS -c BPServer|BPMProcessStore at your system's command prompt. If started from the command prompt, then shutdown all the components started individually. Then start Business Process Server by <strong>Start &gt; Programs &gt; Progress &gt; OpenEdge &gt; BP Server &gt; Start Business Process Server</strong>. Do not start components individually from the command prompt.</td>
</tr>
<tr>
<td>What if the e-mail support raises a security exception?</td>
<td>Open the oebpsemail.properties file and find the BPServer.EmailServer.UniqueID parameter. Set to False to flush process instances and remove the e-mail security exception. Set to True enables the security feature. The default is set to True.</td>
</tr>
<tr>
<td>What causes a gap that sometimes occurs in ID sequence in the process instance ID or process template ID in BP Server?</td>
<td>BP Server uses a sequence tool to generate IDs for process template and process instance. For every sequence, such as process instance sequence, BP Server caches 10 numbers in memory in order to avoid too frequent database access. If you stop the server or the server crashes, then all the cache numbers are lost from memory. This is a common behavior.</td>
</tr>
</tbody>
</table>
Configuring BPM Events

This chapter explains how to configure BPM Events using Business Process Portal’s Administration module. This chapter also explains how to prepare and administer business rules and events, along with BPM Events backup and restore procedures. It further describes how to use BPM Events Admin and other utilities.

Note: The BPM Events rule language and BPM Events utilities are described in detail in the BPM Events User’s Guide.

For details, see the following topics:

- Using the BPM Events configuration interface
- Loading applications and recovering applications

Using the BPM Events configuration interface

Business Process Server stores the configuration parameters for BPM Events in the bpmevents.conf file, located in the OEBPS_HOME\conf directory. You use the Configuration interface in the Administration module to configure these parameters. To see additional parameters that are not visible in the interface, refer to the bpmevents.conf file.

To configure BPM Events using Business Process Portal:

1. In the Administration module, click System > Configuration > BPM Events, to view the BPM Events Configuration page.

   This page displays your current configuration settings for BPM Events.
An example of this page is shown in the following figure.

**Figure 26: Using the BPM Events configuration page**

2. You can scroll through the listed parameters and modify values, as required. Refer to Table 17 on page 82 for a description of the parameters.

3. Click **Save**. Business Process Server updates the configuration after your confirmation.

### BPM Events configuration parameters

Table 17 on page 82 presents the configuration parameters for BPM Events and their descriptions, along with default values, when appropriate.

#### Parameters

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Debug Flag</td>
<td>off</td>
<td>If set to on, the debug (trace) information is written to the log file.</td>
</tr>
<tr>
<td>Database Access Trace</td>
<td>off</td>
<td>If set to on, the database access information is written to the log file.</td>
</tr>
<tr>
<td>Event Cache Size</td>
<td>10000</td>
<td>The maximum size, in number of events, of the BPM Events event cache.</td>
</tr>
<tr>
<td>Sender Email</td>
<td><a href="mailto:oebpsadmin@apac.progress.com">oebpsadmin@apac.progress.com</a></td>
<td>The default sender e-mail address for BPM Events.</td>
</tr>
<tr>
<td>Automatic Error Recovery</td>
<td>on</td>
<td>If set to on, when an error is caught by the event reader, it processes the next event, otherwise it stops processing events.</td>
</tr>
<tr>
<td>DB Maximum Transaction Duration</td>
<td>30</td>
<td>Maximum duration of DB Transaction in minutes, default 30 minutes</td>
</tr>
</tbody>
</table>
### Loading applications and recovering applications

BPM Events automatically keeps a database image of its internal state for recovery purposes. When starting BPM Events through the Administration module of Business Process Portal, it automatically reloads the latest recovery backup (if any), and processes the event backlog generated in the database event queue while BPM Events is down. No data is lost due to a shutdown, whether voluntary (operator) or not (server crash). However, it is possible to make a fresh start using the "discardBPMEventsBackup" utility script (see the BPM Events User's Guide).

Do not confuse starting BPM Events with loading (or reloading) an application. The following describes the difference between starting BPM Events and loading an application:

- **Starting BPM Events.** Automatically triggers the recovery mechanism for all applications loaded during the latest shutdown. The internal state is recovered, as it was at the end of the processing of the latest event before shutdown. The processing proceeds, as if there was no interruption. If no application was running before, or if a new application requires starting, then load this application after BPM Events is started.

- **Loading an application.** Involves loading rules using a procedure quite different from recovery. When you start BPM Events, if some applications were recovered, then do not load BPM Events again (in fact, you cannot unless you unload it first). When loading a rule module, the `initialize{}` section is automatically executed. It contains initialization statements that create and initialize infopads. This does not happen when recovering an application or a module.

---

<table>
<thead>
<tr>
<th>Parameter name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Batch Size</td>
<td>100</td>
<td>Maximum size of each batch of events fetched from the database. Format: integer</td>
</tr>
<tr>
<td>Sleep Time</td>
<td>3000</td>
<td>Period (milliseconds) between fetching two batches of events. Format: integer</td>
</tr>
<tr>
<td>Sleep Time When Events</td>
<td>0</td>
<td>Period (milliseconds) between fetching two batches of events when there are still events in BPM Events table. Format: integer</td>
</tr>
<tr>
<td>Retry Interval</td>
<td>30000</td>
<td>Period (milliseconds) between retry of database connection. Format: integer</td>
</tr>
<tr>
<td>Maximum Database Retry Number</td>
<td>-1</td>
<td>Maximum database retry number when connection failed. By default, the value is -1, which specifies that BPM Events tries to re-establish the connection infinitely until the database is up or BPM Events is shut down. Format: integer</td>
</tr>
<tr>
<td>Maximum Total Prepared Statement</td>
<td>100</td>
<td>Maximum number of opened prepared statements. Format: integer</td>
</tr>
<tr>
<td>Max Gap Retry</td>
<td>10</td>
<td>Maximum retry number when an event gap is found. Format: integer</td>
</tr>
<tr>
<td>BPM Events Callback</td>
<td>False</td>
<td>If set to true, change of BPM Events states is notified by invoking registered callback adapters.</td>
</tr>
</tbody>
</table>
Similarly, stopping BPM Events does not unload the application. The following describes the
difference between stopping BPM Events and unloading an application:

• **Stopping BPM Events.** BPM Events automatically shuts down so that it can restart and resume
the processing of events as if there was no interruption. The latest state of all loaded applications
is saved to the database, so that after recovery of these can resume without any intervention
from the user.

• **Unloading an application.** A unloaded rule module automatically execute its `finalize()`
section. The statements in this section will typically delete application objects (infopads) from
both the memory and the database. If you unload an application, then you remove all trace of
this application in the rule engine, including the recovery backup in the database. When restarting
BPM Events, this application is not recovered. When you reload the application, it is similar to
a new installation: the application state and objects are reinitialized.

Finally, the BPM Events Admin utility provides another mode of adding rules in the engine—the
Replace command (for an application or for a single rule module). Replacing an application (or
module) is intended for upgrading the rules of the application (or of the module), without affecting
the objects currently manipulated by the application. Unlike unloading, which typically executes
some final statements (like deleting the infopads), the Replace command only replaces the rules—no
`finalize()` or `initialize()` section is executed when unloading then reloading.
Using the Log Viewer

Use the Log Viewer to track the status and error messages for each component. With the Log Viewer, you can see log files for the following:

- Business Process Portal
- OEBPS
- BP Server
- BPM Workflow
- BPM Events
- BPM Process Store
- Archiver
- Event Publisher

Note: You may adjust the log level for these and other categories in the Log Configuration page. Refer to Using the log configuration interface on page 87 for more details.
Chapter 10: Using the Log Viewer

For details, see the following topics:

- Viewing log files
- Configuring the log
- Log configuration

Viewing log files

With the Log Viewer, you can see the priority set for the log levels of each component. You set the priority of each log level in the Log Configuration page in the System menu in the Administration module. Business Process Server stores the priorities for the log levels in oebpslog.conf, located in the OEBPS_HOME\conf directory. For more information, see Using the log configuration interface on page 87.

To access and view log files in the Log Viewer:

1. In the Administration module, click System > Log Viewer.

   The Log Viewer page displays the log messages.

   The example of this page is shown in the following figure.

   Figure 27: Log viewer

   ![Log Viewer Example]

2. To view log files for a specific component, select an option from the Log file to view list.

   To specify the number of lines that each page should contain, enter a number in the Number of Lines box. Business Process Portal remembers this value till you change it.

3. Click Go.

   The log viewer presents the requested log files.
Configuring the log

The Business Process Portal’s Administration module enables you to set the log levels, format, file size, and backup archive files using the Log configuration interface. This section explains how to configure the log levels for categories that include Business Process Portal, BPM Events, BPM Workflow, BPM Process Store, BP Server, Web Services, Dashboard, Archiver, and Event Publisher.

Setting log levels with log4j

You set the log levels in the Log Configuration page as shown in this chapter. Use the Log Viewer feature to view the priority set for the log levels of each category. Log levels are determined by Log4j, a uniform logging framework provided for all Business Process Server components. This framework uses log4j API, an open source logging package available under Apache Public License.

**Note:** For more information about log4j features, visit the Web site: http://jakarta.apache.org/log4j/docs/documentation.html.

The logging appender

As the destination output, appenders may take the form of a console, network socket, UNIX or Windows 2000 syslog files, or an interface. For Business Process Server components, the default appender is the respective log files. In oebpslog.conf, you adjust only two parameters: appender and log level. By default, all Business Process Server categories contain rolling file appenders as the appender and ‘info’ as the log level. For example:

```log4j.category.BPM CustomUI API=info,A2```

Using the log configuration interface

Business Process Server stores the priorities for the log level in the oebpslog.conf file, located in the OEBPS_HOME/conf directory. Business Process Server allows you to change the parameters through the Log configuration interface, as shown in Configuring the log from Business Process Portal on page 88. To see additional parameters that are not visible in the interface, refer to the oebpslog.conf file.

You may adjust log levels in oebpslog.conf under one of the categories listed on the previous page (Business Process Portal modules, BPM Process Store, BPM Events, Archiver, etc.). You can assign one of the following priorities (‘debug’ is the lowest priority and ‘fatal’ is the highest):

- **Debug.** Provides fine-grained information events that are most useful in debugging an application.
- **Info.** Provides coarse-grained information events that highlight the progress of an application
- **Warn.** Indicates potentially harmful situations.
- **Error.** Indicates error events that might still allow the application to continue.
- **Fatal.** Indicates very severe events that can presumably cause the application to abort.
If you want to change the log level for BPM Process Store, BP Server, Archiver or Event Publisher, then you must also navigate to the *.conf file for the category (for example, bpmprocessstore.conf in the OEBPS_HOME\conf directory) and change the settings for the following parameters (if they are present) to ‘true’, as shown in the following example for the BPM Process Store category:

bpmprocessstore.debug.engine=true
bpmprocessstore.printEvent=true
bpmprocessstore.printStack=true
bpmprocessstore.debug.sql=true

Configuring the log from Business Process Portal

To configure the Log using the Administration module in Business Process Portal, complete the following steps:

1. In the Administration module, click System > Configuration > Log.

   The Log Configuration page appears as shown in the following figure. This page displays the list of components that you can configure.

   Figure 28: Using the log configuration page

   ![Log Configuration Page](image)

   2. You can scroll through the listed parameters and modify values, as required. Refer to Table 18 on page 89 for a description of the parameters.

   3. Click Save.

      Business Process Server updates the configuration after your confirmation.

Log configuration

Table 18 on page 89 presents the configuration parameters for the log and a description of use, along with default values, if appropriate.
## Parameters

**Table 18: Log configuration**

<table>
<thead>
<tr>
<th>Configuration name</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OEBPS Log Level</td>
<td>info, OEBPS</td>
<td>The log level for messages written to the default OEBPS log file.</td>
</tr>
<tr>
<td>OEBPS Log Maximum File Size</td>
<td>6MB</td>
<td>The Maximum size for the OEBPS log file. MB or KB should be capitalized.</td>
</tr>
<tr>
<td>OEBPS Log Maximum Number of Backups</td>
<td>3</td>
<td>The maximum number of backup archive files used for the OEBPS log file.</td>
</tr>
<tr>
<td>OEBPS Log Message Format</td>
<td>%d{DATE} %c{3} %p - %m%n</td>
<td>Format messages in the OEBPS log file according to this pattern.</td>
</tr>
<tr>
<td>Business Process Portal Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for Business Process Portal log file before back up or clean up.</td>
</tr>
<tr>
<td>Business Process Portal Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for Business Process Portal log file.</td>
</tr>
<tr>
<td>Business Process Portal Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>BPMEvents Log Level</td>
<td>info, BPMEvents.File</td>
<td>The log level for messages written to the BPMEvents log file.</td>
</tr>
<tr>
<td>BPMEvents Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the BPMEvents log file before back up or clean up.</td>
</tr>
<tr>
<td>BPMEvents Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the BPMEvents log file.</td>
</tr>
<tr>
<td>BPMEvents Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>BPMEventsOutput Log Level</td>
<td>info, BPMEventsOutput.File</td>
<td>The log level for messages written to the BPMEventsOutput log file.</td>
</tr>
<tr>
<td>BPMEventsOutput Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the BPMEventsOutput log file before back up or clean up.</td>
</tr>
<tr>
<td>BPMEventsOutput Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the BPMEventsOutput log file.</td>
</tr>
<tr>
<td>BPMEventsOutput Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>BPMWorkflow Log Level</td>
<td>info, BPMWorkflow.File</td>
<td>The log level for messages written to the BPMWorkflow log file.</td>
</tr>
<tr>
<td>BPMWorkflow Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the BPMWorkflow log file before back up or clean up.</td>
</tr>
<tr>
<td>Configuration name</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>BPMWorkflow Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the BPMWorkflow log file.</td>
</tr>
<tr>
<td>BPMWorkflow Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>BPMProcessStore Log Level</td>
<td>info, BPMProcessStore.File</td>
<td>The log level for messages written to the BPMProcessStore log file.</td>
</tr>
<tr>
<td>BPMProcessStore Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the BPMProcessStore log file before back up or clean up.</td>
</tr>
<tr>
<td>BPMProcessStore Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the BPMProcessStore log file.</td>
</tr>
<tr>
<td>BPMProcessStore Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>WebService Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the WebService log file before back up or clean up.</td>
</tr>
<tr>
<td>WebService Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the WebService log file.</td>
</tr>
<tr>
<td>WebService Log Message Format</td>
<td>%d{DATE} %c{3} %p - %m%n</td>
<td>Format messages in the WebService log file according to this pattern.</td>
</tr>
<tr>
<td>mconsole Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the mconsole log file before back up or clean up.</td>
</tr>
<tr>
<td>mconsole Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the mconsole log file.</td>
</tr>
<tr>
<td>Management Console Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>Event Publisher Log Level</td>
<td>info, EventPublisher.File</td>
<td>The log level for messages written to the Event Publisher log file.</td>
</tr>
<tr>
<td>Event Publisher Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the Event Publisher log file before back up or clean up.</td>
</tr>
<tr>
<td>Event Publisher Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the Event Publisher log file.</td>
</tr>
<tr>
<td>Event Publisher Log Message Format</td>
<td>[#</td>
<td>%d{DATE}</td>
</tr>
<tr>
<td>BPServer Log Level</td>
<td>info,BPServer.File</td>
<td>The log level for messages written to the BPServer log file.</td>
</tr>
<tr>
<td>Configuration name</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>BPServer Maximum File Size</strong></td>
<td>6MB</td>
<td>Maximum size for the BPServer log file before back up or clean up.</td>
</tr>
<tr>
<td><strong>BPServer Maximum Number of Backups</strong></td>
<td>3</td>
<td>Maximum number of backup archive files used for the BPServer log file.</td>
</tr>
<tr>
<td><strong>BPServer Log Message Format</strong></td>
<td>[#{d(DATE)}</td>
<td>%c(3)</td>
</tr>
<tr>
<td><strong>Messaging Log Level</strong></td>
<td>debug,Messaging.File</td>
<td>The log level for Messages written to the message log file.</td>
</tr>
<tr>
<td><strong>Messages Maximum File Size</strong></td>
<td>6MB</td>
<td>Maximum size for the Messages log file before back up or clean up.</td>
</tr>
<tr>
<td><strong>Messages Maximum Number of Backups</strong></td>
<td>3</td>
<td>Maximum number of backup archive files used for the Messages log file.</td>
</tr>
<tr>
<td><strong>Messages Log Message Format</strong></td>
<td>[#{d(DATE)}</td>
<td>%c(3)</td>
</tr>
<tr>
<td><strong>BPServer Client Library Log Level</strong></td>
<td>info, BPServerClient.File</td>
<td>The log level for messages written to the BPServer Client Library log file.</td>
</tr>
<tr>
<td><strong>BPServer Client Library Maximum File Size</strong></td>
<td>6MB</td>
<td>Maximum size for the BPServer Client Library log file before back up or clean up.</td>
</tr>
<tr>
<td><strong>BPServer Client Library Maximum Number of Backups</strong></td>
<td>3</td>
<td>Maximum number of backup archive files used for the BPServer Client Library log file.</td>
</tr>
<tr>
<td><strong>BPServer Client Library Log Message Format</strong></td>
<td>[#{d(DATE)}</td>
<td>%c(3)</td>
</tr>
<tr>
<td><strong>Home Log Level</strong></td>
<td>info, MAAdapter.File</td>
<td>The log level for messages written to the Home log file.</td>
</tr>
<tr>
<td><strong>Home Maximum File Size</strong></td>
<td>6MB</td>
<td>Maximum size for the Home log file before back up or clean up.</td>
</tr>
<tr>
<td><strong>Home Maximum Number of Backups</strong></td>
<td>3</td>
<td>Maximum number of backup archive files used for the Home log file.</td>
</tr>
<tr>
<td><strong>Home Log Message Format</strong></td>
<td>[#{d(DATE)}</td>
<td>%c(3)</td>
</tr>
<tr>
<td><strong>pim Log Level</strong></td>
<td>info,pim.File</td>
<td>The log level for messages written to the pim log file.</td>
</tr>
<tr>
<td><strong>pim Maximum File Size</strong></td>
<td>6MB</td>
<td>Maximum size for the pim log file before back up or clean up.</td>
</tr>
<tr>
<td><strong>pim Maximum Number of Backups</strong></td>
<td>3</td>
<td>Maximum number of backup archive files used for the pim log file.</td>
</tr>
<tr>
<td><strong>pim Log Message Format</strong></td>
<td>[#{d(DATE)}</td>
<td>%c(3)</td>
</tr>
<tr>
<td>Configuration name</td>
<td>Default value</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>sdms Log Level</td>
<td>info,sdms.File</td>
<td>The log level for messages written to the sdms log file.</td>
</tr>
<tr>
<td>sdms Maximum File Size</td>
<td>6MB</td>
<td>Maximum size for the sdms log file before back up or clean up.</td>
</tr>
<tr>
<td>sdms Maximum Number of Backups</td>
<td>3</td>
<td>Maximum number of backup archive files used for the sdms log file.</td>
</tr>
<tr>
<td>sdms Log Message Format</td>
<td>[%d{DATE}</td>
<td>%c{3}</td>
</tr>
</tbody>
</table>
Managing event channels

This chapter explains how to use the Administration module of Business Process Portal to configure event channels. The Event Channel Configuration page enables the Business Process Server administrator to create, view, update and remove event channel. For details, see the following topics:

• Managing event channels

Managing event channels

Business Process Server enables you to manage event channels by displaying information about existing channels, adding new channels, removing channels, updating existing channels.

You can manage event channels from the Administration module of Business Process Portal by using the Event Channel Configuration page as illustrated in Figure 29 on page 94.

You can perform the following tasks from this page:

• Display information about an existing channel.
• Create and remove channels.
• Update the channel information.

Displaying information about an event channel

To view the Event Channel Configuration page, in the Administration module, click System > Configuration > Event Publisher.
This page lists all current channels, as shown in the following figure.

**Figure 29: Event channel configuration page**

The Event Channel Configuration page displays information about the existing channels and the following information about each channel:

### Table 19: Event channel information

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Channel Name</td>
<td>The name of the event channel.</td>
</tr>
<tr>
<td>Channel Type</td>
<td>Whether the event channel is of type topic or queue.</td>
</tr>
</tbody>
</table>

To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the Event Channel Configuration page, you can:

- Add channels.
- View/modify channel details.
- Delete a channel.

These operations are explained further in this chapter in the following sections.

### Adding event channels

To create an event channel, complete the following steps:

1. In the Event Channel Configuration page, click Add Channel.

   The Add Channel page is displayed enabling you to create a new channel.
An example of this page is shown in the following figure.

**Figure 30: Add channel page**

2. Specify requisite details in appropriate fields.

You must enter the name of the queue or topic set up on your server as the channel name. The fields marked with a red asterix are required fields.

Optionally, you can also specify a filter condition that can be applied to the messages sent to the queue or topic in the Filter Condition section.

a) Specify the filter type in the **Type** text box.

b) Specify the BP Server Event Value in the **Value** text box. Alternatively, click **Add** beside this text box, select the event value(s) in the **BPServer Event Values** window that opens, and then click **Submit**.

Your selected values are added in the text box.

c) Specify the process template and workstep template names in appropriate boxes.

d) In the Context panel, click **Add** to open the **Add Context** window. Enter the context name beginning with "CTX." and value in appropriate boxes, and then click **Save**.

The context name and value is added in the Context table. To remove it from the table, select its checkbox in the first column, and then click **Delete**.

3. Click **Save** to add the new event channel and go back to the previous page.

To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

**Deleting channels**

You can delete a particular event channel that you no longer need.

To do so, follow these steps:

1. In the **Event Channel Configuration** page, select the channel that you want to delete.
2. Click **Delete**.

Business Process Portal deletes the selected event channel and it is removed from the list.

---

**Note:** You can simultaneously delete multiple channels. To do this, in the **Event Channel Configuration** page, select multiple channels and then click **Delete**. Business Process Portal deletes all the selected channels.

---

### Updating event channel information

To update event channel information, complete the following steps:

1. In the **Event Channel Configuration** page, click the event channel name hyper link in the **Channel Name** column, whose details you want to update.

   The **Modify Channel** page is displayed.

   An example of this page is shown in the following figure.

   **Figure 31: Modify channel page**

2. Enter/modify the relevant data as necessary.

3. Click **Save** to save the changes and go back to the previous page.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.
Working with administrative filters

If the out of box filters provided by Business Process Server do not meet your requirements, then you, as a Business Process Server administrator, can create filters that can be used by others in your organization. Such filters are called “Admin Filters”. For more information about Admin and other types of filters, see the Business Process Portal User’s Guide.

For details, see the following topics:

• Managing administrative filters
• Adding admin filters

Managing administrative filters

To view the Filter List page, in Administration module click System > Filter.
This page lists the out-of-the-box filters as well as any filters created by you, as a Business Process Server administrator, as shown in the following figure.

Figure 32: Filter list page

The **Filter List** page displays information about the filters defined by you. By default, it displays all filters created by you and the following information about each filter:

Table 20: Filter list information

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>The name of the filter.</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about a filter.</td>
</tr>
<tr>
<td>Filter Type</td>
<td>The type of the filter.</td>
</tr>
</tbody>
</table>

To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see *Exploring Business Process Portal* on page 28.

From the **Filter List** page, you can perform the following operations:

- Add a new Admin Filter, as described in *Adding admin filters* on page 98.
- Copy an existing Admin Filter, as described in *Copying, modifying, and deleting admin filters* on page 99.
- Modify an existing Admin Filter, as described in *Copying, modifying, and deleting admin filters* on page 99.
- Delete a Admin Filter, as described in *Copying, modifying, and deleting admin filters* on page 99.

**Adding admin filters**

To remove clutter and to focus on your work, you can limit the tasks displayed in your Task list by defining your own filters.
As adding a new Admin Filter is very similar to adding a new My Filter by a Business Process Server User from the Home module, for more information, see the *Business Process Portal User's Guide*. The only difference in adding a My Filter and adding an Admin Filter is that, in the case of a version-specific Admin Filter, in addition to the system dataslots, you can also use the global dataslots defined for that version while defining the filtering condition and/or sorting order.

The added filter is displayed on the **Filter List** page, with Filter Type as "Admin Filter."

The filters you create here are added under the "Global Filters" group of the Default Filter drop-down list in the **Profile** page in Home module. When you select an application from the Application drop-down list in the **Profile** page in Home module, the Admin Filters defined for that application are displayed in the Default Filter drop-down list.

They are also available under "Global Filters" group of the Filter drop-down list in the **Task List** page in Home module. If you select a specific application from the Application drop-down list and 'All' from the version drop-down list, then the Admin Filters defined for all versions of that application are displayed. If you select a specific application from the Application drop-down list and a specific version from the version drop-down list, then the Admin Filters defined for selected version of that application are displayed.

### Copying, modifying, and deleting admin filters

As copying an existing Admin Filter, modifying an existing Admin Filter, and deleting an Admin Filter operations are identical to the ones that are performed by a Business Process Server User from the Home module, for more information about these operations, see the *Business Process Portal User's Guide*. 
Working with business calendars

To accurately calculate a task's due date, Business Process Server considers the availability of the task's performers. Performers' availability in turn depends on their working time — that is, business hours and business days — and non-working time — that is, holidays and weekends.

The administrator can define business calendars using the Business Calendar feature, and can assign them to specific users and/or groups.

This chapter explains how to use the Business Calendar feature.

Note: For more information on using tags to define calendars and other technical aspects, see the Business Calendar chapter in the *BP Server Developer's Guide*. 
For details, see the following topics:

- Displaying all business calendars
- Defining business calendars
- Editing business calendars
- Displaying calendar view
- Setting/Unsetting a default calendar
- Opening the default OEBPS calendar
- Business calendar restrictions
- Commands for calendar management

Displaying all business calendars

The Calendar List page lists all the existing business calendars. To view the Calendar List page, in the Administration module, click System > Calendars.

This page lists all business calendars, as shown in the Figure 33 on page 102.

Figure 33: Calendar list page

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Description</th>
<th>View</th>
<th>Default Selection</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>No Calendar</td>
<td>This will use the system default calendar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Progress</td>
<td>USA</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Services</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The Calendar List page lists all the existing business calendars and displays the following information about each business calendar:

Table 21: Calendar list information

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the business calendar.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the business calendar.</td>
</tr>
</tbody>
</table>
Defining business calendars

To define a business calendar, complete the following steps:

1. In the Calendar List page, click Add Calendar.

   The Add Calendar page, containing General, Working Time and Non-working Time sections, is displayed enabling you to enter the new business calendar information.

   An example of this page is shown in the following figure.
Note: If you want to use a predefined business calendar as a template for the business calendars you want to create, then see Opening the default OEBPS calendar on page 113. For limitations on Business Calendars, see Business calendar restrictions on page 115.

Figure 34: Add calendar page (General section)

2. In the General section, enter relevant data, as explained below:
   a) Specify a name and description for the business calendar in the **Name** and **Description** boxes respectively.

   **Note**: You should not use the following special characters in the name or description while defining a calendar: <, >, ", ", %, ;, +, \, and |.

   b) Select the geographical time zone to be used for the business calendar from the **Time Zone** drop-down list. **Name**, **Description**, and **Time Zone** are the required fields.

   c) Define the Year Range for the business calendar by selecting the start and end years from the **From** and **To** drop-down lists respectively.

   d) Define the Regular Business Hours by specifying the start and end times using the **Start Time** and **End Time** drop-down lists respectively.

   e) Define the Mid-Day Break by specifying the start and end times using the **Start Time** and **End Time** drop-down lists respectively.

3. Open the Working Time section to define Working Time.
An example of this page is shown in the following figure.

**Figure 35: Add calendar page (Working time section)**

You can define working time if you want to specify business hours different than the regular business hours defined in the General section. For more information, see Managing working time on page 106.

4. Open the Non-working Time section to define non-working time.

An example of this page is shown in the following figure.

**Figure 36: Add calendar page (Non-working time section)**

If you want to specify a holiday or weekend, then you can define it in the Non-working Time section. For more information, see Managing non-working time on page 107.

5. Click **Save** to define the new business calendar and go back to the previous page.

To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.
Managing working time

If you want to define different business hours only for a specific day, then you can do so in the Working Time section.

Perform the following:

1. In the Working Time section of the Add Calendar or Calendar Details page, click the Add Working Time button at the bottom of the Working Time table.

   The Add Working Time window is displayed.

   An example of this window is shown in the following figure.

   ![Figure 37: Add working time window](image)

   a) In the Day/Date panel, specify whether you want to add working time for a specific day of the week or a specific date by selecting the Day or Date option. Then depending on your selection, specify the day of the week from the Day drop-down list, or specify the date by selecting appropriate value(s) from the Year, Month and Date drop-down lists.

   When you add a working time, it takes priority over the regular business hours for that day. Hence, while defining the working time, you may also need to include the regular business hours. For example, if your regular working hours on a particular day are 09:00 to 18:00, and you want to indicate additional working hours from 18:00 to 20:00, then you should define the working time as 09:00 to 20:00.

   b) In the Time panel, define working hours by specifying the start and end times using the Start Time and End Time drop-down lists respectively.

   c) Click Save to add the new working time and go back to the previous page.

      Click Save & Add New to save the current working time and reload the current window to continue adding another working time.

      To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current window, click Cancel.

      The new working time is added in the Working Time table.

      **Note:** The non-working time has priority over the working time. Working time defined for a weekend or holiday is not considered while calculating the due date.

2. You can change the working hours of an existing day/date entry from the Working Time table. To do so, in the Working Time table, click the Day or Date link for the entry whose details you want to change.

   The Working Time Details window is displayed.
An example of this window is shown in the following figure.

**Figure 38: Working time details window**

![Working Time Details Window](image)

a) In the Time panel, change working hours by specifying the start and end times using the **Start Time** and **End Time** drop-down lists respectively.

b) Click **Save** to update the working time and go back to the previous page.

To reset the form and remove the information you just entered, click **Reset**. Click **Delete** to remove the current working time. To cancel the action and exit the current window, click **Cancel**. The updated working time is added in the Working Time table.

**Note:** You should only change the working hours of the existing entry. If you change the day or date, then it is saved as a new working time entry in the table.

---

3. To delete one or more working time entries, select the working time entries that you want to delete from the table.

For more details about this operation, see **Selecting and clearing rows** on page 35.

4. Click **Delete Working Time** button at the bottom of the Working Time table.

The selected entries are removed.

### Managing non-working time

Non-working Time consists of Holidays (half-day or full day) and Weekends.

**To define these, complete the following steps:**

1. In the Non-working Time section of the **Add Calendar** or **Calendar Details** page, click the **Add Non-working Time** button at the bottom of the Non-working Time table.

   The **Add Non-working Time** window is displayed.

   An example of this window is shown in the following figure.

   **Figure 39: Add non-working time window**

   ![Add Non-working Time Window](image)

   a) Specify a name for the non-working time in the **Name** box.
**Note:** Non-working time name must not contain a comma (",").

b) Select appropriate options from the other panels depending on the type of holiday you want to define.

For more details, see Settings for weekends and holidays on page 108.

c) Click **Save** to add the new non-working time and go back to the previous page. Click **Save & Add New** to save the current non-working time and reload the current window to continue adding another non-working time. To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current window, click **Cancel**. The new non-working time is added in the Non-working Time table.

2. You can change the details of the non-working time. To do so, in the Non-working Time table, click the non-working time name link in the Name column, whose details you want to change.

The **Non-working Time Details** window is displayed.

An example of this window is shown in the following figure.

**Figure 40: Non-working time details window**

<table>
<thead>
<tr>
<th>Non-working Time Details</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name:</strong> Saturday</td>
</tr>
<tr>
<td><strong>Type:</strong> Select One</td>
</tr>
<tr>
<td><strong>Weekend</strong></td>
</tr>
<tr>
<td><strong>Holiday</strong></td>
</tr>
<tr>
<td><strong>Year:</strong> Select One</td>
</tr>
<tr>
<td><strong>Month:</strong> Select One</td>
</tr>
<tr>
<td><strong>Select One:</strong></td>
</tr>
<tr>
<td><strong>Date:</strong> 1</td>
</tr>
<tr>
<td><strong>Day:</strong> Saturday</td>
</tr>
<tr>
<td><strong>Occurrence:</strong> All</td>
</tr>
<tr>
<td><strong>Save</strong></td>
</tr>
<tr>
<td><strong>Reset</strong></td>
</tr>
<tr>
<td><strong>Delete</strong></td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
</tr>
</tbody>
</table>

a) The name of the non-working time is displayed in read-only mode.

b) Select appropriate options from the other panels depending on the type of holiday you want to define.

For more details, see Settings for weekends and holidays on page 108.

c) Click **Save** to update the non-working time and go back to the previous page. To reset the form and remove the information you just entered, click **Reset**. Click **Delete** to remove the current non-working time. To cancel the action and exit the current window, click **Cancel**.

The updated non-working time is added in the Non-working Time table.

3. To delete one or more non-working time entries, select the non-working time entries that you want to delete from the table.

For more details about this operation, see Selecting and clearing rows on page 35.

4. Click **Delete Non-working Time** at the bottom of the Non-working Time table.

The selected entries are removed.

**Note:** You can also define, edit and delete holidays except weekends, from the Calendar View page. For more information, see, Managing holidays on page 111.

---

**Settings for weekends and holidays**

You can define weekends and different types of holidays using different combinations of options in the Add Non-working Time window.
### Table 22: Combinations of settings for weekends and holidays

<table>
<thead>
<tr>
<th>Type of holiday</th>
<th>Values of options</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Type</td>
<td>Year</td>
</tr>
<tr>
<td>Weekend</td>
<td>Weekend</td>
<td>---</td>
</tr>
<tr>
<td></td>
<td>Weekend</td>
<td>---</td>
</tr>
<tr>
<td>Date-specific Holiday</td>
<td>Holiday and Full Day</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Holiday and Full Day</td>
<td>A Specific Year</td>
</tr>
<tr>
<td></td>
<td>Holiday, and First Half or Second Half</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Holiday, and First Half or Second Half</td>
<td>A Specific Year</td>
</tr>
<tr>
<td>Day-of-the-week-specific Holiday</td>
<td>Holiday and Full Day</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>Holiday, and First Half or Second Half</td>
<td>All</td>
</tr>
</tbody>
</table>

---

### Editing business calendars

**To edit a business calendar, complete the following steps:**

1. In the [Calendar List](#) page, click the business calendar name link in the Name column, whose details you want to change.

   The [Calendar Details](#) page is displayed.
An example of this page is shown in the following figure.

Figure 41: Calendar details page (General section)

This page is same as the Add Calendar page except that the Name field in this page is displayed in read-only mode.

2. Make changes as required in the General, Working Time and Non-working Time sections as explained in the Steps 2, 3 and 4 of the Defining business calendars on page 103.

3. You can click the Calendar View link to go to the Calendar View page, where you can view a particular month’s business calendar.

   For more details, see Displaying calendar view on page 110.

4. Click Save to save the current business calendar and go back to the previous page.

   To reset the form and remove the information you just entered, click Reset. Click Delete to remove the current business calendar. To cancel the action and exit the current page, click Cancel.

   Note: You can delete multiple business calendars simultaneously from the Calendar List page. For more details, see Defining business calendars on page 103.

Displaying calendar view

After defining the business hours, weekends and holidays; you can see all these in a more convenient, easy to use and familiar layout of a monthly desktop calendar.

To do this, complete the following steps:

1. In the Calendar List page, click the Calendar View icon ( ) in the View column.
2. ) in the View column.

   The Calendar View page is displayed.
An example of this page is shown in the following figure.

**Figure 42: Calendar view page**

3. From the Calendar drop-down list, select the business calendar to be displayed.
4. Select the month and year from the Month and Year drop-down lists respectively.

   The monthly calendar for the selected month and year is displayed. It displays the weekends and holiday(s), if there are any.

   Additionally, it also displays all the holidays in the selected year in a table in chronological order. You can click the date link of a holiday in this table to load the month in which that holiday falls.

5. Optionally, you can perform following operations:
   - mark a day as a holiday,
   - unmark a holiday.

   For more details, see Managing holidays on page 111.

6. You can click the Calendar Details link to go to the Calendar Details page, where you can view/edit the current business calendar.

   This page is same as the Calendar Details page opened from the Calendar List page. For more details, see Editing business calendars on page 109.

7. Click Cancel to go back to the previous page.

### Managing holidays

From the Calendar View page you can perform following operations:

- Mark a particular day as a holiday,
- Unmark an existing holiday and make it a normal business day.

### Editing a holiday

You cannot edit an existing holiday from the Calendar View; To achieve this, you must first unmark the existing holiday, and then mark the same day as a holiday, with different settings. For more details see Unmarking a holiday on page 112 and Marking a holiday on page 111.

### Marking a holiday

You can define a holiday from the Calendar View.
To do this, complete the following steps:

1. In the Calendar View page, use the Calendar, and then Month and Year drop-down lists to load the month in which you want to mark the holiday.
2. Click the date that you want to mark as a holiday.
   The Mark Holiday window is displayed.
   **Figure 43: Mark holiday window**

   ![Mark Holiday Window](image)

   3. Specify the Name for the holiday.
   4. Choose the Type as a full day holiday or first or second half of the day as a holiday.
   5. Click **Save** to mark the holiday and go back to the previous page.
      To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current window, click **Cancel**.

      The new holiday is added in the adjacent table of the list of holidays.

### Unmarking a holiday

You can delete a holiday and make it as a normal business day from the Calendar View.

To do this, complete the following steps:

1. In the Calendar View page, use the Calendar, and then Month and Year drop-down lists to load the month that contains the holiday to be deleted.
   Optionally, you can click the date link of the holiday in the table listing holidays of the year.
2. Click the date of the holiday that you want to delete.
   The Holiday Details window is displayed.
   **Figure 44: Holiday details window**

   ![Holiday Details Window](image)

   3. Click **Unmark Holiday** to delete the holiday and go back to the previous page.
   To cancel the action and exit the current window, click **Cancel**.

   The deleted holiday is removed from the adjacent table of the list of holidays.
Setting/Unsetting a default calendar

From the list of business calendars, you can specify a particular business calendar as the default calendar. The default calendar is the business calendar used by Business Process Server for due date calculations when no business calendar is assigned to the user and/or the group.

Once you select a default calendar, if needed, you can deselect it so that you have no default calendar.

To set or unset a default calendar, complete the following steps:

1. In the Calendar List page, to set a default calendar, click the option in the Default Selection column for that calendar.

![Calendar List page](image)

To unset the already specified default calendar, click the option in the Default Selection column for the "No Calendar".

2. Click Save to save the settings and go back to the previous page.

To reset the form and remove the information you just entered, click Reset.

Opening the default OEBPS calendar

Business Process Server provides the OEBPS Calendar, a predefined business calendar with a standard 8-hour work day, a standard 5-day work week, and the 17 standard United States holidays. You can use the OEBPS Calendar as a template to quickly create your customized business calendars.
To add the predefined OEBPS Calendar as the default calendar on your Calendar List page:

1. Open the Command Prompt window and navigate to the 
   `%OEBPS_HOME%\conf\resources\common` directory.
2. Enter `createcalendar sbmcalendar.xml` and wait for successful validation.
3. Enter `setsystemcalendar sbmcalendar true`. The message, "sbmcalendar has been set as system calendar" should appear.
4. Navigate to the Calendar List page in Business Process Portal, and the OEBPS Calendar is seen as the default system calendar in the list of calendars.

Assigning business calendar to users and groups

As an administrator, you can assign a business calendar to users and groups. The working time — that is, business hours and business days — and non-working time — that is, holidays and weekends of the assigned business calendars will be applicable to the users and group members. For more information about assigning calendars to users, see Creating users on page 154 and for more information about assigning calendars to groups, see Creating groups on page 165.

If you do not assign any business calendar to the user or group, then the default calendar is used for the due date calculations. Such a user can assign a business calendar to him/herself from the Home module when he/she clicks Preferences > Calendar for the first time.

If you assign a business calendar to a group, and if the group member has already been assigned a different business calendar, then whether the group business calendar or individual business calendar should take precedence is decided by the way the task is assigned to the group. If the task is to be performed by all group members, then the group business calendar takes precedence. However, if the task can be performed by any group member, and if a particular group member assigns such a task to him/herself, then that group member’s business calendar takes precedence over the group calendar.

Deleting business calendars

You can delete one or more business calendars that you no longer need. To do so, follow these steps:

1. In the Calendar List page, select the business calendars that you want to delete.
   For more details about this operation, see Selecting and clearing rows on page 35.
2. Click Delete.
   Business Process Portal deletes the selected business calendars and they are removed from the list.

**Note:** You can also delete a business calendar from the Calendar Details page. For more details, see Editing business calendars on page 109.
Business calendar restrictions

The following restrictions apply to Business Calendar:

• You must enter a value in each of the fields in the General section of the Add Calendar page.
• The Start Time for a Mid-Day Break cannot be greater than or equal to its End Time.
• You cannot add a day-specific holiday (for example, the fourth Thursday of November) as non-working time in the Business Calendar for a specific year. You can only add day-specific holidays for "All" years.
• Non-working Time takes precedence over Working Time. Therefore, if you want to redefine a Weekend or Holiday as Working Time, then you must first unmark the Weekend or Holiday and then assign it as Working Time.
• You can only unmark a holiday defined for a specific year from the Calendar View page. You cannot unmark a holiday defined for "All" years from this page.
• If you have defined a non-working time for a particular date of a specific year, and then if you add a non-working time for "All" years, then Business Process Server adds the latter entry without any alert message. However, if you have already defined a non-working time for a particular date of "All" years, and then try to define a non-working time for the same date for a specific year, then Business Process Server displays an alert message.

For example, if you have defined a non-working time for January 1, 2004, then you can define another non-working time for January 1, All years; but the reverse is not possible.

Similarly, if you have defined a weekend for Sunday, First, then you can define another non-working time for Sunday, All; but the reverse is not possible.

• You cannot configure night shifts in a business calendar.

Commands for calendar management

Business Calendars are typically created and managed from Business Process Portal. Alternatively, the following commands from the %OEBPS_HOME%/bin directory can also be used by the administrator to create and manage the business calendars.

Commands

Table 23: Business calendar commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description / Business Process Portal equivalent commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>createcalendar.sh/.cmd</td>
<td>Create or replace (with override) calendars.<strong>Calendar List page &gt; Add Calendar button</strong></td>
</tr>
<tr>
<td>setsystemcalendar.sh/.cmd</td>
<td>Set a specific calendar as the system calendar.<strong>Calendar List page &gt; Default Selection option &gt; Save button</strong></td>
</tr>
<tr>
<td>checkoutcalendar.sh/.cmd</td>
<td>Checkout the calendar XML to a file. No Business Process Portal equivalent command.</td>
</tr>
</tbody>
</table>
### Command Table

<table>
<thead>
<tr>
<th>Command</th>
<th>Description / Business Process Portal equivalent commands</th>
</tr>
</thead>
<tbody>
<tr>
<td>removecalendar.sh/.cmd</td>
<td>Remove a calendar. [Calendar List page &gt; Select calendar &gt; Delete button]</td>
</tr>
<tr>
<td>listcalendar.sh/.cmd</td>
<td>Lists all calendars. [System &gt; Calendars]</td>
</tr>
</tbody>
</table>
Working with dashboards

This chapter explains you how to define new dashboards, modify the existing ones, set and assign one to users.

The administrator can define new dashboards or modify the existing ones using Business Process Server’s Dashboard feature, and can assign them to specific users and/or groups.

This chapter explains how an administrator can use the Dashboard feature.
For details, see the following topics:

- Displaying all dashboards
- Defining dashboards
- Modifying an existing dashboard
- Configuring dashboard
- Publishing a dashboard
- Setting a default dashboard
- Deleting a dashboard

Displaying all dashboards

The Dashboard List page lists all the existing dashboards.

- To view the Dashboard List page, in the Administration module, click System > Dashboards.

This page lists all dashboards, as shown in the Figure 46 on page 118.

Figure 46: Dashboard list page

The Dashboard List page lists all the existing dashboards and displays the following information about each dashboard:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard Name</td>
<td>The name of the dashboard.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the dashboard.</td>
</tr>
</tbody>
</table>
Professional Knowledge

To navigate through the pages, you can use the paging controls. For more details about this operation, see Exploring Business Process Portal on page 28.

From the Dashboard List page, you can perform the following operations:

- Defining a new dashboard.
- Copying an existing dashboard.
- Viewing/modifying an existing dashboard’s details.
- Publishing a dashboard.
- Setting a default dashboard for all users/groups.
- Deleting a dashboard.

These operations are explained further in the following sections of this chapter.

**Note:** If you are using Internet Explorer 7.0 as your browser, then ensure that the “Check for newer versions of stored pages” option in the Temporary Internet file settings is set to “Every time I visit the webpage”.

---

### Defining dashboards

You can define a dashboard by defining one manually from scratch or by copying from an existing dashboard.

### Defining a new dashboard

**To define a new dashboard, complete the following steps:**

1. In the Dashboard List page, click Create Dashboard.

   The Create Dashboard page, containing General and Users/Groups sections, is displayed enabling you to enter the new dashboard information.
An example of this page is shown in the following figure.

**Figure 47: Dashboard details page (General section)**

2. In the General section, enter relevant data, as explained below:
   a) Specify a name and description for the dashboard in the **Name** and **Description** boxes respectively.

   **Note:** You should not use the following special characters in the name or description while defining a dashboard:
   - For Name: <, >, ", , %, , (, ), &-, \, ^, #.
   - For Description: <, >, ", , %, , (, ), &-, \, ^, #.

   b) From the **Layout** drop-down list, select a layout to be used to arrange the components in the new dashboard.
   
   For example, if you select TwoColumns70-30 layout, then the first column of components occupies 70% of the dashboard width and the second column occupies 30%.

3. Click Component icon.

   The **Add Dashboard Component** window is displayed.
An example of this window is shown in the following figure.

**Figure 48: Dashboard details page and add dashboard component window**

![Dashboard details page and add dashboard component window](image)

a) If you want to add an application specific component, then from the **Application Name** drop-down list, select the name of the application.

b) To add a component that works across all applications, select **All**. Based on your selection of application in the previous step, the Category drop-down list provides you appropriate options.

c) From the **Category** drop-down list, click the category to which you want to add the dashboard component.

d) From the **Component** drop-down list, select the widget to be used in the current component. If you have selected a particular application in the previous step, then this list displays only the widget(s) defined for that application while creating the application in Progress Developer Studio for OpenEdge. For more information about creating widgets, see *OpenEdge Getting Started: Developing BPM Applications with Developer Studio*. If you have selected All in the previous step, then this list displays the out-of-box widgets.

e) Specify a name and description for the dashboard in the **Title** and **Description** boxes respectively.

**Note:** You should not use the following special characters in the name or description while defining a dashboard:

`<, >, ' , " , % , ; , + , \ and |`

f) Click **Save** to define the new component and go back to the previous page. The new component is added in the current dashboard.

To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current window, click **Cancel**.

Repeat the sub-steps provided in step 3 to add more components to the Dashboard.

**Note:** While adding a new component to the Dashboard, ensure that all the widgets are loaded. If you click component icon before the widgets are loaded, then it may lead to Ajax call conflicts.

4. Open the Users/Groups section to assign the current dashboard to existing user(s) and/or group(s).
An example of the this page is shown in the following figure.

Figure 49: Dashboard details page (Users/Groups section)

<table>
<thead>
<tr>
<th>No.</th>
<th>User Name</th>
<th>First Name</th>
<th>Last Name</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Richard</td>
<td>Richard</td>
<td></td>
<td><a href="mailto:richard@serv1.com">richard@serv1.com</a></td>
</tr>
<tr>
<td>2</td>
<td>elena</td>
<td>elena</td>
<td></td>
<td><a href="mailto:elena@serv2.com">elena@serv2.com</a></td>
</tr>
<tr>
<td>3</td>
<td>victor</td>
<td>victor</td>
<td></td>
<td><a href="mailto:victor@serv3.com">victor@serv3.com</a></td>
</tr>
</tbody>
</table>

a) To assign the current dashboard, click **Add**.

The **Add Users & Groups** window is displayed.

b) Search and locate users or groups. For more details, see **Searching Users** on page 40.

c) Click **Add** to add the selected users and/or groups and go back to the previous page.

To cancel the action and exit the current window, click **Cancel**.

d) To delete cancel an assignment to the user/group, select the user and/or group for whom you want to cancel the dashboard assignment, and click **Remove**.

**Note:** Alternatively, you can also assign a dashboard to a user from the **User Details** page. For more information, see **Creating users** on page 154. Similarly, you can assign a dashboard to a group from the **Group Details** page. For more information, see **Creating groups** on page 165.

5. Click **Save** to define the new dashboard and go back to the previous page.

To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

**Copying an existing dashboard**

To create a new dashboard by copying from an existing dashboard, complete the following steps:

1. In the **Dashboard List** page, click **Copy Dashboard**.
The Copy Dashboard window is displayed. An example of this window is shown in the following figure.

**Figure 50: Copy dashboard window**

2. From the Dashboard drop-down list, select the dashboard to be used as a source for copying.
3. In the Save a Copy As box, enter the name with which the copied dashboard is to be saved.
4. Click Save to copy the dashboard and go back to the previous page.

To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

---

### Modifying an existing dashboard

**To edit an existing dashboard, complete the following steps:**

1. In the Dashboard List page, click the dashboard name link in the Dashboard Name column, whose details you want to change.

The Edit Dashboard Details page appears.

An example of this page is shown in the following figure.

**Figure 51: Dashboard details page (General section)**

This page is same as the Dashboard Details page displayed while defining a dashboard except that the Name field in this page is displayed in read-only mode.

2. Make changes as required in the General, Component and Users/Groups sections as explained in the Steps 2, 3 and 4 of the Defining a new dashboard on page 119.
Configuring dashboard

This section guides you to configure auto-refresh for dashboard widgets.

Configuring auto-refresh for the widgets

Configuring auto-refresh for widgets helps to automatically refresh the dashboard content after specified time.

To configure this feature you must update `bpmpportal.conf` file. This file is located at `<OEBPS_HOME>/conf` folder.

The properties listed in the following table are required to configure auto-refresh for widgets:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Possible values</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>bpmpportal.widget.autorefresh</code></td>
<td>If set to true, it refreshes the dashboard widget after the specified refresh interval.</td>
<td>True, False Default - True</td>
</tr>
<tr>
<td><code>bpmpportal.widget.autorefresh.interval</code></td>
<td>Refreshes the widget automatically after the specified interval provided. Auto-refresh should be enabled for this.</td>
<td>Specify the value in seconds.Default - 600 secs.</td>
</tr>
<tr>
<td><code>bpmpportal.widget.autorefresh.target</code></td>
<td>Specify the target widget for which you must enable auto-refresh.</td>
<td>OEBPS,ALL Default - NAR</td>
</tr>
</tbody>
</table>

Enabling auto refresh

Widget auto-refresh can be enabled by setting the property `bpmpportal.widget.autorefresh` to `true`.

This property is used to control only OEBPS widgets in Business Process Portal. This is not applicable for non-OEBPS widgets. On setting this property, auto refresh is enabled for all OpenEdge widgets depending on the target specified.

The default refresh interval value is 600 secs.
Setting target

You can enable auto-refresh for OEBPS. For this you can specify the target at bpmportal.widget.autorefresh.target. The default value is NAR (no auto refresh). The valid values are 'NAR', 'OEBPS' and 'ALL' (case insensitive).

Publishing a dashboard

After defining a dashboard, you must publish it to make it accessible to other users. Other Business Process Server users can view only the dashboards that are published and assigned to them.

To publish a dashboard, follow these steps:

1. In the Dashboard List page, select the dashboards that you want to publish by clicking the check boxes in the Publish column.

   For more details about this operation, see Selecting and clearing rows on page 35.

2. Click Save.

Business Process Portal publishes the selected dashboards.

Setting a default dashboard

From the list of dashboards, you can specify a particular dashboard as the system-level default dashboard for all users and groups. Business Process Portal uses this system-level dashboard for all users and/or groups for whom no dashboard is assigned.

To set a default dashboard, complete the following steps:

1. In the Dashboard List page, click the option in the Default Selection column for that dashboard.

   To specify the Performance Dashboard as a default dashboard, click the option in the Default Selection column for the Performance Dashboard.

2. Click Save to set the selected dashboard as the default dashboard and go back to the previous page.

   To reset the form and remove the information you just entered, click Reset.

Dashboard precedence

As a Business Process Server administrator, you can specify a particular dashboard as the system-level default dashboard for all users and groups. You can also assign dashboards to users and groups individually.

If no dashboard is assigned to a user, then the dashboard assigned to that user’s group gets assigned to him/her. If no dashboard is assigned to a user and his/her group, then the system-level dashboard (defined for all users) gets assigned to him/her.
If you do not define any dashboard, then an out-of-the-box dashboard (bundled with Business Process Server) becomes the system-level default dashboard. The order of precedence of dashboard is as follows:

Table 26: Dashboard precedence

<table>
<thead>
<tr>
<th>Priority</th>
<th>Dashboard type</th>
<th>Defined by ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Dashboard assigned to you</td>
<td>Business Process Server administrator</td>
</tr>
<tr>
<td>2</td>
<td>Dashboard assigned to your group</td>
<td>Business Process Server administrator</td>
</tr>
<tr>
<td>3</td>
<td>System-level dashboard for all users</td>
<td>Business Process Server administrator</td>
</tr>
<tr>
<td>4</td>
<td>Out-of-box dashboard with default components</td>
<td>Business Process Server</td>
</tr>
</tbody>
</table>

Deleting a dashboard

You can delete one or more dashboards that you no longer need.

To do so, follow these steps:

1. In the Dashboard List page, select the dashboards that you want to delete.
   For more details about this operation, see Selecting and clearing rows on page 35.
2. Click Delete.

   Business Process Portal deletes the selected dashboards and they are removed from the list.

Note: The Performance Dashboard cannot be deleted.
Working with widgets

This chapter describes how an administrator can view the widget list for a specific dashboard and how to publish OpenEdge widgets to Progress Control Tower (PCT).
For details, see the following topics:

- Displaying widgets
- Exporting widgets to PCT
- Deploy application pack to PCT

Displaying widgets

The Widgets List page lists all the existing widgets for a specific dashboard.

To view the Widgets List page, in the Administration module, do the following:

1. Click System > Widgets.
2. Select a dashboard from the Dashboard drop-down list.
3. Click Search.
The Widget List page appears, as shown in Figure 52 on page 128.

Figure 52: Widget list page

The Widget List page lists all the existing widgets and displays information about each widget as described in Table 27 on page 128:

Table 27: Widget list information

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Widget Name</td>
<td>Provides the name of the widget. The widget name is specified in the Widget Properties – General Tab dialog box in Progress Developer Studio for OpenEdge.</td>
</tr>
<tr>
<td>Application</td>
<td>Provides the name of the application with which a widget was deployed.</td>
</tr>
<tr>
<td>Chart Type</td>
<td>Provides the chart type values of a widget. The chart type value of a widget is a value specified in the Widget Properties dialog box – Properties Tab dialog box in Progress Developer Studio for OpenEdge. The Chart Type column can have any one of the following values: Area, Line (2D and 3D), Meter, Vertical Bar (2D and 3D), Horizontal Bar (2D and 3D), Pie (2D and 3D), Doughnut (2D and 3D), Funnel, Pyramid, and Bar 3D Line.</td>
</tr>
<tr>
<td>Category</td>
<td>Provides the category name of a widget. The category name of a widget is a value specified in the Widget Properties – General Tab dialog box in OpenEdge. The widgets provided in the Performance dashboard have OpenEdge as the default category name.</td>
</tr>
<tr>
<td>Description</td>
<td>Provides the description of a widget. The widget description is a description specified in the Widget Properties – General Tab dialog box in OpenEdge.</td>
</tr>
<tr>
<td>Export (➡) icon</td>
<td>Enables you to export a selected widget to PCT.</td>
</tr>
</tbody>
</table>

To navigate through the pages, you can use the paging controls. For more details about this operation, see Exploring Business Process Portal on page 28.

Exporting widgets to PCT

You can export the widgets defined in the Widgets List page to PCT as described in this section.
To export a widget, do the following:

1. Navigate to System > Widgets page.
2. Select a Dashboard and then click Search.
3. Click the Export ( ) icon in the Widget list page.

The Export Widget for PCT dialog box appears as shown in the following figure.

![Export Widget for PCT dialog box](image)

The Export Widget for PCT dialog box has the following fields:

- Widget Name
- Application
- Category
- PCT URL
- PCT Application Id
- Portal Height

The fields Widget Name, Application, and Category are OpenEdge widget attributes. If you have defined a custom widget in OpenEdge, then the application with which this widget is deployed is displayed in the dialog box. The application field is blank for Out Of Box (OOB) widgets which are a part of the Performance dashboard.

4. Provide the PCT URL.
5. Optionally provide the Portlet Height if required.
6. Click OK to export the widget to PCT.

### Deploy application pack to PCT

You can deploy OpenEdge application pack to PCT.

Perform the following:

1. Go to Administration > System > Deploy Application Pack to PCT.
   
   The Export OpenEdge Application Pack to PCT dialog appears.

2. Enter the PCT URL. This is the url in the format `<protocol>://<pct host>:<pct port>`.
3. Click OK.
   
   The application pack is deployed to PCT.
Managing attributes

This chapter explains how to use the Administration module of Business Process Portal to manage attributes. The Attribute List page enables the Business Process Server administrator to create, view, update and remove attributes associated with all the processes checked-in in the repository. For details, see the following topics:

- Managing attributes

Managing attributes

An attribute is a label that you can use to tag or mark your process. Attributes are generally used by the Progress Developer Studio for OpenEdge and Business Process Modeler. For your convenience, Business Process Portal provides the following predefined attributes. The following table provides more information about these predefined attributes.

**Table 28: Predefined attributes**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Objective</td>
<td>The objective of the process. For example, to automate the order processing.</td>
</tr>
<tr>
<td>Goal</td>
<td>The goal of the process. For example, to reduce the order processing cost by 10%.</td>
</tr>
<tr>
<td>Organizational Unit</td>
<td>The scope of the process within the organization. For example, Sales and Distribution.</td>
</tr>
</tbody>
</table>
### Attribute Table

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Influencers</td>
<td>The entities affected by the process. For example, Sales Staff, Customers, Partners, and Dealers.</td>
</tr>
<tr>
<td>Process Type</td>
<td>The scope of the process type. The default values are BusinessProcess, MonitoringProcess, and SystemProcess.</td>
</tr>
<tr>
<td>Risks</td>
<td>The risks involved. For example, Time and money for training.</td>
</tr>
<tr>
<td>Rewards</td>
<td>The benefits of the process. For example, High customer satisfaction, High retention, Increased revenue.</td>
</tr>
<tr>
<td>Executable</td>
<td>Whether the process is executable or not. For example, Yes.</td>
</tr>
</tbody>
</table>

Business Process Portal enables you to manage attributes by displaying information about existing attributes, adding new attributes, removing attributes, updating existing attributes.

You can manage attributes from the Administration module of Business Process Portal by using the **Attribute List** page as illustrated in Displaying information about an attribute on page 132. You can perform the following tasks from this page:

- Display information about an existing attribute.
- Search for one or more existing attributes.
- Create and remove attributes.
- Update the attribute information.

## Displaying information about an attribute

To view the **Attribute List** page, in the Administration module, click **System > Attributes**.

This page lists all current attributes, as shown in the following figure.

**Figure 53: Attribute list page**
Attribute List

The **Attribute List** page displays the following information about each attribute:

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the attribute.</td>
</tr>
<tr>
<td>Label</td>
<td>The label of the attribute.</td>
</tr>
<tr>
<td>Initial Value</td>
<td>The initial value for the attribute.</td>
</tr>
<tr>
<td>Values</td>
<td>All possible values available for the attribute.</td>
</tr>
<tr>
<td>Editable</td>
<td>Whether the attribute’s value can be changed.</td>
</tr>
<tr>
<td>Required</td>
<td>Whether the attribute is mandatory.</td>
</tr>
</tbody>
</table>

You can search for a particular attribute using the Search Bar. The procedure for searching attributes is very similar to that of searching the users. For more details about this, see [Searching Users](#) on page 40. It lists the attributes satisfying your search criteria. To view the list of all attributes again, click **All** in the Quick Search. To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see [Exploring Business Process Portal](#) on page 28.

From the **Attribute List** page, you can:

- Add attributes.
- View/modify attribute details.
- Delete an attribute.

These operations are explained further in this chapter in the following sections.

## Adding attributes

**To create an attribute, complete the following steps:**

1. In the **Attribute List** page, click **Add Attribute**.

   The **Add Attribute** page is displayed enabling you to create a new attribute.
An example of this page is shown in the following figure.

**Figure 54: Add attribute page**

<table>
<thead>
<tr>
<th>Add Attribute</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name: MaxDocSize</td>
</tr>
<tr>
<td>Label: Maximum Size of the document</td>
</tr>
<tr>
<td>Descriptions: Maximum permissible size (in KB) of the document</td>
</tr>
<tr>
<td>Value:</td>
</tr>
<tr>
<td>Initial Value: 5</td>
</tr>
<tr>
<td>Editable: ✔</td>
</tr>
<tr>
<td>Required: ✔</td>
</tr>
<tr>
<td>Save</td>
</tr>
</tbody>
</table>

2. In the Name, Label and Description text boxes, enter a name, a label and some additional information about the attribute respectively.

The fields marked with a red asterix are required fields.

**Note:** The attribute name must contain only alphanumeric characters.

3. In the Value text box, enter a possible value for the attribute, and click **Add**.

This value is added in the Initial Value drop-down list. To remove a value from this list, select it and click **Delete**.

4. Select the **Editable** checkbox if you want to allow the users to change the value of this attribute.

5. Select the **Required** checkbox if you want to make this a mandatory attribute.

6. Click **Save** to add the new attribute and go back to the previous page.

Click **Save & Add New** to save the current attribute and reload the current page to continue adding another attribute.

To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

## Deleting attributes

You can delete a particular attribute that you no longer need.

**To do so, follow these steps:**

1. In the **Attribute List** page, select the attribute that you want to delete.

   For more details about this operation, see [Selecting and clearing rows](#) on page 35. If needed, first search the attributes.

2. Click **Delete**.

   Business Process Portal deletes the selected attribute and it is removed from the list.
Note: You can simultaneously delete multiple attributes. To do this, in the Attribute List page, select multiple attributes and then click Delete. Business Process Portal deletes all the selected attributes.

Updating attribute information

To update attribute information, complete the following steps:

1. In the Attribute List page, click the attribute name hyper link in the Name column, whose details you want to update.

   The Attribute Details page is displayed.

   An example of this page is shown in the following figure.

   Figure 55: Attribute details page

   ![Attribute Details page](image)

2. Enter/modify the relevant data as necessary.

3. Click Save to save the changes and go back to the previous page.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.
Using the audit events page

This chapter explains how to use the Administration module of Business Process Portal to view an audit trail of events for applications. You can view the audit trail for a process instances using the Home module. For more information about it, see “Chapter 7, Working with My Instances” in the "Business Process Portal User’s Guide". For details, see the following topics:

- Audit events page

Audit events page

Business Process Server enables you to view an audit trail of events that have occurred during the flow of a process, and selectively see the details of any of the listed events. For example, you can see how the performer of a work item has changed throughout a process, or how the value of a specific dataslot has changed for a series of worksteps.

You can view an audit trail of events in the Administration module of Business Process Portal by selecting Audit Events, opening the Audit Events page as illustrated in Figure 56 on page 140. You can perform the following tasks from this page:

- View the list of audited events for a particular application.
- View the details of a particular audited event.
Viewing an audit trail of events

To view an audit trail of events, follow these steps:

1. In the Administration module, click **System > Audit Events**.
   The *Audit Events* page is displayed.

2. From the **Application** drop-down list, select the application for which you want to view the events.

3. If you want to filter the events for a specific instance ID, then enter the ID in the **Instance ID** text box.
   If you know the first digit (left most number) of the instance ID; when you enter it, then Business Process Server lists all instance IDs beginning with the specified digit. You can select the desired one from the list. You can enter multiple instance IDs by specifying a comma separated list of instance IDs. After selecting one instance ID from the list, you can enter a comma and enter the first digit of another instance ID. For example, if there are instances with IDs 254, 333, 340, 348 and 350. When you enter 3, Business Process Server will list 333, 340, 348 and 350. When you enter 4 after 3 and make it 34, Business Process Server will list only 340 and 348. To select 340 and 348, you can select 340 from the list, enter a comma and again enter 34. Business Process Server will now list only 348. You can select it.
   If you do not enter any instance ID, then Business Process Server lists events of all instances of the specified application.

4. From the **Audit Event Type** drop-down list, select the type of event that you want to review, and then click **Go**.
   *P* represents Process; *PI* represents Process Instance; *W* represents Workstep, *I* represents Work item; and *S* represents Save.

   The filters you use in Steps 2-4 can help you narrow down your search for specific information. The following table explains the list of audit events type available.

<table>
<thead>
<tr>
<th>Audit Event Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>P_CREATED</td>
<td>Process template creation.</td>
</tr>
<tr>
<td>P_INSTALLED</td>
<td>Process template installation.</td>
</tr>
<tr>
<td>P_REMOVED</td>
<td>Process template removal.</td>
</tr>
<tr>
<td>P_RESUMED</td>
<td>Process template resumed.</td>
</tr>
<tr>
<td>P_SUSPENDED</td>
<td>Process template suspension.</td>
</tr>
<tr>
<td>PI_CREATED</td>
<td>Process instance creation.</td>
</tr>
<tr>
<td>PI_ACTIVATED</td>
<td>Process instance activation.</td>
</tr>
<tr>
<td>PI_SUSPENDED</td>
<td>Process instance suspension.</td>
</tr>
<tr>
<td>PI_RESUMED</td>
<td>Process instance resumed.</td>
</tr>
<tr>
<td>PI_COMPLETED</td>
<td>Process instance completion.</td>
</tr>
<tr>
<td>PI_PRIORITYSET</td>
<td>Process instance priority is set.</td>
</tr>
<tr>
<td>PI_DUEDATESET</td>
<td>Process instance due date is set.</td>
</tr>
<tr>
<td>PI_REMOVED</td>
<td>Process instance removal.</td>
</tr>
<tr>
<td>PI_CREATORSET</td>
<td>Process instance creator is set.</td>
</tr>
<tr>
<td>Audit Event Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PI_ATTRIBUTESET</td>
<td>Process instance attributes are set.</td>
</tr>
<tr>
<td>PI_DATASLOTSSET</td>
<td>Process instance dataslots are set.</td>
</tr>
<tr>
<td>W_CREATED</td>
<td>Workstep instance creation.</td>
</tr>
<tr>
<td>W_ACTIVATED</td>
<td>Workstep instance activation.</td>
</tr>
<tr>
<td>W_SUSPENDED</td>
<td>Workstep instance suspension.</td>
</tr>
<tr>
<td>W_RESUMED</td>
<td>Workstep instance resumed.</td>
</tr>
<tr>
<td>W_COMPLETED</td>
<td>Workstep instance completion.</td>
</tr>
<tr>
<td>W_PRIORITYSET</td>
<td>Workstep instance priority is set.</td>
</tr>
<tr>
<td>W_DUEDATESET</td>
<td>Workstep instance due date is set.</td>
</tr>
<tr>
<td>W_PERFORMERSET</td>
<td>Workstep instance performer is set.</td>
</tr>
<tr>
<td>W_EVENTACTIVATION_WAIT</td>
<td>A monitoring workstep enters into wait state for an activation event.</td>
</tr>
<tr>
<td>I_CREATED</td>
<td>Work item creation.</td>
</tr>
<tr>
<td>I_ACTIVATED</td>
<td>Work item activation.</td>
</tr>
<tr>
<td>I_AVAILABLE</td>
<td>Work item is made available to one or more users.</td>
</tr>
<tr>
<td>I_ASSIGNED</td>
<td>A work item is assigned or reassigned to a user.</td>
</tr>
<tr>
<td>I_COMPLETED</td>
<td>Work item completion.</td>
</tr>
<tr>
<td>I_PRIORITY</td>
<td>Work item priority is set.</td>
</tr>
<tr>
<td>I_DUEDATE</td>
<td>Work item due date is set.</td>
</tr>
<tr>
<td>I_PERFORMER</td>
<td>Work item performer is set.</td>
</tr>
<tr>
<td>I_SUSPENDED</td>
<td>Work item suspension.</td>
</tr>
<tr>
<td>S_UPDATED</td>
<td>Dataslots are updated.</td>
</tr>
<tr>
<td>EP_AFTERBREAK</td>
<td>An exception occurring in an adapter instance execution.</td>
</tr>
</tbody>
</table>
The following is audit events page.

**Figure 56: Audit events page**

Business Process Server displays all the audit events satisfying the filter condition and the following information about each instance id:

<table>
<thead>
<tr>
<th>Audit Event ID</th>
<th>Audit Event Name</th>
<th>Date Created</th>
<th>Instance ID</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>R.CREATED</td>
<td>Mar 09, 2010 12:00 AM</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>R.INSTALLED</td>
<td>Mar 09, 2010 12:00 AM</td>
<td>0</td>
</tr>
<tr>
<td>57</td>
<td>R.CREATED</td>
<td>Mar 09, 2010 01:20 AM</td>
<td>126</td>
</tr>
<tr>
<td>58</td>
<td>R.ACTIVATED</td>
<td>Mar 09, 2010 01:20 AM</td>
<td>126</td>
</tr>
<tr>
<td>49</td>
<td>Y1.CREATED</td>
<td>Mar 09, 2010 01:20 AM</td>
<td>126</td>
</tr>
<tr>
<td>41</td>
<td>Y1.ACTIVATED</td>
<td>Mar 09, 2010 01:20 AM</td>
<td>126</td>
</tr>
<tr>
<td>42</td>
<td>L.CREATED</td>
<td>Mar 09, 2010 01:20 AM</td>
<td>126</td>
</tr>
<tr>
<td>43</td>
<td>LASSIGNED</td>
<td>Mar 09, 2010 01:28 AM</td>
<td>126</td>
</tr>
<tr>
<td>44</td>
<td>PA.CREATED</td>
<td>Mar 09, 2010 01:32 AM</td>
<td>126</td>
</tr>
<tr>
<td>207</td>
<td>L.COMPLETED</td>
<td>Mar 19, 2010 01:00 AM</td>
<td>126</td>
</tr>
<tr>
<td>208</td>
<td>Y1.COMPLETED</td>
<td>Mar 19, 2010 01:00 AM</td>
<td>126</td>
</tr>
<tr>
<td>209</td>
<td>Y1.ACTIVATED</td>
<td>Mar 19, 2010 01:00 AM</td>
<td>126</td>
</tr>
<tr>
<td>210</td>
<td>Y1.COMPLETED</td>
<td>Mar 19, 2010 01:00 AM</td>
<td>126</td>
</tr>
<tr>
<td>211</td>
<td>Y1.ACTIVATED</td>
<td>Mar 19, 2010 01:00 AM</td>
<td>126</td>
</tr>
<tr>
<td>212</td>
<td>Y1.USERIFIED</td>
<td>Mar 19, 2010 01:10 AM</td>
<td>126</td>
</tr>
<tr>
<td>213</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Business Process Server displays all the audit events satisfying the filter condition and the following information about each instance id:

**Table 30: Audit events information**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audit Event ID</td>
<td>The ID of the audit event.</td>
</tr>
<tr>
<td>Audit Event Name</td>
<td>The name of the audit event type.</td>
</tr>
</tbody>
</table>
5. To view more details of a particular event, click the +/- sign in the Audit Event ID column for that event. Business Process Server displays further details about it in read-only mode.

**Figure 57: Details of an audit event**

You can click the +/- sign in the Audit Event ID column again to collapse the audit event details.
Managing users

The chapter explains how to configure user management systems and realms, and how to use the Administration module of Business Process Portal to manage Business Process Server user accounts.

For details, see the following topics:

- Configuring user management
- Managing user accounts
- Password policy
- Delegating tasks to users

Configuring user management

Business Process Server includes a user management mechanism that is capable of supporting multiple directory service architectures. It enables you to configure Business Process Server to effectively use your existing directory service. This section explains how Business Process Server supports the directory service architectures, which are also known as realms.

Understanding realms

Business Process Server supports the following directory services or realms:
Table 31: User management realms

<table>
<thead>
<tr>
<th>Realm</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JDBC Realm</td>
<td>The JDBC realm is a user management system built on a database. It reads user, password, group, and Business Process Server specific information from the database. It also provides password encryption. Note: Recursive groups are not supported for JDBC realms.</td>
</tr>
<tr>
<td>LDAP</td>
<td>The LDAP realm employs the LDAP directory service to retrieve user, password, and general group information. Other Business Process Server-specific information is retrieved from the database. LDAP runs over TCP/IP and features a hierarchical structure. Business Process Server supports Sun Java System Directory Server 5.2 and MS Active Directory for Windows 2000.</td>
</tr>
<tr>
<td>LDAP hybrid</td>
<td>The LDAP hybrid realm uses a combination of LDAP realm and Business Process Server database. Typically, the LDAP realm is used for authentication and Business Process Server database is used to store groups related information.</td>
</tr>
<tr>
<td>OERealm</td>
<td>The OEHybrid realm is a combination of the JDBC realm and the OpenEdge AppServer based service. Business Process Server (BP Server) supports the single point of authentication (SPA) service using the OEHybrid realm.</td>
</tr>
</tbody>
</table>

Note: Passwords are case sensitive in all realms. For more information, see Case sensitivity for user management on page 144.

Java interfaces for user management

Business Process Server provides three Java interfaces for user management:

- `com.tdiinc.userManager.Group`
- `com.tdiinc.userManager.Realm`
- `com.tdiinc.userManager.User`

By implementing these interfaces, you can easily plug in a new realm (a new user manager) into the Business Process Server system. The interfaces are in the `um.jar` file, which is in the `OEBPS_HOME\lib` directory.

Case sensitivity for user management

A user name and group name in the JDBC realm may or may not be case sensitive, depending on the following parameters:

- `usermgr.casesensitive` in `umacl.conf` file in `OEBPS_HOME/conf` directory.
- `oebps.usermanager.casesensitive` in `oebps.conf` file in `OEBPS_HOME/conf` directory.

Ensure that the values of both these parameters are consistent. Additionally, if you use the LDAP, LDAP hybrid, or OEHybrid realms, then ensure that the case sensitivity parameters set in Business Process Server are consistent with the case sensitivity parameters set in your LDAP, LDAP hybrid, or OEHybrid realms.
Using OEHybrid realm for Single Point of Authentication

OpenEdge single point of authentication (SPA) is used in realm-based systems. Business Process Server supports SPA service using the OEHybrid realm. The OEHybrid realm uses a combination of the JDBC realm and the OpenEdge AppServer-based service.

OEHybrid realm implementation

In the OEHybrid realm, the OpenEdge AppServer-based single point of authentication (SPA) service authenticates users against the OpenEdge database to which the AppServer is connected, while the JDBC realm supports Business Process Server for groups, user attributes, and permissions.

You can create the SPA service by implementing the built-in Progress.Security.Realm.IHybridRealm interface. You must implement the interface as a SINGLETON class. An interface implementation OpenEdge.Security.Realm.HybridRealm.cls class file is available in your Progress OpenEdge installation directory at $DLC\src\samples\security\OpenEdge\Security\Realm. A utility class OpenEdge.Security.Util.Properties.cls for property file support is available in $DLC\src\samples\security\OpenEdge\Security\Util.

Before configuring the BP Server to use the SPA service, you must deploy the authentication service class file OpenEdge.Security.Realm.HybridRealm.cls and property file OpenEdge.Security.Util.Properties.cls on an OpenEdge AppServer running in state-free operating mode.

Note: By default, the bpsbroker defined for an AppServer is in state-free operating mode and the asbroker defined for an AppServer is in state-reset operating mode.

The reference implementation uses the _User table of the OpenEdge database to which the AppServer is connected to access an user's account information. For more information on configuring reference implementation and populating _User table of an OpenEdge database, see the OpenEdge Single Point of Authentication (SPAInstructions.pdf) document in your OpenEdge installation directory at $DLC\src\samples\security.

In addition, refer to the Progress Developer Studio for OpenEdge Guide for information on creating an OpenEdge database, and associating the database to an OpenEdge AppServer.

Configuring reference implementation properties

The reference implementation uses a property file that contains information used to lock the authentication service. A SPA client reads a sealed client-principal file and then sends the file when it communicates with the authentication service. The authentication service validates the seal by using the domain password, and then validates the role of the client-principal to see if it matches.

A default property file spaservice.properties is provided in $DLC\src\samples\security. You must copy this property file to your working directory $WRKDIR.

The property file contains these default values:
### Table 32: Property file parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>oech1:2033334252a2137</td>
<td>Password is the encoded domain password of the sealed client-principal.</td>
</tr>
<tr>
<td>Role</td>
<td>SpaClient</td>
<td>Role is the role that the client-principal role is compared to.</td>
</tr>
<tr>
<td>DebugMsg</td>
<td>False</td>
<td>DebugMsg will enable log messages in the AppServer server log file for the SPA service.</td>
</tr>
</tbody>
</table>

The default client-principal file `spadefault.cp` located in your installation directory at `DLC\src\samples\security`, uses a password that corresponds to the encoded "Password" value in the table, and the role "SpaClient". For information on generating your own client-principal file using the `genspacp` utility, see Generating a sealed client-principal file on page 147.

### OEHybrid realm configuration

You must specify custom authentication OEHybrid realm in Business Process Server to implement SPA. The OEHybrid realm configuration information is stored in the `umacl.conf` file. To modify the OEHybrid realm configuration values, modify the `umacl.conf` file located in the `OEBPS_HOME\conf` directory. The parameters are listed in the following table:

### Table 33: OEHybrid realm configuration parameters

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>usermgr.realm.type</code></td>
<td>Specifies the realm type for user management. Set the parameter value to <code>custom</code>.</td>
</tr>
<tr>
<td><strong>Note:</strong> The default value is <code>jdbc</code>.</td>
<td></td>
</tr>
<tr>
<td><code>usermgr.realm.provider</code></td>
<td>Specifies the OEHybrid realm provider name. Set the User Manager parameter to <code>com.savvion.usermanager.OERealm</code>.</td>
</tr>
<tr>
<td><strong>Note:</strong> By default, the provider value is blank.</td>
<td></td>
</tr>
<tr>
<td><code>oauth.server.location</code></td>
<td>Specifies the URL to an AppServer that provides the SPA service. Set the parameter value to <code>AppServer://localhost/bpsbroker1</code>.</td>
</tr>
<tr>
<td><code>oauth.server.provider</code></td>
<td>Specifies the class name of the OEHybrid realm implementation that provides the SPA service. Set the parameter value to <code>OpenEdge.Security.Realm.HybridRealm</code>.</td>
</tr>
<tr>
<td><code>oauth.server.authmethod</code></td>
<td>Method used to validate a password. Set the parameter value to <code>digest</code>.</td>
</tr>
<tr>
<td><code>oauth.server.clientprincipal</code></td>
<td>Specifies the client principal file used to authorize SPA clients. Set the parameter value to <code>spadefault.cp</code>.</td>
</tr>
</tbody>
</table>
Group administration in Business Process Portal

When you use a custom realm, the option for adding and removing groups, and adding and removing users within a group does not appear in the Business Process Portal.

To enable group management when you use the OEHybrid realm, modify the bpmportal.conf file located in the OEBPS_HOME\conf folder. The configuration parameters are listed in the following table:

Table 34: Group management parameters for OEHybrid realm

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>bpmportal.customrealm.managegroup</td>
<td>Set the parameter to true to enable Business Process Portal for managing groups such as add, modify, and delete in a custom realm.</td>
<td></td>
</tr>
<tr>
<td>Note: The default value is false.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Generating a sealed client-principal file

You can use the genspacp utility to generate a sealed client-principal file for use with the single point of authentication service.

To use the utility:

1. Go to Windows Start > Programs, select Progress > OpenEdge > Proenv. A command shell window opens and displays information about your OpenEdge installation. The command at the prompt is:

   proenv>

2. Enter the following command:

   genspacp -password <text> [-user <text> -domain <text> -role <text> -file <text>]

Where:

- -password: (Required) The domain password used to seal the client-principal object.
- -user: (Optional) The user name set in the client-principal. The default name is BPSServer.
- -domain: (Optional) The domain name set in the client-principal. The default domain name is OESPA.
• \textit{role}: (Optional) The role set in the client-principal. The default role is SPAClient.

• \textit{file}: (Optional) The name of the file to which the client-principal object is saved. The default file name is \texttt{oespaclient.cp}.

3. Do the following:
   a) Copy the generated encoded password value to the Password property of the \texttt{spaservice.properties} file to use the client-principal. The property file is located in your installation directory at $\texttt{DLC/src/samples/security}$.
   b) Copy the generated client-principal file to the OEBPS\_HOME\textbackslash conf directory. By default, the client-principal is created in your working directory $\texttt{WRKDIR}$.
   c) In the \texttt{umacl.conf} file, update the \texttt{oeauth.server.clientprincipal} parameter value with the client-principal file name generated in the previous step. This client principal file is used to authorizes SPA clients. The \texttt{umacl.conf} file is located in the \texttt{OEBPS\_HOME\textbackslash conf} directory.

Logging in with default Business Process Server's user credentials

To log in to Business Process Portal using the default Business Process Server credentials "admin" as the username and password, you must add the default admin user details to the \texttt{User} table of the OpenEdge database that is associated with the OEHybrid realm. For more information on populating the \texttt{User} table of an OpenEdge database, see the \textit{OpenEdge Single Point of Authentication (SPAInstructions.pdf)} document in your OpenEdge installation directory at $\texttt{DLC/src/samples/security}$.

Alternatively, you can add an admin account to the JDBC realm of an existing OEHybrid realm user and grant the user administrator permissions. For more information on creating users and managing user permissions, see the \textit{Managing user accounts} on page 152.

\textbf{Note:} Before you log in to Business Process Portal, ensure that both the OpenEdge AppServer and Business Process Server are running.

When you switch over to the custom OEHybrid authentication realm and log in to Business Process Portal using the admin user, the OpenEdge SPA service authenticates the admin user credentials against the OpenEdge database associated with the AppServer on which the service is running, while BP Server manages the user permissions.

\textbf{Note:} You cannot have a blank password to login to Business Process Portal. You must specify the username and password fields when adding users to the \texttt{User} table of the OpenEdge database that is configured with the OEHybrid realm.

Using the LDAP realm

The LDAP Realm configuration information is stored in the \texttt{umacl.conf} file. Under normal circumstances, Business Process Server supplies the correct settings in the \texttt{umacl.conf} configuration files. However, you might need to modify these files if you choose to use the LDAP Realm following Business Process Server installation.

\textbf{Note:} If you choose the LDAP Realm, then the option of adding and removing users and groups, and adding and removing users within a group does not appear in the interface.
You can use the `usermgr.additionalstorage` parameter in `umacl.conf`. This parameter specifies where the OEBPS specific information for user manager is stored. This parameter applies to NIS and LDAP only. For example, you can store the first name and last name of a user, or the language setting for an LDAP realm; or portal level configurations that are granted to users and groups. Although the parameter provides a choice between `database` and `file` options, we recommend you use the default value, `database`, rather than the `file` option. If you choose `database`, then the user details are stored in Business Process Server database. If you choose `file` option, then the user details are stored in `usermgr.additionalstorage` parameter in `umacl.conf`.

You can specify this parameter by editing the `umacl.conf` file. This file is available in `OEBPS_HOME\conf` folder.

### LDAP realm configuration

LDAP is a software protocol for enabling anyone to locate organizations, individuals, and other resources such as files and devices in a network, whether on the Internet or on a corporate intranet. Business Process Server, when configured to LDAP realm, supports Sun Java System Directory, or Active Directory.

### Modifying LDAP realm configuration

To modify the LDAP realm configuration values, modify the following parameters in `umacl.conf` file located at `OEBPS_HOME\conf` folder. The parameters are listed in the following table:

**Table 35: OEBPS LDAP configuration parameters**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ldap.server.provider</code></td>
<td>Provide the LDAP server provider name. If you use Active Directory, then set this parameter to &quot;MSActive.&quot; If you use Sun Java System Directory, then set this parameter to &quot;Netscape.&quot;</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> Using the &quot;Netscape&quot; value requires you to set the User Manager parameter to &quot;com.tdiinc.com.userManager.LDAPRealm.&quot;</td>
</tr>
<tr>
<td><code>ldap.server.location</code></td>
<td>This parameter specifies the location of the LDAP server.</td>
</tr>
<tr>
<td><code>ldap.ssl</code></td>
<td>This is an optional parameter. This specifies whether the LDAP connection is based on SSL or not. The default value for this parameter is blank.</td>
</tr>
<tr>
<td><code>ldap.user.name</code></td>
<td>A proper account is usually required to access the LDAP server. For example, a user account may be: <code>uid=ebms, ou=people, o=progress, dc=com</code> for the Sun Java System Directory server, and <code>cn=ebms, ou=users, dc=progress, dc=com</code> for the Active Directory server. The LDAP server may be configured in a way that anonymous users can read information from the LDAP server. In this case, these two parameters may be left blank. For more information, refer to your LDAP server documentation.</td>
</tr>
<tr>
<td><code>ldap.user.password</code></td>
<td></td>
</tr>
</tbody>
</table>
These two parameters specify in umacl.conf where the "User" and "Group" objects are stored in a Directory Information Tree (DIT). Business Process Server searches only the "User" objects within the subtree "ldap.user.search.root" and "Group" objects within the subtree "ldap.group.search.root." You may set these two parameters to the root of the whole DIT or to a very low-level node. The lower the node you set, the more efficient the search is. You may also set multiple values for these parameters separated by a "." For example, ou=groups,o=progress.com|ou=depts,o=progress.com.

### Non-Standard LDAP schema configuration parameters

The parameters describing this LDAP schema are presented in the following table:

#### Parameters

<table>
<thead>
<tr>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>user.name.attr</td>
<td>Specifies the attribute name considered the user name in Business Process Server. Assume this attribute is unique among user objects in LDAP. Business Process Server identifies the first object as the one you are searching for.</td>
</tr>
<tr>
<td>user.object.class</td>
<td>Specifies the class name of the user object.</td>
</tr>
<tr>
<td>user.last.name.attr</td>
<td>Specifies the attribute name of the user's last name.</td>
</tr>
<tr>
<td>user.first.name.attr</td>
<td>Specifies the attribute name of the user's first name.</td>
</tr>
<tr>
<td>user.email.attr</td>
<td>Specifies the attribute name of the user's e-mail address.</td>
</tr>
<tr>
<td>user.phone.number.attr</td>
<td>Specifies the attribute name of the user's phone number.</td>
</tr>
<tr>
<td>group.name.attr</td>
<td>Specifies the attribute name considered the group name in Business Process Server. Assume this attribute is unique among group objects in LDAP. Business Process Server identifies the first object as the one you are searching for.</td>
</tr>
<tr>
<td>group.object.class</td>
<td>Specifies the class name of the group object.</td>
</tr>
<tr>
<td>group.member.attr</td>
<td>Specifies the membership's attribute name.</td>
</tr>
<tr>
<td>group.desc.attr</td>
<td>Specifies the attribute name of the group description.</td>
</tr>
</tbody>
</table>

If the `ldap.read.user.attribute` parameter is set to `True` in the `umacl.conf` file, then for the attributes `first name`, `last name`, `phone`, and `email`, their LDAP values take precedence over the corresponding database values.

### Using the LDAP hybrid realm

In LDAP hybrid realm users are stored and authenticated using the LDAP realm whereas groups are created and stored in the database. Therefore, you cannot perform user management operations on the LDAP users. However, you can perform the group management operations on all groups. In an LDAP hybrid realm, a group can consist of an LDAP user, a database group or a combination of these two. If you must configure the LDAP realm of your LDAP hybrid realm, then refer to the LDAP realm configuration on page 149.
Note: If you choose the LDAP hybrid Realm, then the option of adding and removing users does not appear in the interface.

Modifying the realm type

To modify the realm type.

1. Modify the following parameters in the *umacl.conf* file.
   a) To change to JDBC realm type.

   **Table 37: JDBC realm**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Change value to</th>
</tr>
</thead>
<tbody>
<tr>
<td>set usermgr.realm.type</td>
<td>jdbc</td>
</tr>
</tbody>
</table>

   b) To change to LDAP MSActive

   **Table 38: LDAP MSActive**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Change value to</th>
</tr>
</thead>
<tbody>
<tr>
<td>set usermgr.realm.type</td>
<td>ldap</td>
</tr>
<tr>
<td>set ldap.server.provider</td>
<td>MSActive</td>
</tr>
<tr>
<td>set ldap.server.location</td>
<td>Provide the ldap server location</td>
</tr>
<tr>
<td>set ldap.user.name</td>
<td>Provide the ldap server user name</td>
</tr>
<tr>
<td>set ldap.user.password</td>
<td>Provide the ldap server password</td>
</tr>
<tr>
<td>set ldap.user.search.root</td>
<td>cn=Users,dc=qatest,dc=tdiinc,dc=com Here cn stands for common name and dc stands for domain content</td>
</tr>
<tr>
<td>set ldap.group.search.root</td>
<td>cn=Users,dc=qatest,dc=tdiinc,dc=com</td>
</tr>
</tbody>
</table>

   c) To change to LDAP SunJAVA

   **Table 39: LDAP SunJAVA**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Change value to</th>
</tr>
</thead>
<tbody>
<tr>
<td>set usermgr.realm.type</td>
<td>ldap</td>
</tr>
<tr>
<td>set ldap.server.provider</td>
<td>Netscape</td>
</tr>
<tr>
<td>set ldap.server.location</td>
<td>Provide the ldap server location</td>
</tr>
<tr>
<td>set ldap.user.name</td>
<td>Provide the ldap server user name</td>
</tr>
<tr>
<td>set ldap.user.password</td>
<td>Provide the ldap server password</td>
</tr>
<tr>
<td>set ldap.user.search.root</td>
<td>ou=Special Users,dc=tdiinc,dc=com Here ou stands for organizational unit.</td>
</tr>
<tr>
<td>set ldap.group.search.root</td>
<td>ou=Special Users,dc=tdiinc,dc=com</td>
</tr>
</tbody>
</table>

   d) To change to LDAP hybrid
Table 40: LDAP hybrid

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Change value to</th>
</tr>
</thead>
<tbody>
<tr>
<td>set usermgr.realm.type</td>
<td>ldaphybrid</td>
</tr>
<tr>
<td>set ldap.server.provider</td>
<td>MSActive/Netscape</td>
</tr>
</tbody>
</table>

Follow the instruction provided in rows 3 to 7 based on the table LDAP MSActive or LDAP SunJava for LDAP hybrid realm.

e) To change to OEHybrid realm type

Table 41: OEHybrid realm

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Change value to</th>
</tr>
</thead>
<tbody>
<tr>
<td>set usermgr.realm.type</td>
<td>custom</td>
</tr>
<tr>
<td>set usermgr.realm.provider</td>
<td>com.savvion.usermanager.OERealm</td>
</tr>
<tr>
<td>set oauth.server.location</td>
<td>AppServer://localhost/bpsbroker1</td>
</tr>
<tr>
<td>oauth.server.authmethod</td>
<td>digest</td>
</tr>
<tr>
<td>oauth.server.clientprincipal</td>
<td>spadefault.cp</td>
</tr>
</tbody>
</table>

2. Invoke the User Config Tool and select the Business Manager Admin credentials.
3. Enter the username and password.
4. Stop all the OEBPS servers.
5. Execute Setup OEBPS.
6. Restart all the OEBPS servers.

Using setupOEBPS to clean or set up component data

BPM Events, Business Process Server, and User Management maintain data repositories in different locations depending on the configuration setup. One component failure can cause application data inconsistency. You can use the setupOEBPS utility to clean up Business Process Server application data and reset Business Process Server.

Note: When you perform setup User Management using setupOEBPS -c UserManager, it automatically resets Access Control Management component data also.

Managing user accounts

Business Process Server enables you to manage user accounts by displaying user information, adding new users, removing users, updating existing user information, and adjusting Business Process Portal Configuration display for each user.
You manage users in the Administration module of Business Process Portal by using the **User List** page as illustrated in Figure 58 on page 153. Depending on the user realm you selected during installation (see Choosing realms during installation), you can:

- Display information about a user (all realms).
- Search for a user or set of users (all realms).
- Create and remove users (only in JDBC realm).
- Update user information (with limitations in LDAP realm).
- Add/remove permissions for a user, including administration and manager privileges (all realms).
- Configure Business Process Portal links associated with a user (all realms).

## Displaying user information

To view the **User List** page, in the Administration module, click **User Management > Users**. To view the list of all users, click **All** in the Quick Search.

This page lists all current users, as shown in the following figure.

**Figure 58: User list page**

### User list information

The **User List** page displays information about the users. By default, it does not display any user. You have to search for the user(s) using the Search Bar. For more details about this, see Searching Users on page 40. It lists the users satisfying your search criteria and the following information about each user:

**Table 42: User list information**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>The user name of the user.</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the user.</td>
</tr>
</tbody>
</table>
### Information | Description
---|---
Last Name | The last name of the user.
Email | The email address of the user.
Phone | The phone number of the user.
Group Memberships | Click the View link to view the groups of which the current user is a member.
Queue Memberships | Click the View link to view the queues of which the current user is a member.

To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the **User List** page, you can:

- Creating users.
- View/modify user details.
- View group membership details.
- View queue membership details.
- Delete a user.

These operations are explained further in this chapter in the following sections.

## Creating users

**To create a Business Process Server user, complete the following steps:**

**Note:** You cannot create a user in LDAP, LDAP hybrid. When you use the OEHybrid realm, then the option of adding and removing users does not appear on the Users page in the Business Process Portal. You can add or remove users using an ABL procedure (.p) file to the `_Users` table of an OpenEdge database. For more information on adding or removing users using an ABL procedure (.p) file, see the *OpenEdge Single Point of Authentication* document in your OpenEdge installation directory at `$DLC\src\samples\security`.

1. In the **User List** page, click **Create User**.

   The **Create User** page is displayed enabling you to enter the new user information.
An example of this page is shown in the following figure.

**Figure 59: Create userpage**

2. In the User Details section, enter the relevant data as necessary.
   
   For more information about the fields, refer to the "Chapter 11, Managing Profile and Favorites" in the *Business Process Portal User's Guide*.

   **Important**: The fields marked with a red asterisk are required fields.

   **Note**: The user name must contain only alphanumeric characters and underscore (_), and it must start with an alphabet.

   a) If you do not assign any business calendar to the user, then the default calendar is used for the due date calculations. Such a user can assign a business calendar to him/herself from the Home module when he/she clicks *Preferences > Calendar* for the first time.

   b) From the Assigned column in the Dashboard table, select the dashboards to be assigned to the user. This list contains the published dashboards. The assigned dashboards appears in the Dashboard List of this user.

   c) From the Default Selection column in the Dashboard table, select the dashboard to be assigned to the current user as the default dashboard.

   Alternatively, you can also assign a dashboard to a user from the Dashboard Details page. For more information, see *Defining a new dashboard* on page 119.

   If you do not assign any dashboard to the user, then the default dashboard specified by the Business Process Server administrator is used.

   If you set the `multiuser.credential` parameter to "true" and the `appuser.credential` parameter to "false" in the `sdms.properties` file, then you must specify the DMS username and its password.

3. At this time, you can also assign permissions or configure portal resources for the new user.
   
   For more information, see *Managing user permissions* on page 159.

4. Click *Save* to create the new Business Process Server user and go back to the previous page.
Click Save & Create New to save the current user and reload the current page to continue adding another user.

To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

Deleting users

You can delete a particular user that you no longer need.

To do so, follow these steps:

**Note:** You cannot remove a user in LDAP and LDAP hybrid realm.

1. In the User List page, select the user that you want to delete.
   
   For more details about this operation, see Selecting and clearing rows on page 35. If needed, first search the users.

2. Click Delete.
   
   Business Process Portal deletes the selected user and it is removed from the list.

**Note:** You can simultaneously delete multiple users. To do this, in the User List page, select multiple users and then click Delete. Business Process Portal deletes all the selected users.

Updating user information

To update Business Process Server user information, complete the following steps:

1. In the User List page, click the user name link in the User Name column, whose details you want to update.
   
   The User Details page is displayed.
An example of this page is shown in the following figure.

**Figure 60: User details page**

2. In the **Admin Password** text box, enter the Business Process Server administrator's password. You must enter this password again, if you want to change the user's password.

3. In the **User Details** section, enter/modify the relevant data as necessary.

   If the user has made any change(s) in the assigned business calendar, then the name of the default calendar is displayed as "Custom Calendar". If you change this default calendar, then the new calendar is assigned as the default calendar and the changes made by the user are lost.

   **Note:** The user name must contain only alphanumeric characters and underscore (_), and it must start with an alphabetic character.

   You cannot change the password for LDAP and LDAP hybrid realm.

   In LDAP and LDAP hybrid realms, you may notice that some information fields are inactive and therefore you cannot edit or update fields that include: "Last Name", "First Name", "Email", and "Phone".

   If you set the `multiuser.credetial` parameter to "true" and the `appuser.credential` parameter to "false" in the `sdms.properties` file, then you must specify the DMS username and its password.

4. Click **Save** to save the changes and go back to the previous page.

   Click **Delete** to delete the current user.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.
Viewing group memberships

To view the list of groups of which a user is a member, complete the following steps:

1. In the User List page, click the View link in the Group Memberships column, whose membership details you want to view.

   The Membership Details window is displayed.

   An example of this window is shown in the following figure.

   **Figure 61: Group membership details window**

<table>
<thead>
<tr>
<th>Membership Details table</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
</tr>
<tr>
<td>-----</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
</tbody>
</table>

   The Membership Details table displays the group name and group description of groups of which the current user is a member.

2. Click Close to close the window and go back to the previous page.

Viewing queue memberships

To view the list of queues of which a user is a member, complete the following steps:

1. In the User List page, click the View link in the Queue Memberships column, whose membership details you want to view.

   The Membership Details window is displayed.
An example of this window is shown in the following figure.

**Figure 62: Queue membership details window**

<table>
<thead>
<tr>
<th>No.</th>
<th>Queue Name</th>
<th>Queue Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Queue1</td>
<td>Queue One</td>
</tr>
</tbody>
</table>

The Membership Details table displays the queue name and queue description of queues of which the current user is a member.

2. Click **Close** to close the window and go back to the previous page.

**Managing user permissions**

As an administrator, you can grant or revoke permissions to specific Business Process Server components and resources and/or module menus in Business Process Portal.

**To manage permissions for a user:**

1. In the **User List** page, click the user name link in the **User Name** column, whose permissions you want to update.

   The **User Details** page is displayed.

2. Click **Permissions** to go to the Permissions section.
3. Select or clear the checkbox to grant or revoke permission to resources that include Business Process Server, BPM Events, Management or Administration.

4. Click **Portal Configuration** to go to the Business Process Portal Configuration section.

5. Select or clear the checkbox to grant or revoke permission to access the module menus.

6. Click **Save** to save the changes and go back to the previous page.

   Click **Delete** to delete the current user.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

### Refreshing user cache

In OEBPS user cache techniques are introduced to cache the user details. LDAP is an existing system, when there is any changes done to LDAP system, for example, user’s first name, then OEBPS is unaware of the changes. To reflect the LDAP changes in OEBPS portal immediately, OEBPS cache needs to be refreshed using BPServerAdmin command `removeuserfromcache <username>`

1. To notify the OEBPS about the LDAP changes for the user, OEBPS cache should be refreshed by following the steps below:
   a) Open the BPServerAdmin console using the command `startBPServerAdmin.cmd` from `OEBPS_Home>\bin`.
   b) To refresh the user cache, execute the command `removeuserfromcache <username>` for which the changes has been done.

2. Navigate to **Administration > User Management > Users** page. The changes on LDAP will be reflected.

3. Refresh the page. The changes on LDAP is reflected.
Password policy

You can add Password Security Policy feature in the portal for each user. You can set the following password policies:

• Change on first login
• Duration

For more details about these password policies, and about implementing a custom password policy, refer to the *OpenEdge Getting Started: Installation and Configuration Guide*.

Delegating tasks to users

As a Business Process Server administrator, you can delegate tasks usually performed by one user to another user, in the event that the usual user cannot perform his/her tasks for a specified time period. Currently, you cannot delegate at the task level, but only at an application level; that is, a user is assigned all the tasks of a selected application.

**To delegate tasks to a user:**

1. In the Administration module, click **User Management > Delegate Settings**, to view the Delegate Settings page.
   
   To view the list of all users, click **All** in the Quick Search.
   
   An example of this page is shown in the following figure.

   **Figure 64: Selecting a user in the delegate settings page**

   ![Delegate Settings Page](image)

2. Select a user for whom you want to set delegates by clicking the option in the first column of that user. For more details, see **Selecting and clearing rows** on page 35.

3. Click **Choose**. The Delegate Settings Details page is displayed, where you can assign one or more delegates to perform tasks in selected application(s) for the specified user.
The user you have submitted is shown in the Delegation for (submitted user name) title.

**Figure 65: Selecting delegates in the delegate settings details page**

4. In the **Delegate Settings** page, you can specify the user to whom all your tasks are delegated by entering its user name in the **Delegate all tasks to** text box. Alternatively, you can click the Search User icon ( ) and opening the **Search Users** page where you can choose a user. Alternatively, for each application, you can specify the user name(s) to whom that application should be delegated. If needed, you can search and add users for delegating all tasks or delegating application-wise tasks. For more details, see **Searching Users** on page 40.

5. Select the check box in the **Disable Delegation** column to disable delegation of a particular task. Select the check box in the Disable Delegation column header to disable delegation of all the tasks.

6. Specify the period of delegation and its start and end dates using the **Start Date** and **End Date** text boxes. Alternatively, click the Select Date icon ( ) to set the respective start date or end date. For more details, see **Specifying a Date** on page 39.

7. Click **Save** to save your settings.

To cancel the action and exit the current page, click **Cancel**.
Managing groups

The chapter explains how to use the Administration module of Business Process Portal to manage Business Process Server groups, along with the features of each realm and its respective interface. It also explains how to manage the favorite links.

Business Process Server enables you to manage group accounts by displaying group and user information, adding or removing users as members, updating existing group information, and adjusting Business Process Portal Configuration display for a group. You can also refresh the user cache settings. For more information refer to, Refreshing user cache on page 160.

For details, see the following topics:

- Managing group accounts
- Managing favorites

Managing group accounts

Business Process Server enables you to manage groups in the Administration module of Business Process Portal by using the Group List page. From this page, you can:

- Display information about an existing group (all realms).
- Search for a user or a group (all realms).
- Create and remove groups (only in JDBCRealm).
- Add and remove members from groups (only in JDBCRealm).
Displaying group information

To view the Group List page, in the Administration module, click User Management > Groups. To view the list of all groups, click All in the Quick Search.

This page lists all current groups, as shown in the following figure.

**Figure 66: Displaying group information in the group list page (JDBC realm)**

**Group list page**

By default, the Group List page does not display any group. You must search for the group(s) using the Search Bar or by clicking All in the Quick Search Bar. For more details on searching for groups, see Searching Users on page 40. Groups satisfying the search criteria are displayed, and the following information about each group is displayed:

**Table 43: My application list information**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Name</td>
<td>The name of the group.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the group.</td>
</tr>
<tr>
<td>Member</td>
<td>Click the icon to view the members of the group.</td>
</tr>
<tr>
<td>Memberships</td>
<td>Click the View link to view the groups of which the current group is a member.</td>
</tr>
</tbody>
</table>

To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the Group List page, you can perform the following operations:

- Creating groups.
- View/modify group details.
• View/modify group members.
• Delete a group.

These operations are explained further in this chapter in the following sections.

Creating groups

To create a new Business Process Server group, complete the following steps:

**Note:** You cannot create a group in an LDAPRealm.

1. In the **Group List** page, click **Create Group**.

   The **Create Group** page is displayed enabling you to enter the new group information.

   An example of this page is shown in the following figure.

   **Figure 67: Create group page**

   ![Create Group Page](image)

2. In the **Group Details** section, enter the relevant data as necessary.

   For more information about the Organization and Tenancy fields, refer to the "Chapter 12, Managing Profile and Favorites" in the *Business Process Portal User's Guide*. Note that Group Name and Default Calendar are the required fields.

   **Note:** The group name must contain only alphanumeric characters and underscore (_), and it must start with an alphabet.

   If you do not assign any business calendar to the group, then the default calendar is used for the due date calculations.

   a) From the **Assigned** column in the Dashboard table, select the dashboards to be assigned to the group. This list contains the published dashboards.

      The assigned dashboards will appear in the Dashboard List of this members of this group.

   b) From the **Default Selection** column in the Dashboard table, select the dashboard to be assigned to the current group as the default dashboard.
Alternatively, you can also assign a dashboard to a group from the Dashboard Details page. For more information, see Defining a new dashboard on page 119.

If you do not assign any dashboard to the group, then the default dashboard specified by the Business Process Server administrator is used.

3. At this time, you can also assign permissions and configure portal resources for the group.
   For more information, see Managing group permissions on page 167.

4. Click Save to create the new Business Process Server group and go back to the previous page.
   Click Save & Create New to save the current group and reload the current page to continue adding another group.
   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

Deleting groups

If you no longer need a particular group, then you can delete it.

To do so, follow these steps:

Note: You cannot remove a group in an LDAPRealm.

1. In the Group List page, select the group that you want to delete.
   For more details about this operation, see Selecting and clearing rows on page 35. If needed, first search the groups. For more details about this operation, see Searching Users on page 40.

2. Click Delete.

   Business Process Portal deletes the selected group and it is removed from the list.

   Note: You can simultaneously delete multiple groups. To do this, in the Group List page, select multiple groups and then click Delete. Business Process Portal deletes all the selected groups.

Updating group information

To update Business Process Server group information, complete the following steps:

1. In the Group List page, click the group name hyper link in the Group Name column, whose details you want to update.

   The Group Details page is displayed.
An example of this page is shown in the following figure.

**Figure 68: Group details page**

2. In the Group Details section, enter/modify the relevant data as necessary.

   **Note:** The group name must contain only alphanumeric characters and underscore (_), and it must start with an alphabet.

3. Click **Save** to save the changes and go back to the previous page.
   
   Click **Delete** to delete the current group.
   
   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

**Managing group permissions**

As an administrator, you can grant or revoke group permissions for specific Business Process Server components and resources and/or module menus in Business Process Portal.

To manage permissions for a group:

1. In the **Group List** page, click the group name hyper link in the **Group Name** column, whose permissions you want to update. The **Group Details** page is displayed.
2. Click **Permissions** to go to the Permissions section.
3. Select a **Component** for which you want to update permissions from the list. Select **All** to apply these permissions to all components.

4. Select or clear the check box to grant or revoke permission to resources that include BP Server, BPM Events, Administration or Management. Select the checkbox in the heading to apply all the listed permissions to the group.

5. Click **Portal Configuration** to go to the Portal Configuration section.

6. Select or clear the checkbox to grant or revoke permission to access the module menus.

7. Click **Save** to save the changes and go back to the previous page.

   Click **Delete** to delete the current group.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

### Managing members in groups

Business Process Server enables you to manage members in groups by allowing you to search for users for a group, add and remove one or more members from groups (only in JDBCRealm), and to change user roles within the group. In this way, you gain more flexibility for filtering users assigned as a performer in an activity workstep.

A group can contain one or more groups as members. A user or a group can be a member of more than one group.

### Viewing Group members

To view the **Group Members List** page, click the **View Group Members** icon in the **Group List** page. This page displays the members of the selected group.
The example of this page is shown in the following figure.

**Figure 70: Group members list page**

<table>
<thead>
<tr>
<th>User List</th>
<th>Group List</th>
</tr>
</thead>
<tbody>
<tr>
<td>No.</td>
<td>First Name</td>
</tr>
<tr>
<td>1</td>
<td>Alice</td>
</tr>
<tr>
<td>2</td>
<td>Bob</td>
</tr>
<tr>
<td>3</td>
<td>John</td>
</tr>
</tbody>
</table>

Currently, there are no groups as group members.

### Group Members List page

The **Group Members List** page contains two frames: the top frame displays users that are members of the selected group; and the bottom frame displays groups that are members of the selected group.

To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the **Group Members List** page, you can:

- Adding a group member.
- Changing the role of a member.
- Deleting a group member.

These operations are explained in the following sections.

### Adding members to groups

To add Business Process Server users or groups as members of a group, complete the following steps:

**Note:** You cannot add a member to a group in an LDAPRealm.

1. In the **Group Members List** page, click **Add Group Member**.

   The **Add Users & Groups** page is displayed.
An example of this page is shown in the following figure.

**Figure 71: Add users and groups page**

2. Search and locate users or groups. For more details, see *Searching Users* on page 40.

3. Click **Add** to add the selected users and/or group and go back to the previous page.

   Click **Add & Continue** to add the current users/groups and reload the current page to continue adding another user/group.

   To cancel the action and exit the current page, click **Cancel**.

### Changing the role of a member

To change the current role of the user who is a member of a group, complete the following steps:

1. In the **Group Members List** page, click the **Edit Role** icon ( ). The Edit Role window is displayed.

   An example of this page is shown in the following figure.

   **Figure 72: Edit role window**

   2. Specify the name of the new role in the box. Alternatively, click the option beside the drop-down list, and select a role from the list.

   3. Click **Save** to save the settings and close the window.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the window, click **Cancel**.

**Note:** To remove the role of a member, click the “New Role” option and enter a space, and then click **Save**.
Removing members from groups

To remove a member from a group, complete the following steps:

**Note:** You cannot remove a member from a group in an LDAPRealm.

1. In the **Group Members List** page, select the user and/or group that you want to delete. For more details about this operation, see *Selecting and clearing rows* on page 35.
2. Click **Delete**.

Business Process Portal deletes the selected user/group and it is removed from the list.

**Note:** You can simultaneously delete multiple users or groups. To do this, in the **Group Member List** page, select multiple users or groups, and then click **Delete**. Business Process Portal deletes all the selected users/groups.

Managing favorites

Business Process Server enables you to manage frequently accessed Web applications, Business Process Server applications, internet and/or intra-net sites' links in the Administration module of Business Process Portal by using the **Favorites List** page.

From this page, you can:

- Display list of existing favorites links.
- Add and remove links.
- Update links.

Displaying list of favorites

To view the **Favorites List** page, in the Administration module, click **User Management** > **Favorites**.
This page lists all current favorite links, as shown in the following figure.

Figure 73: Displaying the favorites list page

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Group</th>
<th>URL</th>
<th>Language</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>google</td>
<td>MgmtGrp</td>
<td><a href="http://www.google.com">http://www.google.com</a></td>
<td>EN,US</td>
</tr>
</tbody>
</table>

By default, it displays the following information about each favorites link:

Table 44: Favorites list information

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the link.</td>
</tr>
<tr>
<td>Group</td>
<td>The list of groups that can access this link.</td>
</tr>
<tr>
<td>URL</td>
<td>The URL of the link.</td>
</tr>
<tr>
<td>Language</td>
<td>The language used for the content of the link.</td>
</tr>
</tbody>
</table>

To manage the contents of the list, you can sort them using the name. To sort the list, click the drop-down list beside the Name column header, and select Ascending or Descending.

To navigate through the pages, you can use the paging controls shown below the table.

From the Favorites List page, you can:

- Add Favorite links.
- View/modify link details.
- Delete a link.

Note: The user has to re-login to reflect the changes because of addition, modification and deletion in the favorite links.

These operations are explained further in this chapter in the following sections.

Adding favorite links

To add a new favorite link, complete the following steps:

1. In the Favorite List page, click Add Favorites.
The **Add Favorites** page is displayed enabling you to enter the favorite link's information. An example of this page is shown in the following figure.

**Figure 74: Add favorites page**

1. **Enter a name for the favorite link in the** **Name** **text box.**
2. **Specify the group(s) in the** **Assign Group(s)** **text box. This link is shown as a Favorite menu's option in the Home module for the members of the specified group(s).**
3. **Select the language from the** **Language** **drop-down list.**

  **Note:** Favorites created in a specific language is assigned only to a user configured with that language.

4. **Enter the** **Display Name**, **URL** **and** **Description** **in the respective text boxes. The Display Name is shown as the Favorite menu's option in the Home module. Note that Name, Assign Group(s), Language, Display Name, and URL are the required fields.**
5. **Click** **Save** **to add the new Favorite link and go back to the previous page.**

  **To reset the form and remove the information you just entered, click** **Reset**. **To cancel the action and exit the current page, click** **Cancel**.

### Deleting favorites

If you no longer need a particular favorite link, then you can delete it.

**To do so, follow these steps:**

1. **In the** **Favorite List** **page, select the favorite link that you want to delete by clicking its radio button in the first column.**
2. **Click** **Delete**. Business Process Portal deletes the selected favorite link and it is removed from the list.
Updating favorites information

To update favorite link's information, complete the following steps:

1. In the **Favorite List** page, select the favorite link that you want to modify by clicking its radio button in the first column

2. Click **Edit**.

   The **Modify Favorites** page is displayed.

   An example of this page is shown in the following figure.

   **Figure 75: Modify favorites page**

   ![Modify favorites page](image)

   3. Enter/modify the relevant data as necessary.

   **Note:** You cannot modify the Name and Language.

4. Click **Save** to save the changes and go back to the previous page.

   To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.
Managing work item queues

The chapter explains how to configure the work item queues using the Administration module of Business Process Portal. For details, see the following topics:

• Understanding work item queue management
• Managing work item queues

Understanding work item queue management

In Business Process Server, workitems can be generated when a process instance is created, and these workitems are assigned to a valid human performer or valid user group as tasks. A work item queue is a dynamic data structure to which users and groups are added, allowing them to subscribe to workitems assigned to the queue. Work item queues are dynamic in the sense that, you can add, remove or update users and groups to a queue during run time.

Note: To enable work item management using queues, the Business Process Server property oebps.queues should be set to TRUE in oebps.conf file. For more information, see BP Server property files on page 70.

Important: If a task is assigned to any member of queue containing nested groups, then only the members of highest level group find the task in Available state.
Managing work item queues

Business Process Server enables you to manage work item queues by displaying work item queue information, adding new work item queues, removing work item queues, updating existing work item queue information, and adding/updating/removing the work item queue members for each user.

Displaying work item queues

To view the **Queue List** page, in the Administration module, click **User Management > Queues**. To view the list of all queues, click **All** in the Quick Search.

This page lists all current queues, as shown in the following figure.

**Figure 76: Queue list page**

<table>
<thead>
<tr>
<th>Queue Name</th>
<th>Description</th>
<th>Member</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue One</td>
<td>Queue One</td>
<td></td>
</tr>
</tbody>
</table>

Queue List page

The **Queue List** page displays information about the work item queues. By default, it does not display any work item queue. You will have to search for the queue(s) using the Search Bar. Searching for queues is similar to searching for users. For more details about this, see **Searching Users** on page 40. It lists the queues satisfying your search criteria and the following information about each queue:

**Table 45: My application list information**

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Queue Name</td>
<td>The name of the work item queue.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the work item queue.</td>
</tr>
<tr>
<td>Member</td>
<td>The user(s) and group(s) that are members of the work item queue.</td>
</tr>
</tbody>
</table>
To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the Queue List page, you can perform the following operations:

- Creating work item queues.
- View/modify work item queue details.
- View/modify work item queue members.
- Delete a work item queue.

These operations are explained further in this chapter in the following sections.

**Creating work item queues**

To create a work item queue, complete the following steps:

1. In the Queue List page, click Create Queue.

   The Create Queue page is displayed enabling you to enter the new work item queue information.

   An example of this page is shown in the following figure.

   **Figure 77: Create queue page**

2. In the Queue Details page, enter the relevant data as necessary.

   The fields marked with a red asterisk are required fields.

3. Click Save to create the new work item queue and go back to the previous page. Click Save & Create New to save the current work item queue and reload the current page to continue adding another work item queue.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.
Updating work item queue information

To update work item queue information, complete the following steps:

1. In the Queue List page, click the work item queue name link in the Queue Name column, whose details you want to update.

   The Queue Details page is displayed.

   An example of this page is shown in the following figure.

   **Figure 78: Queue details page**

   ![Queue Details Page](image)

   2. In the Queue Details page, enter/modify the relevant data as necessary.

   3. Click Save to save the changes and go back to the previous page.

   Click Delete to delete the current work item queue.

   To reset the form and remove the information you just entered, click Reset. To cancel the action and exit the current page, click Cancel.

Deleting work item queues

If you no longer need a particular work item queue, then you can delete it.

**To do so, follow these steps:**

1. In the Queue List page, select the work item queue that you want to delete.

   For more details about this operation, see Selecting and clearing rows on page 35. If needed, first search the queues. Searching for queues is similar to searching for users. For more details about this, see Searching Users on page 40. It lists the queues satisfying your search criteria.

2. Click Delete.
Note:

- A queue having workitems available to queue members cannot be deleted.
- A queue cannot be deleted even if the workitem available to the queue members is reassigned to another user. This is because the queue is the actual owner of the workstep instance. Only when the workstep instance is completed, then you can delete the queue.

Business Process Server deletes the selected work item queue and it is removed from the list.

Note: You can simultaneously delete multiple queues. To do this, in the Queue List page, select multiple queues and then click Delete. Business Process Server deletes all the selected users.

Managing work item queue members

Business Process Server enables you to manage members of a work item queue by allowing you to search for users and/or groups, add and remove one or more members, and to change user/group availability.

One or more users and/or groups can become a member of a work item queue.

Viewing Queue Members

To view the Queue Members List page, click the View Queue Members icon in the Queue List page. Alternatively, you can click the Queue Members link from the Queue Details page of the selected work item queue. This page displays the members of the selected work item queue. The example of this page is shown in the following figure.

Figure 79: Queue members list page
Queue Members List page

The Queue Members List page contains two frames: the top frame displays users that are members of the selected work item queue; and the bottom frame displays groups that are members of the selected work item queue.

To manage the contents of the list, you can sort them. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the Queue Members List page, you can:

- Adding a member.
- Deleting a member.

These operations are explained further in this chapter in the following sections.

Adding members to work item queues

To add Business Process Server users or groups as members of a work item queue, complete the following steps:

1. In the Queue Members List page, click Add Queue Member.

   The Add Users & Groups page is displayed.

   An example of this page is shown in the following figure.

   Figure 80: Add users and groups page

   2. Search and locate users or groups. For more details, see Searching Users on page 40.

   3. Click Add to add the selected users and/or group and go back to the previous page.

   Click Add & Continue to add the current users/groups and reload the current page to continue adding another user/group.

   To cancel the action and exit the current page, click Cancel.
Removing members from workitem queue

To remove a member from a work item queue, complete the following steps:

1. In the Queue Members List page, select the user and/or group that you want to delete. For more details about this operation, see Selecting and clearing rows on page 35.

2. Click Delete.

Business Process Server deletes the selected user/group and it is removed from the list.

**Note:** You can simultaneously delete multiple users or groups. To do this, in the Queue Member List page, select multiple users or groups, and then click Delete. Business Process Server deletes all the selected users/groups.

Do not remove all members of a queue if workitems are still assigned to that queue.
Managing access control

The introduction of Access Control Management (ACLManager) enables you as administrator to personalize Business Process Portals, with authorization to specified portals and features limited to the appropriate user. The Access Control Management feature also allows administrators to:

• Add and/or remove privileges, thereby limiting a user's access to some features of a portal. For example, you may give a person access to the user management features of the Administration module, but not the ability to restart the servers or install applications.

• Develop a custom portal that collects features from the various "out-of-the-box" Business Process Portals. For example, allowing a user to install or uninstall certain applications.

ACLManager is used by the portals and the server API to limit access to Business Process Server resources. This chapter explains how to apply the ACLManager permissions to users and groups, and their resources.
For details, see the following topics:

- **Butterfly model of security**
- **Accessing access control parameters**
- **Working with permissions**

## Butterfly model of security

The ACLManager in Business Process Server follows the butterfly modeling concept for security. This model gives you more flexibility and better control. In the butterfly model, users, resources and actions are the basic entities, and the relations between these entities are controlled by granting/revoking rights. In this model, users are the subjects of accesses, resources are the objects of accesses, and actions are the operations performed by the users on the resources. In Business Process Server, the users can be Business Process Portal users and/or groups, resources can be any of the Business Process Server components and/or resources, and actions are the list of possible operations you can perform on these resources. For more details about the Business Process Server resources and actions see, [Business Process Server resource hierarchy](page 184).

## Accessing access control parameters

Business Process Server stores the configuration parameters for Access Control Management in the `umacl.conf` file, located in the `OEBPS_HOME\conf` directory. The parameter that specifies the implementation is as follows:

```
system.aclmgr.class=com.savvion.acl.impl
```

If you want to use your own user management implementation instead of the Business Process Server's default implementation -- `com.savvion.acl.impl`, then you can specify your user implementation class name as the value of this parameter.

## Business Process Server resource hierarchy

The authorization process in Business Process Server is performed by the ACLManager. Actions are placed on the resource. The list of resource/action pairs associated with the user/group represent that user/group's privilege. Actions define the type of task you can perform on the resource.

To better understand the application of permissions, Business Process Server resource hierarchies are grouped into five categories: Business Process Server, BPM Events, Management, Administration, and Dashboard. How these resources operate is explained as follows:

### Business Process Server

Business Process Server resources belong to one of three hierarchies:

- Process instance resources. This hierarchy gives a user the right to perform operations on a process instance, i.e. `BPServer.PI.Approval.App#1`, while another user has the right to perform operations on `BPServer.PI.Approval.App#2`. Remember, a user with the right to perform operations on `BPServer.PI.Approval` as a resource inherits the right for all instances of Approval.
Likewise, a user with the right to perform an operation on BPServer.PI, may perform that operation on all Business Process Server process template instances.

Tip: To use the process instance permissions, you must set the system.pi.checkacl parameter from the umacl.conf file to TRUE.

Figure 81: Resource hierarchy for process instances

- Dataslot resource. Consider the protection for the "salary" and "resume" dataslots of the Hiring#1 process instance. The resource names are BPServer.DS.Hiring.Hiring#1.salary and BPServer.DS.Hiring.Hiring#1.resume. A user with the rights to resource BPServer.DS.Hiring.Hiring#1 has the rights on all Hiring#1 dataslots, which includes "salary" and "resume."

Figure 82: Resource hierarchy for dataslot

- Process template resource. The shallowest of the Business Process Server hierarchies, this permission allows defining process templates as resources. Any template, such as Approval, Hiring or Timeoff can be protected as a resource in Business Process Server. You may reference these templates as BPServer.PT.Approval, BPServer.PT.Hiring, or BPserver.PT.Timeoff.

Figure 83: Resource hierarchy for process template

The resources protected in Business Process Server are summarized below:
<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Process Template</td>
<td>PTName</td>
</tr>
<tr>
<td>Process Instance</td>
<td>PTName.PIName</td>
</tr>
<tr>
<td>Data Slot</td>
<td>PTName.PIName.DSName</td>
</tr>
</tbody>
</table>

### BPM Events

The resources protected in BPM Events are as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Infopad</td>
<td>infopadname</td>
</tr>
</tbody>
</table>

### Management

The resources protected in the Management module of Business Process Portal are as follows:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Report</td>
<td>PTName.reportName</td>
</tr>
<tr>
<td>BPMSQLReport</td>
<td>fileName</td>
</tr>
<tr>
<td>ReportBuilder</td>
<td>reportType</td>
</tr>
</tbody>
</table>

The Report Types are:

- **OEBPS**: Internally created reports in the Management module.
- **External**: Reports from external reports sources, crystal, BPM SQL, etc.

### Administration

The protected resources for Administration module users are:

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>appName</td>
</tr>
<tr>
<td>Modeler</td>
<td>modelername</td>
</tr>
<tr>
<td>Configuration</td>
<td>conffilename</td>
</tr>
<tr>
<td>Queue</td>
<td>queueName</td>
</tr>
<tr>
<td>Reusable Components</td>
<td>reusablecomponentName</td>
</tr>
<tr>
<td>Log</td>
<td>componentName</td>
</tr>
<tr>
<td>Server</td>
<td>serverName</td>
</tr>
<tr>
<td>Group</td>
<td>groupname</td>
</tr>
</tbody>
</table>
The application resource types are:
• BPM Workflow
• OEBPS

The configuration resource file names are:
• BPMPortal
• BPMEvents
• BPMWorkflow
• BPMProcessStore
• Email
• EventPublisher
• Log
• Portal
• OEBPS

The reusable components resource types are:
• BPMWorkflow
• OEBPS

The log resource component names are:
• Archiver
• BPMPortal
• BPMEvents
• BPMWorkflow
• BPMProcessStore
• EventPublisher
• OEBPS

The server resources are:
• Archiver
• BPMPortal
• BPMEvents
• Event Publisher

[4] This is a general, not a specific permission for this resource. You may name this permission anything but "mypermission."
Dashboard
The resources protected in Dashboard are as follows:

Table 50: Dashboard resources

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dashboard Component</td>
<td>componentname</td>
</tr>
</tbody>
</table>

Actions
Actions are the type of task you can perform on the resource. For example, you may grant a permission to a group to start and stop a server in the Administration module. The resource is the server, stop and start are the actions, and Administration is the component. Unlike resources, actions are not hierarchical. The following table depicts all actions defined for all Business Process Server resources:

Table 51: Actions for resources

<table>
<thead>
<tr>
<th>Component</th>
<th>Resource type</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP Server</td>
<td>Process instance</td>
<td>Any, Remove, Suspend, Resume, View, Update</td>
</tr>
<tr>
<td>BP Server</td>
<td>Process template</td>
<td>Any, View, Update</td>
</tr>
<tr>
<td>BP Server</td>
<td>Dataslot</td>
<td>Any, View, Update</td>
</tr>
<tr>
<td>BP Server</td>
<td>Infopad</td>
<td>Any, View, Update</td>
</tr>
<tr>
<td>Management</td>
<td>Report</td>
<td>Execute</td>
</tr>
<tr>
<td>Management</td>
<td>BPMSQLReport</td>
<td>Execute</td>
</tr>
<tr>
<td>Management</td>
<td>ReportBuilder</td>
<td>Any, Create, Update, Remove</td>
</tr>
<tr>
<td>Administration</td>
<td>Server</td>
<td>Any, Start, Stop, Suspend, Resume, View Status</td>
</tr>
<tr>
<td>Administration</td>
<td>Configuration</td>
<td>Any, View, Update</td>
</tr>
<tr>
<td>Administration</td>
<td>User</td>
<td>Any, View, Create, Remove, Update, Delegate</td>
</tr>
<tr>
<td>Administration</td>
<td>Group</td>
<td>Any, View, Create, Remove, Addmember, RemoveMember, Change Role, Update</td>
</tr>
<tr>
<td>Administration</td>
<td>Application</td>
<td>Any, Install, Uninstall, Suspend, Resume1, Publish, Unpublish, Execute</td>
</tr>
<tr>
<td>Administration</td>
<td>Queue</td>
<td>Any, View, Create, Remove, Addmember, RemoveMember, Update</td>
</tr>
<tr>
<td>Administration</td>
<td>Reusable Component</td>
<td>Any, Import, Export, Delete</td>
</tr>
<tr>
<td>Administration</td>
<td>Log</td>
<td>Any, View</td>
</tr>
<tr>
<td>Administration</td>
<td>Permission</td>
<td>Any, View, Create, Remove</td>
</tr>
<tr>
<td>Administration</td>
<td>Modeler</td>
<td>Any, View, Create, Update, Remove</td>
</tr>
<tr>
<td>Dashboard</td>
<td>Dashboard Component</td>
<td>View</td>
</tr>
</tbody>
</table>

5 You cannot suspend and resume a Web application. 6 The execute action protects a Web application from unauthorized execution. For example, in the Start step of the Web process, if an authenticated user is not authorized to execute the application, then they will receive an authorization failure error.
Note: In the Administration component, for the resource types User, Group and Queue, you can select Any User, Any Group and Any Queue option respectively.

Business Process Server user and group permissions

Business Process Server users and groups are managed by the OEBPS User Manager. The ACLManager invokes the User Manager API to retrieve information about a particular user or group, and enables you to manage permissions. Apply the ACLManager on users and groups to:

- View all permissions in the Administration module.
- Create new permissions.
- Remove permissions.
- Grant permissions to users and groups.
- Revoke permissions from users and groups.

Each Permission List is organized via component, with each component having its own set of permissions, providing you an authorization mechanism with more security over Business Process Server resources.

You manage permissions in Administration by using the Permissions List page. It displays the Access Control information as illustrated in Figure 84 on page 189.

Listing all permissions

To view the Permissions List page, in the Administration module, click User Management > Permissions.

This page lists all permissions, as shown in the following figure.

Figure 84: Listing permissions
Permissions List page

The Permissions List page displays information about the existing set of permissions for various components. By default, it displays all permissions and the following information about each permission:

Table 52: My application list information

<table>
<thead>
<tr>
<th>Information</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Component</td>
<td>The name of the component for which the permission is applicable.</td>
</tr>
<tr>
<td>Permission Name</td>
<td>The name of the permission.</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the permission.</td>
</tr>
<tr>
<td>Resource Type</td>
<td>The type of resource for which the permission is applicable.</td>
</tr>
<tr>
<td>Resource Name</td>
<td>The name of the resource.</td>
</tr>
<tr>
<td>Action</td>
<td>The action performed on the resource; for example, View, Execute.</td>
</tr>
</tbody>
</table>

To manage the contents of the list, you can sort them. You can use the Component drop-down list to list the permissions for a particular component or for all components. To navigate through the pages, you can use the paging controls. For more details about these operations, see Exploring Business Process Portal on page 28.

From the Permissions List page, you can:

- Create a permission.
- Delete one or more permissions.

These operations are explained further in this chapter in the following sections.

Creating permissions

To create a new permission, complete the following steps:

1. In the Permissions List page, click Create Permission.

   The Create Permissions page is displayed enabling you to enter the new permission information.
An example of this page is shown in the following figure.

**Figure 85: Creating New Permissions**

2. Specify a name and description for the permission in the **Permission** and **Description** boxes respectively. Permissions and Description are the required fields.

3. Select a component name from the **Component** drop-down list. Also select options from the **Resource Type** and **Action** drop-down lists.

**Note:** Actions are dependent on the Resource Type. Therefore, select your Resource Type before the Action.

4. Depending on the component you select, you will have to specify additional options by selecting them from the appropriate drop-down lists.

5. Click **Save** to create the new permission and go back to the previous page.

Click **Save & Add New** to save the current permission and reload the current page to continue adding another permission.

To reset the form and remove the information you just entered, click **Reset**. To cancel the action and exit the current page, click **Cancel**.

### Removing permissions

When a permission is removed, you cannot grant or revoke the permission from a user or group.

**To remove an existing permission from a component, complete the following steps:**

1. In the **Permissions List** page, select the permission that you want to delete.

   For more details about this operation, see **Selecting and clearing rows** on page 35.

2. Click **Delete**.

   Business Process Server deletes the selected permission and it is removed from the list.

**Note:** You can simultaneously delete multiple permissions. To do this, in the **Permissions List** page, select multiple permissions and then click **Delete**. Business Process Portal deletes all the
selected permissions. If permissions granted to users is deleted, then the permission is automatically revoked for all users.

Granting/Revoking permissions to users or groups

In order to gain access to, or be restricted from, protected resources, a user or group must be given or denied permission. To grant or revoke permission to users, see the procedures described in Managing user permissions on page 159 or Managing group permissions on page 167.

Note: Once you grant a permission to the user, make sure that the user has access to the relevant portal pages through the Business Process Portal Configuration in the User Details page. See Managing users on page 143 for more information on this procedure. Once you grant a permission to a group, make sure it has access to the relevant portal pages through the Business Process Portal Configuration in the Group Details page. See Managing groups on page 163 for more information on this procedure.

Granting application permission to managers

After creating an application permission, you may grant it to individuals for managing that application. In previous versions, managers were required to have access to the Management module. This is no longer necessary. Now you create and grant the permissions to the user/manager for viewing or updating an application.

This procedure is outlined in the following steps.

1. Navigate to the Permissions List page, and click Create Permission.
2. The Create Permissions page is displayed, where you can create the new permission.
3. Enter the new permission name and its description. For example, if you wish to give a manager the ability to update a process template in the Management module, then you may enter “Update Process Template” in the Permission box and “For Managers in the Management module” in the Description box.
4. Select BP Server from the Component drop-down list; Process Template from the Resource Type drop-down list; and Update from the Action drop-down list.

Important: Although the user accesses the template in Management, the process template itself is in Business Process Server, which is why you must grant this as a Business Process Server permission, not a Management permission.

5. Click Save. Business Process Server creates the new permission after your confirmation. You must next grant this new permission to the user/manager.

6. Click User Management > Users. The User List page is displayed.
7. Click the User Name link of the user/manager to whom you want to assign the new permission, displaying the User Details page.
8. Click Permissions to go to the Permissions section. In this section, Business Process Server displays the permissions available for assignment to the selected user/manager.
9. Select the check box beside the permission name that you just created. Click Save.
Business Process Server grants the selected permission to the selected user/manager after your confirmation.

Working with permissions

In Business Process Server a particular permission is a combination of resources and actions for a component. The options for the resources and actions vary depending on the component you select. The permission names used in the following tables represent the options you selected while defining the permission. For example, bl_pt_any_any represents Component BP Server, Resource Type ProcessTemplate, Action Any and Process Template Any.

Business Process Server permissions

This section explains various Business Process Server permissions and scope.

Abbreviations

The abbreviations for the component options used in the Business Process Server permissions are as follows:

- bl: BP Server
- pt: Process Template
- pi: Process Instance
- ds: Dataslot

Scope of a permission

In the case of resources such as process template or process instance, the options include "Any" and the list of process templates or process instances. If you select Any while creating a permission, then the scope of that permission is across all process templates or process instances; whereas if you select a particular process template or process instance, then the scope of that permission is limited only to the selected process template or process instance. For example, the permission bl_pt_any_any allows you to view or update any of the existing process templates, but bl_pt_any_<specific_pt> allows you to view or update only the selected process template. The following table lists only the permissions with "Any" option, wherever applicable, you may select a specific entity instead of Any to limit the scope.

Note: If ACL needs to be checked when accessing process instance resources, then system.pi.checkacl parameter in umacl.conf file should be set to true.
Table 53: Business Process Server permissions and their usage

<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>bl_pi_any_any_any (Default ProcessInstance permission)</td>
<td>Case 1:Permissions: ---Business Process Portal Configuration: ---</td>
<td>Home &gt; My Instances. You can only view the workstep details of the process instance created by you, by using PSV chart.</td>
</tr>
<tr>
<td></td>
<td>Case 2:Permissions: Any of the following • bl_pt_any_any, or • bl_pt_view_any • bl_pt_update_any Business Process Portal Configuration: Management &gt; Overview</td>
<td>Management &gt; Overview &gt; Instances. You can modify the process instance's workstep details by using PSV chart.</td>
</tr>
<tr>
<td>bl_pi_suspend_any_any</td>
<td>Permissions: All of the following • bl_pt_any_any • bl_pi_view_any_any • bl_ds_update_any_any_any Business Process Portal Configuration: Management &gt; Overview</td>
<td>Management &gt; Overview &gt; Instances &gt; Process Status Viewer &gt; View Dataslots. You can suspend any process instance by changing its Status from the drop-down list.</td>
</tr>
</tbody>
</table>

---

For these permissions, optionally, you can also specify the <creator>. For example, bl_pi_view_any_any_<creator>. In such a case, it allows you to perform the specified action on all process instances of the <creator>. Please note that, if you specify a <creator>, then such a permission ignores the specific process instance name and allows you to perform the specified action on all process instances of the <creator>. Also note that, like other fields, the <creator> field is used as a constraint or filter to limit the access.
<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Example</th>
</tr>
</thead>
</table>
| bl_pi_resume_any_any | Permissions: All of the following  
  - bl_pt_any_any  
  - bl_pi_view_any_any  
  - bl_ds_update_any_any_any  
Business Process Portal Configuration: Management > Overview | Management > Overview > Instances > Process Status Viewer > View Dataslots You can resume any suspended process instance by changing its Status from the drop-down list. |
| bl_pi_view_any_any | Case 1:Permissions: ---Portal Configuration: --- | Case 1:Permissions: ---Portal Configuration: --- Home > My Instances You can only view the workstep details of the process instance created by you, by using PSV chart. |
| | Case 2:Permissions: Any of the following  
  - bl_pt_any_any  
  - bl_pt_view_any  
  - bl_pt_update_any  
Business Process Portal Configuration: Management > Overview | Case 2:Permissions: Any of the following  
  - bl_pt_any_any  
  - bl_pt_view_any  
  - bl_pt_update_any  
Business Process Portal Configuration: Management > Overview | Management > Overview > Instances You can only view the process instance's workstep details by using PSV chart. |
| | Case 2:Permissions: Any of the following  
  - bl_pt_any_any  
  - bl_pt_view_any  
  - bl_pt_update_any  
Business Process Portal Configuration: Management > Overview | Case 2:Permissions: Any of the following  
  - bl_pt_any_any  
  - bl_pt_view_any  
  - bl_pt_update_any  
Business Process Portal Configuration: Management > Overview | Management > Overview > Instances You can modify the process instance's workstep details by using PSV chart. |
| bl_ds_any_any_any_any (Default DataSlot permission) | Permissions: All of the following  
  - bl_pt_<any or view or update>_any  
  - bl_pi_<any or view or update>_any_any  
Business Process Portal Configuration: Management > Overview | Management > Overview > Instances > Process Status Viewer > View Dataslots You can modify the dataslot values. |
### BPM Events permissions

**Example**

bl_ds_any_any_any_any

Let us assume that the administrator "ebms" wants to grant the permission to a user "user1" to modify the dataslot values of any instance of any process. In order to do so, the user will need permission to access the process instance (bl_pi_any_any), and to access the process instance, the user needs permission to access the process template (bl_pt_any_any). Also, to access the dataslots, the user needs access to the Management > Overview menu option. The administrator grants all these permissions and access to the menu option using the User Details page.

The user can now log in to Business Process Portal and go to the Instances Overview page.

On this page he/she can click the Process Status Viewer icon in the Chart column to open the Process Status Viewer page. Click View Dataslots to open the View Dataslot page. As the user "user1" has permission to perform any operation on the dataslots, he/she can modify the values of any dataslots.

The abbreviations for the component options used in the BPM Events permissions are as follows:

- **bp**: BPMEvents
- **ip**: Infopad

**Scope of a permission**

In the case of a resource such as infopad, the options include "Any" and the list of infopads. If you select Any while creating a permission, then the scope of that permission is across all infopads; whereas if you select a particular infopad, then the scope of that permission is limited only to the selected infopad. For example, the permission bp_ip_any_any allows you to view or update any of the existing infopads, but bp_ip_<specific_ip> allows you to view or update only the selected infopad. The following table lists only the permissions with "Any" option; wherever applicable, you may select a specific entity instead of Any to limit the scope.
### Table 54: BPM Events permissions and their usage

<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>bp_ip_any_any (Default InfoPad permission)</td>
<td>Permissions: ---Business Process Portal Configuration: Management &gt; Infopads</td>
<td>Management &gt; Infopads You can modify the infopad slot values.</td>
</tr>
<tr>
<td>bp_ip_view_any</td>
<td>Permissions: ---Business Process Portal Configuration: Management &gt; Reports</td>
<td>Management &gt; Reports &gt; My Reports You can only view the infopad reports.</td>
</tr>
<tr>
<td>bp_ip_update_any</td>
<td>Permissions: ---Business Process Portal Configuration: Management &gt; Infopads</td>
<td>Management &gt; Infopads You can modify the infopad slot values.</td>
</tr>
</tbody>
</table>

**Example**

bp_ip_update_any

Let us assume that the administrator "admin" wants to grant the permission to a user "user2" to modify any infopad slot values of any instance of infopad. Also, to access the infopads, the user needs access to the Management > Infopad menu option. The administrator grants the permission and access to the menu option using the User Details page.

The user can now login in the Business Process Portal and click Management > Infopads to open the Infopads page. As the user "user2" has permission to perform any operation on the infopad slot values, he/she can view and/or modify any of the infopad slot values.

**Management permissions**

This section explains various management permissions and scope.

**Abbreviations**

The abbreviations for the component options used in the Management permissions are as follows:

- **mgm**: Management
- **rep**: Report
- **exe**: Execute
- **repbuild**: ReportBuilder
- **com**: Common
- **ext**: External Report
- **bsqlrep**: BPM SQL Report
- **oob**: Out-of-the-box Report
Scope of a permission

In the case of resources such as report, the options include "Any" and the list of applications. If you select Any while creating a permission, then the scope of that permission is across all applications; whereas if you select a particular application, then the scope of that permission is limited only to the selected application. For example, the permission `mgm_rep_exe_any_any` allows you to execute any of the existing reports of any application, but `mgm_rep_exe_<specific_app>_<specific_rep>` allows you to execute only the selected reports of the selected application. The following table lists only the permissions with "Any" option; wherever applicable, you may select a specific entity instead of Any to limit the scope.

Table 55: Management permissions and their usage

<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>mgm_rep_exe_any_any</code></td>
<td>Permissions: ---Business Process Portal Configuration: <strong>Management &gt; Reports</strong></td>
<td><strong>Management &gt; Reports</strong> You can execute the existing reports.</td>
</tr>
<tr>
<td><code>mgm_rep_exe_com_any</code></td>
<td>Permissions: ---Business Process Portal Configuration: <strong>Management &gt; Reports</strong></td>
<td><strong>Management &gt; Reports</strong> You can execute the existing common reports.</td>
</tr>
<tr>
<td><code>mgm_rep_exe_ext_any</code></td>
<td>Permissions: ---Business Process Portal Configuration: <strong>Management &gt; Reports</strong></td>
<td><strong>Management &gt; Reports</strong> You can execute the existing external reports.</td>
</tr>
<tr>
<td><code>mgm_rep_exe_oob_any</code></td>
<td>Permissions: ---Business Process Portal Configuration: <strong>Management &gt; Reports</strong></td>
<td><strong>Management &gt; Reports</strong> You can execute the existing out-of-the-box reports.</td>
</tr>
<tr>
<td><code>mgm_repbuild_any_any</code></td>
<td>Permissions: All of the following</td>
<td><strong>Management &gt; Reports</strong> You can create, remove or update Multi-Application, Query, Infopad, HTML, Crystal and BPM SQL reports.</td>
</tr>
<tr>
<td><code>mgm_repbuild_any_ext</code></td>
<td>Permissions: All of the following</td>
<td><strong>Management &gt; Reports</strong> You can create, remove, update HTML, Crystal and BPM SQL reports.</td>
</tr>
</tbody>
</table>

Business Process Portal Configuration: Management > Reports
<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>mgm_repbuild_any_sbm</td>
<td>Permissions: All of the following</td>
<td>Management &gt; Reports You can create, remove or update Multi-Application, Query and Infopad reports.</td>
</tr>
<tr>
<td></td>
<td>- bl_pt_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bl_pi_any_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bp_ip_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- mgm_rep_exe_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- mgm_bsqlrep_exe_any</td>
<td></td>
</tr>
<tr>
<td>Business Process Portal Configuration: Management &gt; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mgm_repbuild_create_any</td>
<td>Permissions: All of the following</td>
<td>Management &gt; Reports You can create Multi-Application, Query, Infopad, HTML, Crystal and BPM SQL reports.</td>
</tr>
<tr>
<td></td>
<td>- bl_pt_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bl_pi_any_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bp_ip_any_any</td>
<td></td>
</tr>
<tr>
<td>Portal Configuration: Management &gt; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mgm_repbuild_create_ext</td>
<td>Permissions: All of the following</td>
<td>Management &gt; Reports You can create HTML, Crystal and BPM SQL reports.</td>
</tr>
<tr>
<td></td>
<td>- bl_pt_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bl_pi_any_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bp_ip_any_any</td>
<td></td>
</tr>
<tr>
<td>Business Process Portal Configuration: Management &gt; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mgm_repbuild_create_sbm</td>
<td>Permissions: All of the following</td>
<td>Management &gt; Reports You can create Multi-Application, Query and Infopad reports.</td>
</tr>
<tr>
<td></td>
<td>- bl_pt_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bl_pi_any_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- bp_ip_any_any</td>
<td></td>
</tr>
<tr>
<td>Business Process Portal Configuration: Management &gt; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mgm_repbuild_remove_any</td>
<td>Permissions: All of the following</td>
<td>Management &gt; Reports You can remove Multi-Application, Query, Infopad, HTML, Crystal and BPM SQL reports.</td>
</tr>
<tr>
<td></td>
<td>- mgm_rep_exe_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- mgm_bsqlrep_exe_any</td>
<td></td>
</tr>
<tr>
<td>Portal Configuration: Management &gt; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mgm_repbuild_remove_ext</td>
<td>Permissions: All of the following</td>
<td>Management &gt; Reports You can remove HTML, Crystal and BPM SQL reports.</td>
</tr>
<tr>
<td></td>
<td>- mgm_rep_exe_any_any</td>
<td></td>
</tr>
<tr>
<td></td>
<td>- mgm_bsqlrep_exe_any</td>
<td></td>
</tr>
<tr>
<td>Business Process Portal Configuration: Management &gt; Reports</td>
<td></td>
<td></td>
</tr>
<tr>
<td>mgm_repbuild_remove_sbm</td>
<td>Permissions: mgm_rep_exe_any_any</td>
<td>Management &gt; Reports You can remove Multi-Application, Query and Infopad reports.</td>
</tr>
<tr>
<td></td>
<td>Business Process Portal Configuration: Management &gt; Reports</td>
<td></td>
</tr>
</tbody>
</table>
## Management > Reports

### You can update Multi-Application, Query, Infopad, HTML, Crystal and BPM SQL reports.

**Permissions:** All of the following

- `mgm_rep_exe_any_any`  
- `bl_pt_any_any`  
- `bl_pi_any_any_any`  
- `bp_ip_any_any`  
- `mgm_rep_exe_any_any`  
- `mgm_bsqlrep_exe_any`  

**Business Process Portal Configuration:**  
Management > Reports

### You can update HTML, Crystal and BPM SQL reports.

**Permissions:** All of the following

- `mgm_rep_exe_any_any`  
- `mgm_bsqlrep_exe_any`  

**Business Process Portal Configuration:**  
Management > Reports

### You can update Multi-Application, Query and Infopad reports.

**Permissions:** All of the following

- `bl_pt_any_any`  
- `bl_pi_any_any_any`  
- `bp_ip_any_any`  
- `mgm_rep_exe_any_any`  
- `mgm_bsqlrep_exe_any`  

**Business Process Portal Configuration:**  
Management > Reports

### You can view BPM SQL reports.

**Permissions:** `mgm_rep_exe_any_any`

**Business Process Portal Configuration:**  
Management > Reports

### You can view a specific BPM SQL reports.

**Permissions:** `mgm_rep_exe_any_any`

**Business Process Portal Configuration:**  
Management > Reports

---

**Example**

`mgm_repbuild_update_any`

Let us assume that the administrator "ebms" wants to grant the permission to a user "user3" to update any report using the report builder. In order to do so, the user needs permission to access the report (`mgm_rep_exe_any_any`). Also, to access the reports, the user will need access to the Management > Reports menu option. The administrator grants the permission and access to the menu option using the **User Details** page.
The user can now login in the Business Process Portal and click **Management > Reports > My Reports** to open the **Report List** page. As the user "user3" has permission to update any report, he/she can modify any of the Multi-Application, Query, Infopad, HTML, Crystal and BPM SQL reports by clicking the Edit Report icon in the Report Name column.

### Administration permissions

This section explains various administration permissions and scope.

#### Abbreviations

The abbreviations for the component options used in the Administration permissions are as follows:

- adm: Administration
- app: Application
- bs: BPM Workflow
- sbm: BP Server Applications
- exe: Execute
- mod: Business Process Modeler
- conf: Configuration
- que: Queue
- addmem: Add Member
- remmem: Remove Member
- rc: Reusable Components
- imp: Import
- exp: Export
- del: Delete
- log: Log File
- serv: Server
- viewstat: View Status
- grp: Group
- chrole: Change Role
- usr: User
- perm: Permission
Scope of a Permission

In the case of resources such as application, the options include "Any" and the list of applications. If you select Any while creating a permission, then the scope of that permission is across all applications; whereas if you select a particular application, then the scope of that permission is limited only to the selected application. For example, the permission adm_app_install_any_any allows you to install any of the existing Web or Business Process Server applications, but adm_app_install_any_<specific_app> allows you to install only the selected application. The following table lists only the permissions with "Any" option, wherever applicable; you may select a specific entity instead of Any to limit the scope.

Table 56: Administration permissions and their usage

<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>adm_app_any_any_any</td>
<td>Permissions: Business Process Portal Applications</td>
<td>Administration &gt; Applications: You can perform any action on any Web or Business Process Server application.</td>
</tr>
<tr>
<td>adm_app_any_bs_any</td>
<td>Permissions: Business Process Portal Applications</td>
<td>Administration &gt; Applications: You can perform any action on any Web application.</td>
</tr>
<tr>
<td>adm_app_exe_any_any</td>
<td>Not supported because execute action is available only for Web applications.</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>adm_app_exe_bs_any</td>
<td>Permissions: Business Process Portal Applications</td>
<td>Administration &gt; Applications: You can execute any Web application.</td>
</tr>
<tr>
<td>adm_app_exe_sbm_any</td>
<td>Not supported because execute action is available only for Web applications.</td>
<td>Not applicable.</td>
</tr>
<tr>
<td>adm_app_install_bs_any</td>
<td>Permissions: Business Process Portal Applications</td>
<td>Administration &gt; Applications: You can install any Web application.</td>
</tr>
<tr>
<td>adm_app_uninstall_bs_any</td>
<td>Permissions: Business Process Portal Applications</td>
<td>Administration &gt; Applications: You can uninstall any Web application.</td>
</tr>
<tr>
<td>Permission</td>
<td>Pre-requisite</td>
<td>Usage</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>adm_app_suspend_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; Applications</td>
<td>Administration &gt; Applications You can suspend any Web or Business Process Server application.</td>
</tr>
<tr>
<td>adm_app_resume_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; Applications</td>
<td>Administration &gt; Applications You can resume any suspended Web or Business Process Server application.</td>
</tr>
<tr>
<td>adm_app_publish_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; Applications</td>
<td>Administration &gt; Applications You can publish any Web or Business Process Server application.</td>
</tr>
<tr>
<td>adm_app_publish_bs_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; Applications</td>
<td>Administration &gt; Applications You can publish any Web application.</td>
</tr>
<tr>
<td>adm_app_unpublish_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; Applications</td>
<td>Administration &gt; Applications You can unpublish any published Web or Business Process Server application.</td>
</tr>
<tr>
<td>adm_app_unpublish_bs_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; Applications</td>
<td>Administration &gt; Applications You can unpublish any published Web application.</td>
</tr>
<tr>
<td>adm_mod_any_any</td>
<td>Permissions: ---Business Process Portal Configuration: ---</td>
<td>You can create or update a model using the Business Process Modeler and view or delete a model using the Process Repository Admin.</td>
</tr>
<tr>
<td>adm_mod_create_&lt;specific_mod&gt;</td>
<td>Permissions: ---Business Process Portal Configuration: ---</td>
<td>It is recommended that you should use the &quot;adm_mod_create_any&quot; permission instead of this one.</td>
</tr>
<tr>
<td>Permission</td>
<td>Pre-requisite</td>
<td>Usage</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>adm_conf_view_any</td>
<td>Permissions: ---Portal Configuration: Administration &gt; System</td>
<td>Administration &gt; System You can only view any configuration file.</td>
</tr>
<tr>
<td>adm_que_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>Administration &gt; User Management You can create, update, remove, add a member and remove a member from a queue.</td>
</tr>
<tr>
<td>adm_que_create_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>Administration &gt; User Management You can create any queue.</td>
</tr>
<tr>
<td>adm_que_remove_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>Administration &gt; User Management You can remove any queue.</td>
</tr>
<tr>
<td>adm_que_addmem_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>Administration &gt; User Management You can add a member in any queue.</td>
</tr>
<tr>
<td>adm_que_remmem_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>Administration &gt; User Management You can remove a member from any queue.</td>
</tr>
<tr>
<td>adm_que_view_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>Administration &gt; User Management You can view any queue.</td>
</tr>
<tr>
<td>adm_rc_any</td>
<td>Permissions: ---Business Process Portal Configuration: ---</td>
<td>You can import, export or delete a reusable component.</td>
</tr>
<tr>
<td>adm_rc_imp</td>
<td>Permissions: ---Business Process Portal Configuration: ---</td>
<td>You can only import a reusable component.</td>
</tr>
<tr>
<td>adm_rc_exp</td>
<td>Permissions: ---Business Process Portal Configuration: ---</td>
<td>You can only export a reusable component.</td>
</tr>
<tr>
<td>adm_rc_del</td>
<td>Permissions: ---Business Process Portal Configuration: ---</td>
<td>You can only delete a reusable component.</td>
</tr>
<tr>
<td>Permission</td>
<td>Pre-requisite</td>
<td>Usage</td>
</tr>
<tr>
<td>-------------------</td>
<td>----------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>adm_serv_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; System</td>
<td>You can start, stop, suspend, resume or view status of any of the server from Archiver, BP Server, BPM Events, or EventPublisher.</td>
</tr>
<tr>
<td>adm_serv_start_any</td>
<td>Permissions: adm_serv_viewstat_any Business Process Portal Configuration: Administration &gt; System</td>
<td>You can start any of the server from Archiver, BP Server, BPM Events, or EventPublisher.</td>
</tr>
<tr>
<td>adm_serv_stop_any</td>
<td>Permissions: adm_serv_viewstat_any Business Process Portal Configuration: Administration &gt; System</td>
<td>You can stop any of the server from Archiver, BP Server, BPM Events, or EventPublisher.</td>
</tr>
<tr>
<td>adm_serv_viewstat_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; System</td>
<td>You can view status of any of the server from Archiver, BP Server, BPM Events or EventPublisher.</td>
</tr>
<tr>
<td>adm_grp_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can create, update, remove a group, add a member to a group, remove a member from a group or change the role of a member.</td>
</tr>
<tr>
<td>adm_grp_create_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can create a group.</td>
</tr>
<tr>
<td>adm_grp_remove_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can remove any group.</td>
</tr>
<tr>
<td>adm_grp_addmem_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can add a member to any group.</td>
</tr>
<tr>
<td>adm_grp_remmem_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can remove a member from any group.</td>
</tr>
<tr>
<td>adm_grp_chrole_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can change the role of any member.</td>
</tr>
<tr>
<td>adm_usr_any_any</td>
<td>Permissions: Business Process Portal Configuration: Administration &gt; User Management</td>
<td>You can create, remove, update a user or specify delegate settings for any user.</td>
</tr>
<tr>
<td>Permission</td>
<td>Pre-requisite</td>
<td>Usage</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>adm_usr_create_any</td>
<td>Permissions: Business Process Portal</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Configuration: <strong>Administration &gt; User Management</strong></td>
<td>&gt; Users You can create a user.</td>
</tr>
<tr>
<td>adm_usr_remove_any</td>
<td>Permissions: Business Process Portal</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Configuration: <strong>Administration &gt; User Management</strong></td>
<td>&gt; Users You can remove any user.</td>
</tr>
<tr>
<td>adm_usr_update_any</td>
<td>Permissions: adm_usr_view_any Business Process</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Portal Configuration: **Administration &gt; User</td>
<td>&gt; Users You can update any user.</td>
</tr>
<tr>
<td>adm_usr_view_any</td>
<td>Management</td>
<td></td>
</tr>
<tr>
<td>adm_usr_delegate_any</td>
<td>Permissions: adm_usr_view_any Business Process</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Portal Configuration: **Administration &gt; User</td>
<td>&gt; Users You can specify delegate</td>
</tr>
<tr>
<td></td>
<td>Management</td>
<td>settings for any user.</td>
</tr>
<tr>
<td>adm_perm_any_any</td>
<td>Permissions: Business Process Portal</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Configuration: <strong>Administration &gt; User Management</strong></td>
<td>&gt; Permissions You can view, create or</td>
</tr>
<tr>
<td></td>
<td></td>
<td>remove permissions.</td>
</tr>
<tr>
<td>adm_perm_view_any</td>
<td>Permissions: Business Process Portal</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Configuration: <strong>Administration &gt; User Management</strong></td>
<td>&gt; Permissions You can only view</td>
</tr>
<tr>
<td></td>
<td></td>
<td>permissions.</td>
</tr>
<tr>
<td>adm_perm_create_any</td>
<td>Permissions: Business Process Portal</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Configuration: <strong>Administration &gt; User Management</strong></td>
<td>&gt; Permissions You can create</td>
</tr>
<tr>
<td></td>
<td></td>
<td>permissions.</td>
</tr>
<tr>
<td>adm_perm_remove_any</td>
<td>Permissions: Business Process Portal</td>
<td>Administration &gt; User Management</td>
</tr>
<tr>
<td></td>
<td>Configuration: <strong>Administration &gt; User Management</strong></td>
<td>&gt; Permissions You can remove any</td>
</tr>
<tr>
<td></td>
<td></td>
<td>permissions.</td>
</tr>
</tbody>
</table>

**Example**

adm_serv_any_any

Let us assume that the administrator "ebms" wants to grant the permission to a user "user4" to perform any operation on any server. To access the servers, the user needs access to the Administration > System menu option. The administrator grants the permission and access to the menu option using the **User Details** page.

The user can now login in Business Process Portal and click Administration > System > Status to open the **Report List** page. As the user "user4" has permission to perform any operation, he/she can start, stop, suspend, resume or view status of any of the Archiver, BP Server, BPM Events or EventPublisher servers.

**Dashboard permissions**

This section explains various dashboard permissions and scope.
Abbreviations
The abbreviations for the component options used in the Dashboard permissions are as follows:
- db: Dashboard
- cp: Component
- com: Common
- pt: Process Template

Scope of a permission
You can select only Component as the resource type and "View" as action. If you select Any for the process template while creating a permission, then the scope of that permission is across all process templates; whereas if you select a particular process template, then the scope of that permission is limited only to the selected process template. Similarly, you can also control the scope by specifying Any or a specific component. For example, the permission \texttt{db\_cp\_view\_<specific pt>_any} allows you to view any component of the specified process template. The following table lists only the permissions with "Any" option; wherever applicable, you may select a specific entity instead of Any to limit the scope.

Table 57: Dashboard permissions and their usage

<table>
<thead>
<tr>
<th>Permission</th>
<th>Pre-requisite</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>\texttt{db_cp_view_any_any} (Default Dashboard component permission)</td>
<td>Permissions: ---Business Process Portal Configuration: \texttt{Home &gt; Dashboard}</td>
<td>Home &gt; Dashboard You can only view the component.</td>
</tr>
<tr>
<td>\texttt{db_cp_view_any_&lt;specific cp&gt;}</td>
<td>Permissions: ---Business Process Portal Configuration: \texttt{Home &gt; Dashboard}</td>
<td>Home &gt; Dashboard You can view only the specified component of any process template.</td>
</tr>
<tr>
<td>\texttt{db_cp_view_com_any}</td>
<td>Permissions: ---Business Process Portal Configuration: \texttt{Home &gt; Dashboard}</td>
<td>Home &gt; Dashboard You can view any of the dashboard components which are common for all process templates.</td>
</tr>
<tr>
<td>\texttt{db_cp_view_&lt;specific pt&gt;_any}</td>
<td>Permissions: ---Business Process Portal Configuration: \texttt{Home &gt; Dashboard}</td>
<td>Home &gt; Dashboard You can view any component of the specified process template.</td>
</tr>
<tr>
<td>\texttt{db_cp_view_&lt;specific pt&gt;_&lt;specific cp&gt;}</td>
<td>Permissions: ---Business Process Portal Configuration: \texttt{Home &gt; Dashboard}</td>
<td>Home &gt; Dashboard You can view only the specified component of the specified process template.</td>
</tr>
</tbody>
</table>

Example
\texttt{db\_cp\_view\_any\_any}

Let us assume that the administrator "ebms" wants to grant the permission to a user "user2" to view any component of any process template. Also, to access the component, the user needs access to the Home > Dashboard menu option. The administrator grants the permission and access to the menu option using the User Details page.

The user can now login in Business Process Portal and click Home > Dashboard to open the Dashboard List/Dashboard page. As the user "user2" has permission, he/she can view any component of any process template.
Managing applications

This chapter explains how to use the Administration module of Business Process Portal to manage Business Process Server and BPM Workflow applications, and to publish and unpublish Business Process Server applications as Web services.

Business Process Server provides a series of user interfaces in the Applications menu under the Administration module of Business Process Portal that enables you to manage applications.

**Note:** You may also publish and install Business Process Server applications using BPServerAdmin, a command-oriented interface. Refer to the *BP Server Developer’s Guide* for a description of the most commonly used BPServerAdmin commands.

For details, see the following topics:

- Managing Business Process Server applications
- Suspending and resuming applications
- Versioning of Business Process Server applications
- Managing BPM Workflow applications

Managing Business Process Server applications

Once a user or application developer defines a process template in Business Process Studio, you, as a Business Process Server administrator, can publish and install the process template in the BP Server and load any associated rules into BPM Workflow.
In the Administration module, click **Applications > BP Server**, to view the **BP Server Applications** page.

**Figure 86: BPServer Application page**

In the BP Server application page, you can filter the application based on:

- **Ready to Install**: The application available for installation are listed in this page.
- **Installed**: The installed applications are listed in this page.
- **Suspended**: The suspended applications are listed.
- **Deprecated**: If you update any application with newer version, then the older deprecated applications are listed here.
The BP Server Applications page contains information on:

- **Application Name**: the name of the application. Business Process Server supports versioning for applications, where a new version can be installed on an existing application. In the case of a versioned application, this displays the name of the application of which the current process template is a version.

- **Version Name**: Displays the version name of the application.

- **Process Type**: Displays the process type.

- **Group Access**: Displays whether the group option is selected in Progress Developer Studio for OpenEdge. Indicates which group of users is allowed to view and execute this project. You can only specify one group in Progress Developer Studio for OpenEdge.

- **Category**: Displays the different type of projects as defined in Progress Developer Studio for OpenEdge.

- **Migrate ACL**: select this check box if you want to migrate permissions of another application with same application name to current application.

- **Rule**, indicating whether the application contains rules (Yes) or has none (No). If BPM Workflow is not running, then Business Process Server allows you to install or uninstall applications without rules, but BPM Workflow must be running if you want to install/uninstall applications that contain rules.

- **Installed Date**: Displays the installed date and time of the application.

### Installing Business Process Server applications

At run time when an application is installed, Business Process Server copies the `<Application Server>\ebmsapps` folder to the Web application directory to make its Web pages, JSPs, images, etc. available for an application server to use (paths to the `ebmsapps` folder vary according to the application server you are using; in JBoss, for example, the path is `%OEBPS_HOME%\webapps\deploy\sbm.war\ebmsapps`). Once an application is uninstalled, the application specific directory is removed.

**Note:** Before you install an application available to a specified group, make sure that the group exists in the current Business Process Server user management system.

#### To install one or more Business Process Server applications:

1. In the Administration module, click **Applications > BP Server Applications**, to view the BP Server Applications page.
   Refer **Figure 86** on page 210.

2. Select **Ready to Install** option. The applications which are available for installation are listed in this page.

3. Select the Business Process Server application you wish to install from the list by selecting it, and click **Install**. The selected applications are installed.
   For more details about this operation, see **Selecting and clearing rows** on page 35.
   You select a parent name when you install a new version over an existing version.
Chapter 22: Managing applications

**Note:** You may also install and uninstall applications in OpenEdge. Select **Project > Publish** from the OpenEdge menu bar and provide the user name and password. For more information, see the *OpenEdge Getting Started: Developing BPM Applications with Developer Studio.*

### Viewing installed BP Server applications

**To view installed applications:**

1. In the Administration module, click **Applications > BP Server**, to view the **BP Server Applications** page.
   
   Refer Figure 86 on page 210.

2. Select **Installed** option. The installed applications are listed in this page.

   **Figure 87: Installed Applications**

3.  
4. Optionally, to uninstall, select the Business Process Server applications you need to uninstall from the list, and click **Uninstall**. The confirmation message box appears.

5. Optionally, select **Force Uninstall** to remove any active or suspended process instances.

   When you uninstall an application, Business Process Server removes the process template and unloads the rules from BPM Workflow. The application specific directory is removed.

6. To refresh an application, click **Refresh** button for the application for which you need to refresh.

7. To publish an application, click the Publish next to the application. Refer **Publishing Business Process Server applications as Web Services** on page 214 for more information.

Business Process Server uninstalls the selected application(s).

**Note:** If you have OpenEdge database, then it is recommended to have a period of 3 minutes between uninstalling an application and installing an application with the same name again. If the install operation is done within 3 minutes of 'uninstall' operation or if you try to perform reinstall operation from Progress Developer Studio for OpenEdge, then you may see errors in bpmprocessstore.log file for processing 'P_INSTALLED' event. Please ignore these errors as after few minutes BPM Process Store can recover from such errors.
Suspending and resuming applications

You may want to suspend an application if, for example, you are phasing out an outdated application, Application1, and installing a new application, Application2. By suspending Application1, you enable its existing process instances to remain for users to complete uninterrupted, while only new process instances may be started in Applications2. You may also resume a suspended application if, for example, you made changes to the template of Application1 and you would like to resume the application.

You may also suspend and resume applications (also referred to as process templates) in BP Server Admin. Refer to the *BP Server Developer’s Guide* for a description of these BP Server commands.

**Note:** You can suspend and resume installed applications only.

Suspending installed Business Process Server applications

To suspend one or more Business Process Server applications:

1. In the Administration module, click **Applications > BP Server**, to view the **BP Server Applications** page.
   Refer Figure 86 on page 210.
2. Select **Installed** option. The installed applications are listed in this page.
3. Select the Business Process Server application you wish to suspend from the list by selecting it, and click **Suspend**.
   For more details about this operation, see Selecting and clearing rows on page 35.

Business Process Server suspends the selected application(s).

Resuming suspended applications

Only suspended applications can be resumed.

To resume one or more suspended applications, complete the following steps:

1. In the Administration module, click **Applications > BP Server**, to view the **BP Server Applications** page.
   Refer Figure 86 on page 210.
2. Select **Suspended** option. It lists the suspended applications.
3. Select the suspended Business Process Server application you wish to resume from the list by selecting it, and click **Resume**.
   For more details about this operation, see Selecting and clearing rows on page 35.

Business Process Server resumes the suspended application(s).
Publishing Business Process Server applications as Web Services


Note: You cannot publish more than one applications simultaneously.

To publish Business Process Server applications as Web Services:

1. In the Administration module, click Applications > BP Server, to view the BP Server Applications page.

Refer Figure 86 on page 210.

2. Select Installed option. The applications which are installed are listed in this page.

3. Click the Publish icon next to the Business Process Server application you need to publish as a Web service.

The Publish Application page is displayed.

Figure 88: Publish application page

4. Select the activities (service operations) you want to publish. Optionally, enter a service description. Click Publish.

Business Process Server publishes the selected application as a Web Service.

Unpublishing Business Process Server application Web Services

To unpublish a Business Process Server Web Services application, complete the following steps:

1. In the Administration module, click Applications > BP Server, to view the BP Server Applications page.
Refer Figure 86 on page 210.

2. Select Installed option. The applications which are installed are listed in this page.

3. Select the Unpublish icon next to Business Process Server application, and click UnPublish icon.

Business Process Server unpublishes the selected published application(s).

Versioning of Business Process Server applications

You can create a new version of an existing Business Process Server application using Progress Developer Studio for OpenEdge. Versioning is helpful where your existing process template is deprecated, and the modified process template is installed with the same application name. While installing a new version of a process template from the BP Server Applications page in Business Process Portal, you can select the Migrate ACL checkbox to migrate the permissions of the existing process template to the new process template. If a similar change is required again, then you can install another new version, and deprecate all the other versions. Whenever you must work on any deprecated version, you must uninstall the versions created after that. For more information about creating versions, see the OpenEdge Getting Started: Developing BPM Applications with Developer Studio.

You can remove the previous version, which is deprecated, only when all the existing instances of the deprecated application are completed. If you remove the latest (active) version, then there will not be any active version. You can manually activate the process template deprecated immediately before the latest version or install a new process template as an active version.

Versioning does not allow you to activate multiple versions simultaneously.

You can view the old versions of Business Process Server applications by selecting the Deprecated option in Business Process Server applications page.

**Note:** If you try to resume a deprecated application, without uninstalling its previous version, then an exception will be thrown in bpmportal.log file.

Managing BPM Workflow applications

The flow of a BPM Workflow process (the presentation flow) is developed with Progress Developer Studio for OpenEdge. Business Process Server application developers define the presentation flow for a BPM Workflow application, saving the process definition as a process template in XML. An entire BPM Workflow process can be contained in a single workstep in Progress Developer Studio for OpenEdge.

As a Business Process Server administrator, you are responsible for installing and otherwise managing BPM Workflow applications. You must also know which BPM Workflow applications are being used as worksteps in Business Process Server processes so that you can install them and they are available to Business Process Server users. BPM Workflow is transparent to Business Process Server end users, who use the Home module as a client of BPM Workflow.
Installing BPM Workflow applications

To install one or more BPM Workflow applications:

1. In the Administration module, click Applications > BPM Workflow, to view the BPM Workflow Applications page.

This page displays all current BPM Workflow applications, as shown in the following figure.

Figure 89: Installing BPM Workflow applications

2. Select a status from the Status drop-down list and click Go to display only the applications having the selected status.

The BPM Workflow Applications page contains information on:

- **Status**, indicating the current status of the application. Options include Installed, and Uninstalled.
- **Name**, or the name assigned by the developer when defining the process template in OpenEdge.
- **Label**, or the name users see in Business Process Portal. The developer defines this name as the Label when designing the process template in OpenEdge.
- **Description**, providing a brief description of the application. If required, then you can define the description as a text link to a lengthier, more detailed description.

3. Select the BPM Workflow application you wish to install from the list by selecting it, and click Install. For more details about this operation, see Selecting and clearing rows on page 35.

Business Process Server installs the selected BPM Workflow application(s).

**Note:** You may also install and uninstall BPM Workflow applications in OpenEdge. Select Project > Publish from the Servers view in Progress Developer Studio for OpenEdge. For more information, see the OpenEdge Getting Started: Developing BPM Applications with Developer Studio.

Once a BPM Workflow application is installed, the workflow becomes one of two processes: a workstep within a BPM Workflow process.
Uninstalling BPM Workflow applications

To uninstall a BPM Workflow application, complete the following steps:

1. Perform steps 1 and 2 outlined in Installing BPM Workflow applications on page 216.
2. Select the BPM Workflow application you wish to uninstall from the list by selecting it, and click Uninstall.

   For more details about this operation, see Selecting and clearing rows on page 35.

Business Process Server uninstalls the selected BPM Workflow application(s).
Migrating instances

This chapter explains how to migrate instances of one application as the instances of another application by using the Business Process Portal interface and the migration utility.

In a dynamic organization, processes continuously undergo change. The cost of ownership of processes can be significantly affected when changes are not promptly applied to running instances of processes. The "Instance Migration" feature of Business Process Portal can help reduce the cost of ownership of processes by allowing for bulk migration of instances of processes from one application to another.

For example, you have few instances of application "Application". Then you created another application with name "Application_version1". You can use the instance migration feature to migrate the existing instances of application "Application" as the instances of new application "Application_version1". After migrating an instance the source instance is suspended. The name of the migrated instance has the following nomenclature:

<source_instance_name>#IM#<target_instance_id>

Business Process Portal and the instancemigration utility, both generate appropriate entries in the pim.log file.

Note: The current version of Business Process Server does not support instance migration to a target application which is in a deprecated state.

When you migrate the instances in which worksteps that are mapped to worksteps of target application are in the different state, how it works:

Active state — For worksteps in active state, in Business Process Server as well as in BPM Process Store workstep tables an equivalent record gets created for the mapped workstep from target process template. If such a workstep is human activity workstep, then it is reactivated, so that, if performer of the mapped workstep has been changed in target Process Template, then new workitems are created for the latest performer(s).
Inactive state — If the workstep is not activated then no records are created in Business Process Server and BPM Workflow workstep tables.

Completed state — For worksteps in completed state, for Business Process Server as well as BPM Process Store workstep tables an equivalent record gets created for the mapped workstep from the target process template.

For details, see the following topics:

- Using Business Process Portal interface
- Using the migration utility

Using Business Process Portal interface

You can migrate instances by using the Administration module of Business Process Portal.

Broad steps of the instance migration process are:

- Defining Migration Map(s)
- Defining Instance Filter(s)
- Migrating Instances

Defining an instance filter is an optional step. After defining a migration map, you may migrate instances without using the instance filter.

Defining a migration map

In order to define instance migration, you must define migration map, without this, it is not possible to migrate instances.

To define a migration map:

1. In the Administration module, click Applications > BP Server, to view the BP Server Applications page.
   This page displays all current Business Process Server applications, as shown in the Installing Business Process Server applications on page 211.
2. Click Migrate Instances to open the Migrate Instances page.
As shown in the following figure.

**Figure 90: Migrate instances page**

3. Click **Migration Map** to open the **Migration Map List** page.
   
   This page lists the currently defined migration maps. You can use filters to list only the maps satisfying your filter condition. You can delete one or more of the existing migration maps from this page.

**Figure 91: Migration map list page**

4. Click the **Add Migration Map** button to open the **Add Migration Map** page.
   
   a) In the General section, specify a name in the **Migration Map** text box.
   
   b) Select the source and target application from the respective drop-down lists.
   
   c) Click **Map Worksteps** tab.
Based on the selected source application and target application, the worksteps of same name and type gets mapped automatically and they are listed in the Map worksteps tab page. On the basis of your requirement, you can edit or delete or retain them.

**Note:** Only worksteps of same name and type are displayed, if nothing is matching, Map Workstep tab page will not display any mapped worksteps by default for the selected applications.

d) Click **Edit** to open the **Map Worksteps** page. This displays all the worksteps available for Source application and Target application.

As shown in the following figure.

**Figure 92: Map worksteps**

- To add a mapped workstep, select the source and target application workstep pairs to be included in your map and then click **Map>>**. If the selected worksteps are of the same type, then they get mapped. Click **Save** to save the mapped workstep.

- While mapping, only worksteps of same type can be mapped. If you select worksteps of different type, then you receive a message notifying that only worksteps of same type can be mapped.

  See Step Figure 95 for more information.

- Click **Reset**, to reset the Mapped workstep list.

- Click **Cancel** to close the **Mapped Worksteps** page.

- To delete a mapped workstep, select Mapped workstep you must remove and click **<<Remove** and then click **Save**.

  You can also delete a Mapped Workstep from the Mapped Workstep tab page. Select the mapped workstep, you must delete from the list displayed and then click **Remove**.
e) Click **Map Dataslots** tab.

Based on the selected source application and target application, the dataslots of same name type get mapped automatically and they are listed in the Map dataslots tab page. On the basis of your requirement, you can edit or delete or retain them.

**Note:** Only dataslots of same name and type are displayed, if nothing is matching, then Map Dataslots tab page will not display any mapped dataslots by default for the selected applications.

f) Click **Edit** to open the **Map Dataslots** page.

This displays all the dataslots available for Source application and Target application.

**Note:** It is possible to map dataslots, only if both the application contains dataslots of same type and size.

- To add a mapped dataslots, select the source and target application dataslots pairs to be included in your map and then click **Map>>**. If the selected dataslots are of the same type, then they get mapped. Click **Save** to save the mapped dataslot.

**Important:** While mapping, only dataslots of same type can be mapped. If you select dataslots of different type, then you receive a message notifying that only dataslots of same type can be mapped.

See **Dataslot mapping** on page 224 for more information.

- Click **Reset**, to reset the Mapped dataslots list.
- Click **Cancel** to close the **Mapped Dataslots** page.
- To delete mapped dataslots, select Mapped dataslots you need to remove and click **<<Remove** and then click **Save**.

You can also delete a Mapped dataslots from the Mapped Dataslots tab page. Select the mapped dataslots, you must delete from the list displayed and then click **Remove**.

5. Click **Save** to save the migration map definition.

**Rules and restrictions for mapping**

To successfully migrate process instances, you need to define the migration maps considering the rules and restrictions applicable for the dataslot and workstep mapping.
Dataslot mapping

The following rules and restrictions apply to dataslot mapping:

• The default rule is that, a dataslot from the source process template can be mapped to another dataslot from the target process template only when both the dataslots are of same type (for example, INTEGER to INTEGER, CHARACTER to CHARACTER).

• An object dataslot of a source process template can be mapped to another object dataslot of the target process template only when both the object dataslots hold objects of the same java class.

Note: In migration map utility, you cannot differentiate whether the dataslot object is a
• Business object or normal object
• Date time or Date only
• String or multiline

Only major types of dataslots are displayed in the Type box.

• Dataslot size changes are supported only for CHARACTER. Migration tool allows the size changes only when target dataslot size is larger than the source dataslot size.

• In the case of DECIMAL dataslot, the source and target dataslots must be identical in Scale and precision.

• Source dataslot of type INT64 can only be mapped to target dataslot of type INT64.

• Source dataslot of type ‘Global’ can only be mapped to target dataslot of type ‘Global’.

Workstep mapping

The following rules and restrictions apply to workstep mapping:

• The default rule is that, a workstep from the source process template can be mapped to another workstep from the target process template only if both are of the same type (for example, Activity to Activity, Subprocess to Subprocess).

• Unmapped worksteps of the source process template are assumed to be removed from the target process template.

• Unmapped worksteps in the target process template are assumed to be newly added worksteps of the target process template.

• No new rollback points can be added in the target process template. The source and target process template should have same number of rollback points. Note that if you add or remove a workstep from the already executed path of the source process instance, then the result of a rollback in the target process instance may not be as expected.

Defining an instance filter

Instance filter helps to filter certain instances and migrate based on those instances.
You can define instance filters to help you list only the instances that satisfy specific condition(s). These instance filters can be created either by defining new ones or by copying an existing one. You can define instance filters from the Instance Filter List. To open this page, follow step 1 and 2 explained in the Defining a migration map on page 220, and then click the Instance Filter.

**Figure 93: Instance filter list page**

![Instance filter list page](image)

The procedures to add, copy, modify and delete instance filters are same as those followed for task filters.

**Important:** In Instance migration filter, you can select worksteps as well as dataslots for filtering. Note that, for task filters you can create only dataslot filters.

For more information about adding, modifying and deleting task filters, see Chapter 12, Setting Preferences in the Business Process Portal User's Guide.

**Note:** The current version of Business Process Server does not support filtering of suspended workstep(s).

## Migrating instances

**To migrate an instance, complete the following steps:**

1. In the Administration module, click Applications > BP Server, to view the BP Server Applications page.
   
   This page displays all current Business Process Server applications, as shown in the Installing Business Process Server applications on page 211.

2. Click Migrate Instances to open the Migrate Instances page.

3. Select the source application whose instances you want to migrate from the Source Application drop-down list.

4. Select the target application to which you want to migrate the selected instances from the Target Application drop-down list. Click Go.
5. Select the migration map to be used from the **Migration Map** drop-down list. Optionally, select the instance filter to be used from the **Instance Filter** drop-down list. Click **Go**.

Business Process Portal lists all the instances satisfying the filter conditions specified in the previous and this step.

**Figure 94: Migrate instances page**

6. Select the instances that you want to migrate from the table. For more information, see Selecting and clearing rows on page 35.

7. Click **Migrate**. Business Process Portal migrates all the selected instances, using the specified migration map.

**Viewing migration map’s execution history**

To view the execution history of a migration map, complete the following steps:

1. Perform steps 1 through 3 outlined in Defining a migration map on page 220.
2. On the **Migration Map List** page, in the Execution History column, click the **View** link for the appropriate row to open the **Execution History for Migration Map** window.
This window shows the details of the migration map and its usage history.

### Figure 95: Execution History for Migration Map window

<table>
<thead>
<tr>
<th>No.</th>
<th>Date Instances Migrated</th>
<th>No. of Instances Migrated</th>
<th>Migrated by</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sep 26, 2008 12:37 PM</td>
<td>2</td>
<td>returns</td>
</tr>
</tbody>
</table>

3. Click **Close this Window** to close the window and go back to the **Migration Map List** page.

---

## Using the migration utility

Business Process Server provides the following command line utilities to migrate process instances and undo this operation.

### instancemigration

You can also perform instance migration by using a standalone command line utility `instancemigration.cmd/sh` from the `OEBPS_HOME\bin` directory.

#### Usage:

```
instancemigration.cmd/.sh -u <user_name> -p <password> -mapname <map_name> [-filtername <filter_name>] [-pid <process_instance_id>]
```

The following table describes these options:

### Table 58: Instancemigration Utility Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>-u user_name</td>
<td>The user name of the user performing instance migration.</td>
</tr>
<tr>
<td>-p password</td>
<td>Password of the user performing instance migration.</td>
</tr>
<tr>
<td>-mapname</td>
<td>Name of the map.</td>
</tr>
</tbody>
</table>
UseOption

Name of the filter.:filtername

Process instance ID of the instance to be migrated. This is an optional parameter. If you do not specify any process instance ID, then all process instances satisfying the migration map and instance filter condition are migrated.

-pid

Note: The current version of Business Process Server does not support filtering of suspended workstep(s).

undoinstancemigration

You can undo instance migration and re-migrate the instances in the reverse direction, that is, from the target application to the source application using the undoinstancemigration utility.

Usage:

undomigration.cmd/.sh -u <user_name> -p <password> -migid <migration_id> [-pid <source_process_instance_id>]

The following table describes these options:

Table 59: undoinstancemigration utility options

<table>
<thead>
<tr>
<th>Option</th>
<th>Use</th>
</tr>
</thead>
<tbody>
<tr>
<td>-u user_name</td>
<td>The user name of the user performing undo instance migration operation.</td>
</tr>
<tr>
<td>-p password</td>
<td>Password of the user performing undo instance migration operation.</td>
</tr>
<tr>
<td>-migid migration_id</td>
<td>The migration ID generated while performing the instance migration operation. You can get this ID from the pim.log file.</td>
</tr>
<tr>
<td>-pid source_process_instance_id</td>
<td>Process instance ID of the source instance that was migrated.</td>
</tr>
</tbody>
</table>
Third-party acknowledgments

One or more products in the Progress OpenEdge v11.3 release includes third party components covered by licenses that require that the following documentation notices be provided:
Progress OpenEdge v11.3 may incorporate ANT v1.5.4. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1, applies to all versions of up to ant 1.6.0 included. The Apache Software License, Version 1.1 - Copyright (C) 2000-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.
4. The names "Ant" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.
5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>. 

Appendix A: Third-party acknowledgments
Progress OpenEdge v11.3 may incorporate Apache Avalon 2002/08/06, Apache Batik v1.1, Apache Jakarta POI v1.1, Apache POI 2003/05/14, Regexp (Pure Java Regular Expression) v1.2, and XMLTask v1.15.1 from The Apache Software Foundation. Such technologies are subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 2000 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: “This product includes software developed by the Apache Software Foundation (http://www.apache.org/).” Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.
4. The names “Apache” and “Apache Software Foundation” must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.
5. Products derived from this software may not be called “Apache”, nor may “Apache” appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>. Portions of this software are based upon public domain software originally written at the National Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.
Progress OpenEdge v11.3 may incorporate Apache JAXP v1.3.04 from The Apache Software Foundation. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xalan" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, Lotus Development Corporation., http://www.lotus.com. For more information on the Apache Software Foundation, please see http://www.apache.org/.
Progress OpenEdge v11.3 may incorporate Crimson v1.1.3 from Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999-2003 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., http://www.ibm.com. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate jfor v0.7.2 from jfor. Such technology is subject to the following terms and conditions: jfor Apache-Style Software License. Copyright (c) 2002 by the jfor project. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the jfor project (http://www.jfor.org)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The name "jfor" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact info@jfor.org. 5. Products derived from this software may not be called "jfor", nor may "jfor" appear in their name, without prior written permission of info@jfor.org. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE JFOR PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Apache LogKit v1.2 from The Apache Software
Foundation. Such technologies are subject to the following terms and conditions:
The Apache Software License, Version 1.1 -- Copyright (C) 1997-2003 The Apache Software Foundation. All
rights reserved. Redistribution and use in source and binary forms, with or without modification,
are permitted provided that the following conditions are met: 1. Redistributions of source code
must retain the above copyright notice, this list of conditions and the following disclaimer. 2.
Redistributions in binary form must reproduce the above copyright notice, this list of conditions
and the following disclaimer in the documentation and/or other materials provided with the
distribution. 3. The end-user documentation included with the redistribution, if any, must include
the following acknowledgment: "This product includes software developed by the Apache Software
Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software
itself, if and wherever such third-party acknowledgments normally appear. 4. The names "LogKit",
"Jakarta" and "Apache Software Foundation" must not be used to endorse or promote products
derived from this software without prior written permission. For written permission, please contact
apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may
"Apache" appear in their name, without prior written permission of the Apache Software Foundation.
THIS SOFTWARE IS PROVIDED ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT,
INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF
THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software
consists of voluntary contributions made by many individuals on behalf of the Apache Software
Foundation. For more information on the Apache Software Foundation, please see
Progress OpenEdge v11.3 may incorporate Xerces for Java XML Parser v2.6.2. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1 Copyright (c) 1999 The Apache Software Foundation. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Xerces" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org. 5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation and was originally based on software copyright (c) 1999, International Business Machines, Inc., http://www.ibm.com. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate SOAP v2.3.1 from Apache Foundation. Such technology is subject to the following terms and conditions: The Apache Software License, Version 1.1

Copyright (c) 1999 The Apache Software Foundation. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: "This product includes software developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "SOAP" and "Apache Software Foundation" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact apache@apache.org.

5. Products derived from this software may not be called "Apache", nor may "Apache" appear in their name, without prior written permission of the Apache Software Foundation.
THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software Foundation. For more information on the Apache Software Foundation, please see <http://www.apache.org/>.

Progress OpenEdge v11.3 may incorporate ANTLR (Another Tool for Language Recognition) v2.7.6. Such technology is subject to the following terms and conditions: ANTLR 3 License [The BSD License] Copyright (c) 2003-2006, Terence Parr All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the author nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Castor v0.9.3 from castor.org. Such technology is subject to the following terms and conditions: Original Intalio license - Copyright 1999-2004 (C) Intalio Inc., and others. All Rights Reserved. Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The name "ExoLab" must not be used to endorse or promote products derived from this Software without prior written permission of Intalio Inc. For written permission, please contact info@exolab.org. 4. Products derived from this Software may not be called "Castor" nor may "Castor" appear in their names without prior written permission of Intalio Inc. Exolab, Castor and Intalio are trademarks of Intalio Inc. 5. Due credit should be given to the ExoLab Project (http://www.exolab.org/). THIS SOFTWARE IS PROVIDED BY INTALIO AND CONTRIBUTORS "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL INTALIO OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Decimal Conversion Code (dtoa.c; g_fmt.c; rnd_prod.s; dectrod.c; dectrotf.c; dmisc.c; gdtoa.c; gdtoa.h; gdtoaimp.h; gethex.c; gmisc.c; hd_init.c; misc.c; smisc.c; strtdg.c; strtd.get; sum.c; ulp.c). Such technologies are subject to the following terms and conditions: dtoa.c License: The author of this software is David M. Gay. Copyright (c) 1991, 2000, 2001 by Lucent Technologies. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. g_fmt.c License: The author of this software is David M. Gay. Copyright (c) 1991, 1996 by Lucent Technologies. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.
Appendix A: Third-party acknowledgments

rnd_prod.s License: The author of this software is David M. Gay. Copyright (c) 1991 by Lucent Technologies. Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the supporting documentation for such software. THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, NEITHER THE AUTHOR NOR LUCENT MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

decstrtd.c License: The author of this software is David M. Gay. Copyright (C) 1998-2001 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

decstrtof.c License: The author of this software is David M. Gay. Copyright (C) 1998, 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

dmisc.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

dgtoa.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES
OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gdtoa.h License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gdtoaimp.h License: The author of this software is David M. Gay. Copyright (C) 1998-2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gethex.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. gmisc.c License: The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. hd_init.c License: The author of this software is David M. Gay. Copyright (C) 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

misc.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

smisc.c License: The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. 

strtodg.c License: The author of this software is David M. Gay. Copyright (C) 1998-2001 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission.
LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

**strtord.c License:** The author of this software is David M. Gay. Copyright (C) 1998, 2000 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

**sum.c License:** The author of this software is David M. Gay. Copyright (C) 1998 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

**ulp.c License:** The author of this software is David M. Gay. Copyright (C) 1998, 1999 by Lucent Technologies All Rights Reserved Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both that the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the name of Lucent or any of its entities not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. LUCENT DISCLAIMS ALL WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL LUCENT OR ANY OF ITS ENTITIES BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.
Progress OpenEdge v11.3 may incorporate DOM4J v1.6.1 from MetaStuff, Ltd. Such technology is subject to the following terms and conditions: Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved. Redistribution and use of this software and associated documentation ("Software"), with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain copyright statements and notices. Redistributions must also contain a copy of this document. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The name "DOM4J" must not be used to endorse or promote products derived from this Software without prior written permission of MetaStuff, Ltd. For written permission, please contact dom4j-info@metastuff.com. 4. Products derived from this Software may not be called "DOM4J" nor may "DOM4J" appear in their names without prior written permission of MetaStuff, Ltd. DOM4J is a registered trademark of MetaStuff, Ltd. 5. Due credit should be given to the DOM4J Project - http://www.dom4j.org THIS SOFTWARE IS PROVIDED BY METASTUFF, LTD. AND CONTRIBUTORS "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL METASTUFF, LTD. OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate GraphicsMagick v1.3.14 from GraphicsMagick Group. Such technology is subject to the following terms and conditions:

.. This text is in reStucturedText format, so it may look a bit odd. .. See http://docutils.sourceforge.net/rst.html for details.

======================================
GraphicsMagick Copyrights and Licenses
======================================

This file is part of the GraphicsMagick software distributed by the GraphicsMagick Group.

[*Please note that the legal community considers 15 or more total lines of code or text (not necessarily contiguous) to be significant for the purposes of copyright. Repeated changes such as renaming a symbol has similar significance to changing one line of code.*]

The licenses which components of this software fall under are as follows.

1) In November 2002, the GraphicsMagick Group created GraphicsMagick from ImageMagick Studio's ImageMagick and applied the "MIT" style license: Copyright (C) 2002 - 2012 GraphicsMagick Group
Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

2) In October 1999, ImageMagick Studio assumed the responsibility for the development of ImageMagick (forking from the distribution by E. I. du Pont de Nemours and Company) and applied a new license:

Copyright (C) 2002 ImageMagick Studio, a non-profit organization dedicated to making software imaging solutions freely available.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files ("ImageMagick"), to deal in ImageMagick without restriction, including without limitation
the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of ImageMagick, and to permit persons to whom the ImageMagick is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of ImageMagick.

The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement. In no event shall ImageMagick Studio be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with ImageMagick or the use or other dealings in ImageMagick.

Except as contained in this notice, the name of the ImageMagick Studio shall not be used in advertising or otherwise to promote the sale, use or other dealings in ImageMagick without prior written authorization from the ImageMagick Studio.

3) From 1991 to October 1999 (through ImageMagick 4.2.9), ImageMagick was developed and distributed by E. I. du Pont de Nemours and Company: Copyright 1999 E. I. du Pont de Nemours and Company

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files ("ImageMagick"), to deal in ImageMagick without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of ImageMagick, and to permit persons to whom the ImageMagick is furnished to do so, subject to the following conditions:
The above copyright notice and this permission notice shall be included in all copies or substantial portions of ImageMagick.

The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.

In no event shall E. I. du Pont de Nemours and Company be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with ImageMagick or the use or other dealings in ImageMagick.
Except as contained in this notice, the name of the E. I. du Pont de Nemours and Company shall not be used in advertising or otherwise to promote the sale, use or other dealings in ImageMagick without prior written authorization from the E. I. du Pont de Nemours and Company.

4) The GraphicsMagick Base64Decode() and Base64Encode() functions are based on source code obtained from OpenSSH. This source code is distributed under the following license: Copyright (c) 2000 Markus Friedl. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR \"AS IS\" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

5) Many of the pattern images in coders/logo.c are derived from XFig, which is distributed under the following license:

| FIG : Facility for Interactive Generation of figures
| Copyright (c) 1985-1988 by Supoj Sutanthavibul
| Parts Copyright (c) 1989-2000 by Brian V. Smith
| Parts Copyright (c) 1991 by Paul King

Any party obtaining a copy of these files is granted, free of charge, a full and unrestricted irrevocable, world-wide, paid up, royalty-free, nonexclusive right and license to deal in this software and documentation files (the "Software"), including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons who receive copies from any such party to do so, with the only requirement being that this copyright notice remain intact.

6) The documentation for the composition operators is copied from the rlecomp manual page, which is authored by Rod Bogart and John W. Peterson. Rlecomp is part of the Utah Raster Toolkit distributed by the University of Michigan and the University of Utah. The copyright for this manual page is as follows: Copyright (c) 1986, University of Utah

This software is copyrighted as noted below. It may be freely copied, modified, and redistributed, provided that the copyright notice is preserved on all copies.

There is no warranty or other guarantee of fitness for this software, it is provided solely "as is". Bug reports or fixes may be sent to the author, who may or may not act on them as he desires.

You may not include this software in a program or other software product without supplying the source, or without informing the end-user that the source is available for no extra charge.

If you modify this software, you should include a notice giving the name of the person performing the modification, the date of modification, and the reason for such modification.

7) The source code comprising swab.c is originally derived from libtiff which has the following license:
Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

8) The C++ API known as "Magick++", and which resides in the Magick++ directory, is distributed under the following license: Copyright 1999 - 2003 Bob Friesenhahn <bfriesen@simple.dallas.tx.us>

Permission is hereby granted, free of charge, to any person obtaining a copy of the source files and associated documentation files ("Magick++"), to deal in Magick++ without restriction, including without limitation of the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of Magick++, and to permit persons to whom the Magick++ is furnished to do so, subject to the following conditions:

This copyright notice shall be included in all copies or substantial portions of Magick++. The copyright to Magick++ is retained by its author and shall not be subsumed or replaced by any other copyright.

The software is provided "as is", without warranty of any kind, express or implied, including but not limited to the warranties of merchantability, fitness for a particular purpose and noninfringement. In no event shall Bob Friesenhahn be liable for any claim, damages or other liability, whether in an action of contract, tort or otherwise, arising from, out of or in connection with Magick++ or the use or other dealings in Magick++.

9) The GraphicsMagick HaldClutImagePixels() function in magick/hclut.c is based on source code from the HaldCLUT package by Eskil Steenberg (http://www.quelsolaar.com/technology/clut.html) which is distributed under the following license: Copyright (c) 2005 Eskil Steenberg. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

10) GraphicsMagick makes use of third-party "delegate" libraries to support certain optional features. These libraries bear their own copyrights and licenses, which may be more or less restrictive than the GraphicsMagick license. For convenience, when GraphicsMagick is bundled with (or compiled with) "delegate" libraries, a copy of the licenses for these libraries is provided in a "licenses" directory.
In order to support file conversion and viewing software, we have included considerable functionality beyond the bare JPEG coding/decoding capability; for example, the color quantization modules are not strictly part of JPEG decoding, but they are essential for output to colormapped file formats or colormapped displays. These extra functions can be compiled out of the library if not required for a particular application. We have also included "jpegtran", a utility for lossless transcoding between different JPEG processes, and "rdjpgcom" and "wrjpgcom", two simple applications for inserting and extracting textual comments in JFIF files.

The emphasis in designing this software has been on achieving portability and flexibility, while also making it fast enough to be useful. In particular, the software is not intended to be read as a tutorial on JPEG. (See the REFERENCES section for introductory material.) Rather, it is intended to be reliable, portable, industrial-strength code. We do not claim to have achieved that goal in every aspect of the software, but we strive for it.

We welcome the use of this software as a component of commercial products.

No royalty is required, but we do ask for an acknowledgement in product documentation, as described under LEGAL ISSUES.

LEGAL ISSUES

In plain English:

1. We don't promise that this software works. (But if you find any bugs, please let us know!)

2. You can use this software for whatever you want. You don't have to pay us.

3. You may not pretend that you wrote this software. If you use it in a program, you must acknowledge somewhere in your documentation that you've used the IJG code.

In legalese:

The authors make NO WARRANTY or representation, either express or implied, with respect to this software, its quality, accuracy, merchantability, or fitness for a particular purpose. This software is provided "AS IS", and you, its user, assume the entire risk as to its quality and accuracy.

This software is copyright (C) 1991-1998, Thomas G. Lane.

All Rights Reserved except as specified below.

Permission is hereby granted to use, copy, modify, and distribute this software (or portions thereof) for any purpose, without fee, subject to these conditions:

(1) If any part of the source code for this software is distributed, then this README file must be included, with this copyright and no-warranty notice unaltered; and any additions, deletions, or changes to the original files must be clearly indicated in accompanying documentation.

(2) If only executable code is distributed, then the accompanying documentation must state that "this software is based in part on the work of the Independent JPEG Group".

(3) Permission for use of this software is granted only if the user accepts full responsibility for any undesirable consequences; the authors accept NO LIABILITY for damages of any kind.

These conditions apply to any software derived from or based on the IJG code, not just to the unmodified library. If you use our work, you ought to acknowledge us.

Permission is NOT granted for the use of any IJG author's name or company name in advertising or publicity relating to this software or products derived from it. This software may be referred to only as "the Independent JPEG Group's software".

We specifically permit and encourage the use of this software as the basis of commercial products, provided that all warranty or liability claims are assumed by the product vendor.

ansi2knr.c is included in this distribution by permission of L. Peter Deutsch, sole proprietor of its copyright holder, Aladdin Enterprises of Menlo Park, CA.
ansi2knr.c is NOT covered by the above copyright and conditions, but instead by the usual distribution terms of the Free Software Foundation; principally, that you must include source code if you redistribute it. (See the file ansi2knr.c for full details.) However, since ansi2knr.c is not needed as part of any program generated from the IJG code, this does not limit you more than the foregoing paragraphs do.

The Unix configuration script "configure" was produced with GNU Autoconf.

It is copyright by the Free Software Foundation but is freely distributable.

The same holds for its supporting scripts (config.guess, config.sub, ltconfig, ltmain.sh). Another support script, install-sh, is copyright by M.I.T. but is also freely distributable.

It appears that the arithmetic coding option of the JPEG spec is covered by patents owned by IBM, AT&T, and Mitsubishi. Hence arithmetic coding cannot legally be used without obtaining one or more licenses. For this reason, support for arithmetic coding has been removed from the free JPEG software. (Since arithmetic coding provides only a marginal gain over the unpatented Huffman mode, it is unlikely that very many implementations will support it.)

So far as we are aware, there are no patent restrictions on the remaining code.

The IJG distribution formerly included code to read and write GIF files.

To avoid entanglement with the Unisys LZW patent, GIF reading support has been removed altogether, and the GIF writer has been simplified to produce "uncompressed GIFs". This technique does not use the LZW algorithm; the resulting GIF files are larger than usual, but are readable by all standard GIF decoders.

We are required to state that "The Graphics Interchange Format(c) is the Copyright property of CompuServe Incorporated. GIF(sm) is a Service Mark property of CompuServe Incorporated."

Contents of png.txt file (from GraphicsMagick):

This copy of the libpng notices is provided for your convenience. In case of any discrepancy between this copy and the notices in the file png.h that is included in the libpng distribution, the latter shall prevail.

COPYRIGHT NOTICE, DISCLAIMER, and LICENSE:

If you modify libpng you may insert additional notices immediately following this sentence. libpng versions 1.0.7, July 1, 2000, through 1.2.0, September 1, 2001, are Copyright (c) 2000 Glenn Randers-Pehrson and are distributed according to the same disclaimer and license as libpng-1.0.6 with the following individuals added to the list of Contributing Authors

Simon-Pierre Cadieux
Eric S. Raymond
Gilles Vollant

and with the following additions to the disclaimer:

There is no warranty against interference with your enjoyment of the library or against infringement. There is no warranty that our efforts or the library will fulfill any of your particular purposes or needs. This library is provided with all faults, and the entire risk of satisfactory quality, performance, accuracy, and effort is with the user.

libpng versions 0.97, January 1998, through 1.0.6, March 20, 2000, are Copyright (c) 1998, 1999 Glenn Randers-Pehrson, and are distributed according to the same disclaimer and license as libpng-0.96, with the following individuals added to the list of Contributing Authors:

Tom Lane
Glenn Randers-Pehrson
Willem van Schaik
libpng versions 0.89, June 1996, through 0.96, May 1997, are Copyright (c) 1996, 1997 Andreas Dilger

Distributed according to the same disclaimer and license as libpng-0.88, with the following individuals added to the list of Contributing Authors:

John Bowler
Kevin Bracey
Sam Bushell
Magnus Holmgren
Greg Roelofs
Tom Tanner

libpng versions 0.5, May 1995, through 0.88, January 1996, are Copyright (c) 1995, 1996 Guy Eric Schalnat, Group 42, Inc. For the purposes of this copyright and license, "Contributing Authors" is defined as the following set of individuals:

Andreas Dilger
Dave Martindale
Guy Eric Schalnat
Paul Schmidt
Tim Wegner

The PNG Reference Library is supplied "AS IS". The Contributing Authors and Group 42, Inc. disclaim all warranties, expressed or implied, including, without limitation, the warranties of merchantability and of fitness for any purpose. The Contributing Authors and Group 42, Inc. assume no liability for direct, indirect, incidental, special, exemplary, or consequential damages, which may result from the use of the PNG Reference Library, even if advised of the possibility of such damage. Permission is hereby granted to use, copy, modify, and distribute this source code, or portions hereof, for any purpose, without fee, subject to the following restrictions:

1. The origin of this source code must not be misrepresented.
2. Altered versions must be plainly marked as such and must not be misrepresented as being the original source.
3. This Copyright notice may not be removed or altered from any source or altered source distribution. The Contributing Authors and Group 42, Inc. specifically permit, without fee, and encourage the use of this source code as a component to supporting the PNG file format in commercial products. If you use this source code in a product, acknowledgment is not required but would be appreciated.

A "png_get_copyright" function is available, for convenient use in "about" boxes and the like: printf("%s",png_get_copyright(NULL));

Also, the PNG logo (in PNG format, of course) is supplied in the files "pngbar.png" and "pngbar.jpg (88x31) and "pngnow.png" (98x31).

Libpng is OSI Certified Open Source Software. OSI Certified Open Source is a certification mark of the Open Source Initiative.

Glenn Randers-Pehrson
randeg@alum.rpi.edu

September 1, 2001
Appendix A: Third-party acknowledgments

Contents of tiff.txt file (from GraphicsMagick):
Copyright (c) 1988-1997 Sam Leffler
Copyright (c) 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and its documentation for any purpose is hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

Contents of zlib.txt file (from GraphicsMagick):

zlib 1.1.3 is a general purpose data compression library. All the code is thread safe. The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), rfc1951.txt (deflate format) and rfc1952.txt (gzip format). These documents are also available in other formats from ftp://ftp.uu.net/graphics/png/documents/zlib/zdoc-index.html

All functions of the compression library are documented in the file zlib.h (volunteer to write man pages welcome, contact jloup@gzip.org). A usage example of the library is given in the file example.c which also tests that the library is working correctly. Another example is given in the file minigzip.c. The compression library itself is composed of all source files except example.c and minigzip.c.

To compile all files and run the test program, follow the instructions given at the top of Makefile. In short "make test; make install" should work for most machines. For Unix: "configure; make test; make install"

For MSDOS, use one of the special makefiles such as Makefile.msc.

For VMS, use Make_vms.com or descrip.mms.

Questions about zlib should be sent to <zlib@quest.jpl.nasa.gov>, or to Gilles Vollant <info@winimage.com> for the Windows DLL version.

The zlib home page is http://www.cdrom.com/pub/infozip/zlib/

The official zlib ftp site is ftp://ftp.cdrom.com/pub/infozip/zlib/

Before reporting a problem, please check those sites to verify that you have the latest version of zlib; otherwise get the latest version and check whether the problem still exists or not.

Mark Nelson <markn@tiny.com> wrote an article about zlib for the Jan. 1997 issue of Dr. Dobb's Journal; a copy of the article is available in http://web2.airmail.net/markn/articles/zlibtool/zlibtool.htm

The changes made in version 1.1.3 are documented in the file ChangeLog.

The main changes since 1.1.2 are:

- fix "an inflate input buffer bug that shows up on rare but persistent occasions" (Mark)
- fix gzread and gztell for concatenated .gz files (Didier Le Botlan)
- fix gzseek(...., SEEK_SET) in write mode
- fix crc check after a gseek (Frank Faubert)
- fix miniunzip when the last entry in a zip file is itself a zip file

(J Lilge)
- add contrib/asm586 and contrib/asm686 (Brian Raiter)
See http://www.muppetlabs.com/~breadbox/software/assembly.html
- add support for Delphi 3 in contrib/delphi (Bob Dellaca)
- add support for C++Builder 3 and Delphi 3 in contrib/delphi2 (Davide Moretti)
- do not exit prematurely in untgz if 0 at start of block (Magnus Holmgren)
- use macro EXTERN instead of extern to support DLL for BeOS (Sander Stoks)
- added a FAQ file

plus many changes for portability.

Unsupported third party contributions are provided in directory "contrib". A Java implementation of zlib is available in the Java Development Kit 1.1 http://www.javasoft.com/products/JDK/1.1/docs/api/Package-java.util.zip.html
See the zlib home page http://www.cdrom.com/pub/infozip/zlib/ for details.
A Perl interface to zlib written by Paul Marquess <pmarquess@bfsec.bt.co.uk> is in the CPAN (Comprehensive Perl Archive Network) sites, such as:
A Python interface to zlib written by A.M. Kuchling <amk@magnet.com> is available in Python 1.5 and later versions, see http://www.python.org/doc/lib/module-zlib.html
A zlib binding for TCL written by Andreas Kupries >a.kupries@westend.com> is available at
An experimental package to read and write files in .zip format, written on top of zlib by Gilles Vollant >info@winimage.com>, is available at http://www.winimage.com/zLibDll/unzip.html and also in the contrib/minizip directory of zlib.

Notes for some targets:
- To build a Windows DLL version, include in a DLL project zlib.def, zlib.rc and all .c files except example.c and minigzip.c; compile with -DZLIB_DLL
The zlib DLL support was initially done by Alessandro Iacopetti and is now maintained by Gilles Vollant <info@winimage.com>. Check the zlib DLL home page at
http://www.winimage.com/zLibDll
From Visual Basic, you can call the DLL functions which do not take a structure as argument: compress, uncompress and all gz* functions.
See contrib/visual-basic.txt for more information, or get
http://www.tcfb.com/dowseware/cmp-z-it.zip
- For 64-bit Irix, deflate.c must be compiled without any optimization. With -O, one libpng test fails. The test works in 32 bit mode (with the -n32 compiler flag). The compiler bug has been reported to SGI.
- zlib doesn't work with gcc 2.6.3 on a DEC 3000/300LX under OSF/1 2.1 it works when compiled with cc.
- on Digital Unix 4.0D (formely OSF/1) on AlphaServer, the cc option -std1 is necessary to get gzprintf working correctly. This is done by configure.
- zlib doesn't work on HP-UX 9.05 with some versions of /bin/cc. It works with other compilers. Use "make test" to check your compiler.

- gzdopen is not supported on RISCOS, BEOS and by some Mac compilers.

- For Turbo C the small model is supported only with reduced performance to avoid any far allocation; it was tested with -DMAX_WBITS=11 -DMAX_MEM_LEVEL=3

- For PalmOs, see http://www.cs.uit.no/~perm/PASTA/pilot/software.html Per Harald Myrvang <perm@stud.cs.uit.no> Acknowledgments:

The deflate format used by zlib was defined by Phil Katz. The deflate and zlib specifications were written by L. Peter Deutsch. Thanks to all the people who reported problems and suggested various improvements in zlib; they are too numerous to cite here.

Copyright notice:

(C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.

   Jean-loup Gailly Mark Adler
   jloup@gzip.org madler@alumni.caltech.edu

If you use the zlib library in a product, we would appreciate *not* receiving lengthy legal documents to sign. The sources are provided for free but without warranty of any kind. The library has been entirely written by Jean-loup Gailly and Mark Adler; it does not include third-party code.

If you redistribute modified sources, we would appreciate that you include in the file ChangeLog history information documenting your changes.
Progress OpenEdge v11.3 may incorporate International Classes for Unicode (International Components for Unicode) v2.4 from IBM. Such technology is subject to the following terms and conditions: ICU License - The ICU project is licensed under the X License (see also the x.org original), which is compatible with GPL but non-copyleft. The license allows ICU to be incorporated into a wide variety of software projects using the GPL license. The X license is compatible with the GPL, while also allowing ICU to be incorporated into non-open source products. License ICU License - ICU 1.8.1 and later COPYRIGHT AND PERMISSION NOTICE Copyright (c) 1995-2003 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective owners.

Progress OpenEdge v11.3 may incorporate International Components for Unicode v4.8.0. Such technology is subject to the following terms and conditions: ICU License - ICU 1.8.1 and later COPYRIGHT AND PERMISSION NOTICE Copyright (c) 1995-2011 International Business Machines Corporation and others All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, provided that the above copyright notice(s) and this permission notice appear in all copies of the Software and that both the above copyright notice(s) and this permission notice appear in supporting documentation. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE. Except as contained in this notice, the name of a copyright holder shall not be used in advertising or otherwise to promote the sale, use or other dealings in this Software without prior written authorization of the copyright holder.

All trademarks and registered trademarks mentioned herein are the property of their respective owners.
Progress OpenEdge v11.3 may incorporate java.net args4j v2.0.12 from Kohsuke Kawaguchi. Such technology is subject to the following terms and conditions: Copyright (c) 2003, Kohsuke Kawaguchi All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: * Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. * Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate Jaxen v1.1-beta-3 from jaxen.org. Such technology is subject to the following terms and conditions: Project License $Id: LICENSE.txt 1128 2006-02-05 21:49:04Z elharo $ Copyright 2003-2006 The Werken Company. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Jaxen Project nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Jing 20030619 portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Jing Copying Conditions. Copyright (c) 2001-2003 Thai Open Source Software Center Ltd. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Thai Open Source Software Center Ltd nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. Third-party JARs - This distribution includes some additional JAR files, which have their own copying conditions:

- **saxon.jar** Comes from the Saxon 6.5.2 distribution and is covered by these conditions
- **xercesImpl.jar** Comes from the Xerces-J 2.4.0 distribution and are covered by the Apache Software License
- **isorelax.jar** Comes from ISO RELAX 2003/01/08 distribution and is covered by the following license: Copyright (c) 2001-2002, SourceForge ISO-RELAX Project (ASAMI Tomoharu, Daisuke Okajima, Kohsuke Kawaguchi, and MURATA Makoto) Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
Progress OpenEdge v11.3 may incorporate Sun's Jmaki framework v1.0 and Sun's Jmaki framework v1.0.3 from Sun Microsystems, Inc. Such technology is subject to the following terms and conditions: Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate Jmaki framework v1.8.0 from Sun Microsystems, Inc. Such technology is subject to the following terms and conditions: Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: * Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. * Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.
Progress OpenEdge v11.3 may incorporate JSTL v1.0 from Sun Microsystems, Inc. Such technologies are subject to the following terms and conditions: Code sample License Copyright 1994-2006 Sun Microsystems, Inc. All Rights Reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistribution of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistribution in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of Sun Microsystems, Inc. or the names of contributors may be used to endorse or promote products derived from this software without specific prior written permission. This software is provided "AS IS," without a warranty of any kind. ALL EXPRESS OR IMPLIED CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT, ARE HEREBY EXCLUDED. SUN MICROSYSTEMS, INC. ("SUN") AND ITS LICENSORS SHALL NOT BE LIABLE FOR ANY DAMAGES SUFFERED BY LICENSEE AS A RESULT OF USING, MODIFYING OR DISTRIBUTING THIS SOFTWARE OR ITS DERIVATIVES. IN NO EVENT WILL SUN OR ITS LICENSORS BE LIABLE FOR ANY LOST REVENUE, PROFIT OR DATA, OR FOR DIRECT, INDIRECT, SPECIAL, CONSEQUENTIAL, INCIDENTAL OR PUNITIVE DAMAGES, HOWEVER CAUSED AND REGARDLESS OF THE THEORY OF LIABILITY, ARISING OUT OF THE USE OF OR INABILITY TO USE THIS SOFTWARE, EVEN IF SUN HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. You acknowledge that this software is not designed, licensed or intended for use in the design, construction, operation or maintenance of any nuclear facility.

Progress OpenEdge v11.3 may incorporate Looks v2.1.2 from JGoodies. Such technology is subject to the following terms and conditions: The BSD License for the JGoodies Looks - Copyright (c) 2001-2007 JGoodies Karsten Lentzsch. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: o Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of JGoodies Karsten Lentzsch nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate OpenSSL v0.9.8 from The OpenSSL Project. Such technology is subject to the following terms and conditions: OpenSSL License. Copyright (c) 1998-2006 The OpenSSL Project. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)."
4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact openssl-core@openssl.org.
5. Products derived from this software may not be called "OpenSSL" nor may "OpenSSL" appear in their names without prior written permission of the OpenSSL Project.
6. Redistributions of any form whatsoever must retain the following acknowledgment: "This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://www.openssl.org/)." THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

OpenSSL includes cryptographic software written by Eric Young (eay@cryptsoft.com). This product includes software written by Tim Hudson (tjh@cryptsoft.com). Original SSLeay License. Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com) All rights reserved. This package is an SSL implementation written by Eric Young (eay@cryptsoft.com). The implementation was written so as to conform with Netscapes SSL. This library is free for commercial and non-commercial use as long as the following conditions are aheared to. The following conditions apply to all code found in this distribution, be it the RC4, RSA, LHash, DES, etc., code; not just the SSL code. The SSL documentation included with this distribution is covered by the same copyright terms except that the holder is Tim Hudson (tjh@cryptsoft.com). Copyright remains Eric Young's, and as such any Copyright notices in the code are not to be removed. If this package is used in a product, Eric Young should be given attribution as the author of the parts of the library used. This can be in the form of a textual message at program startup or in documentation (online or textual) provided with the package. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer, in the documentation and/or other materials provided with the distribution.
3. All advertising materials mentioning features or use of this software must display the following acknowledgement: "This product includes cryptographic software written by Eric Young (eay@cryptsoft.com)." The word 'cryptographic' can be left out if the routines from the library being used are not cryptographic related :-). 4. If you include any Windows specific code (or a derivative thereof) from the apps directory (application code) you must include an acknowledgement: "This product includes software written by Tim Hudson (tjh@cryptsoft.com)." THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. The licence and distribution terms for any publicly available version or derivative of this code cannot be changed. i.e. this code cannot simply be copied and put under another distribution licence [including the GNU Public Licence.]

Progress OpenEdge v11.3 may incorporate Quartz Enterprise Job Scheduler v1.3.2 from James House. Such technologies are subject to the following terms and conditions: Copyright James House (c) 2001-2003 All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. THIS SOFTWARE IS PROVIDED BY THE AUTHOR AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION). HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate relaxngDatatype.jar portion of Progress Extensions for Eclipse v2.2. Such technology is subject to the following terms and conditions: Copyright (c) 2001, Thai Open Source Software Center Ltd, Sun Microsystems. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the names of the copyright holders nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate SLF4J v1.6.2 and SLF4J Log4J v1.6.1 from sfl4j.org. Such technology is subject to the following terms and conditions: Copyright (c) 2004-2008 QOS.ch All rights reserved. Permission is hereby granted, free of charge, to any person obtaining a copy of this software and associated documentation files (the "Software"), to deal in the Software without restriction, including without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the following conditions: The above copyright notice and this permission notice shall be included in all copies or substantial portions of the Software. THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

Progress OpenEdge v11.3 may incorporate STAX API (JSR 173) v3.1.1 from Woodstox Project. Such technology is subject to the following terms and conditions: Copyright (c) 2004-2010, Woodstox Project (http://woodstox.codehaus.org/) All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.
2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.
3. Neither the name of the Woodstox XML Processor nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate Trang 20030619 portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Copyright (c) 2002, 2003 Thai Open Source Software Center Ltd. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of the Thai Open Source Software Center Ltd nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate xpp3-1.1.3.4.O portion of Progress Extensions for Eclipse v2.2.1. Such technology is subject to the following terms and conditions: Indiana University Extreme! Lab Software License Version 1.1.1 Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment:

   "This product includes software developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/)." Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear.

4. The names "Indiana University" and "Indiana University Extreme! Lab" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/.

5. Products derived from this software may not use "Indiana University" name nor may "Indiana University" appear in their name, without prior written permission of the Indiana University.

THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Appendix A: Third-party acknowledgments

Progress OpenEdge v11.3 may incorporate Xpp3 v1.1.3.4 from Indiana University. Such technology is subject to the following terms and conditions: Indiana University Extreme! Lab Software License Version 1.1.1 Copyright (c) 2002 Extreme! Lab, Indiana University. All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. The end-user documentation included with the redistribution, if any, must include the following acknowledgment: “This product includes software developed by the Indiana University Extreme! Lab (http://www.extreme.indiana.edu/).” Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party acknowledgments normally appear. 4. The names "Indiana University" and "Indiana University Extreme! Lab" must not be used to endorse or promote products derived from this software without prior written permission. For written permission, please contact http://www.extreme.indiana.edu/. 5. Products derived from this software may not use "Indiana University" name nor may "Indiana University" appear in their name, without prior written permission of the Indiana University. THIS SOFTWARE IS PROVIDED "AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHORS, COPYRIGHT HOLDERS OR ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate XStream v1.3.1 from XStream. Such technology is subject to the following terms and conditions: Copyright (c) 2003-2006, Joe Walnes Copyright (c) 2006-2007, XStream Committers All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of XStream nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate YAJL v0.4.0 from Lloyd Hilaiel. Such technology is subject to the following terms and conditions: Copyright 2007, Lloyd Hilaiel. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. 2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. 3. Neither the name of Lloyd Hilaiel nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Progress OpenEdge v11.3 may incorporate GNU ZLIB v1.1.4 and GNU ZLIB v1.2.3 from Jean-loup Gailly & Mark Adler. Such technology is subject to the following terms and conditions: Copyright notice: (C) 1995-2002 Jean-loup Gailly and Mark Adler This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this software. Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the following restrictions: 1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, an acknowledgment in the product documentation would be appreciated but is not required. 2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software. 3. This notice may not be removed or altered from any source distribution.

Jean-loup Gailly
Mad Adler
jloup@gzip.org madler@alumni.caltech.edu

Progress OpenEdge v11.3 may incorporate ZLIB.NET Free v1.0.4 from ComponentAce. Such technology is subject to the following terms and conditions: Copyright (c) 2006-2007, ComponentAce http://www.componentace.com All rights reserved. Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution. Neither the name of ComponentAce nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
Progress OpenEdge v11.3 may incorporate LALR Parser Generator in Java v0.10k. Such technology is subject to the following terms and conditions: CUP Parser Generator Copyright Notice, License, and Disclaimer – Copyright 1996-1999 by Scott Hudson, Frank Flannery, C. Scott Ananian - Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby granted, provided that the above copyright notice appear in all copies and that both the copyright notice and this permission notice and warranty disclaimer appear in supporting documentation, and that the names of the authors or their employers not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. The authors and their employers disclaim all warranties with regard to this software, including all implied warranties of merchantability and fitness. In no event shall the authors or their employers be liable for any special, indirect or consequential damages or any damages whatsoever resulting from loss of use, data or profits, whether in an action of contract, negligence or other tortious action, arising out of or in connection with the use or performance of this software.

Progress OpenEdge v11.3 includes the RSA Data Security, Inc. MD5 Message-Digest Algorithm. Copyright ©1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. (MD5 Encryption Library v3.0 and MD5 Encryption vMD5C.C) These technologies are subject to the following terms and conditions: RSA Data Security MD5 message-digest algorithm RSA Data Security, Inc. MD5C.C - RSA Data Security, Inc., MD5 message-digest algorithm Copyright (C) 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved. License to copy and use this software is granted provided that it is identified as the "RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material mentioning or referencing this software or this function. License is also granted to make and use derivative works provided that such works are identified as "derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material mentioning or referencing the derived work. RSA Data Security, Inc. makes no representations concerning either the merchantability of this software or the suitability of this software for any particular purpose. It is provided "as is" without express or implied warranty of any kind. These notices must be retained in any copies of any part of this documentation and/or software.
This is a listing of common Business Process Server terminology. For a full version of terms used in Business Process Server documentation, refer to the OpenEdge Business Process Server: Terminology Guide.

**ACL manager**
In Business Process Server, Access Control List Manager provides a finer, more precise control over user access rights for resources and actions.

**Activity workstep**
In Business Process, the basic unit of work; must be performed by one or more human performers (valid individual user, multiple users or user group).

**Adapter**
A Java class that integrates remote, third party classes and actions with Business Process. An adapter can automate certain functions and tasks performed by a remote server or other external systems.

**Administration**
A module in Business Process Portal enabling the administrator to perform tasks such as installing/uninstalling applications, modifying configuration parameters controlling Business Process operations, and manage users, groups and access control. The Administration module is visible only to application users who have permissions to access it.

**Application**
In Business Process, an application is an installed, executable business process that automates a business flow.

**Balanced scorecard**
A management application in the Management module that measures performance by analyzing how an organization’s business activities help it achieve its strategic goals. The Balanced Scorecard provides an analysis from a range of perspectives.

**BAM**
Business Activity Management combines Business process management with strategic and analytical information on specific business performance indicators, providing real-time status information and identifying critical events to assist senior management in making informed business decisions.

**BP Server**
A Business Process Server component that provides a flexible, lightweight, scalable workflow process engine for intranets, extranets, and the Internet.

**BPM Events**
A Business Process Server component that provides an open event-driven rule engine to formulate and enforce policies in business applications.
<table>
<thead>
<tr>
<th><strong>Glossary</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BPM Workflow</strong></td>
</tr>
<tr>
<td><strong>BPEL</strong></td>
</tr>
<tr>
<td><strong>BPMN</strong></td>
</tr>
<tr>
<td><strong>Business Process Portal</strong></td>
</tr>
<tr>
<td><strong>Progress Developer Studio for OpenEdge</strong></td>
</tr>
<tr>
<td><strong>Business calendar</strong></td>
</tr>
<tr>
<td><strong>Business flow</strong></td>
</tr>
<tr>
<td><strong>Business logic</strong></td>
</tr>
<tr>
<td><strong>Business Process Server application</strong></td>
</tr>
<tr>
<td><strong>Business Process Server Web services</strong></td>
</tr>
<tr>
<td><strong>Business object</strong></td>
</tr>
<tr>
<td><strong>Business process</strong></td>
</tr>
<tr>
<td><strong>Business process management</strong></td>
</tr>
<tr>
<td><strong>Business rule</strong></td>
</tr>
<tr>
<td><strong>Control flow</strong></td>
</tr>
<tr>
<td><strong>Dashboard</strong></td>
</tr>
<tr>
<td><strong>Dataslot</strong></td>
</tr>
<tr>
<td><strong>Expression editor</strong></td>
</tr>
<tr>
<td><strong>Group</strong></td>
</tr>
<tr>
<td><strong>Heatmap</strong></td>
</tr>
<tr>
<td><strong>Home</strong></td>
</tr>
<tr>
<td><strong>Infopad</strong></td>
</tr>
<tr>
<td><strong>Instance</strong></td>
</tr>
<tr>
<td><strong>KPI</strong></td>
</tr>
<tr>
<td><strong>Management</strong></td>
</tr>
<tr>
<td><strong>Managed adapter</strong></td>
</tr>
</tbody>
</table>
| **Migration** | The process of moving from the use of one operating environment to another operating environment that is typically seen as improvement. Migration can involve moving to new hardware, new software, or both. It may involve a
new application, another type of database, or a redesigned network. Migration is also used to refer simply to the process of moving data from one storage device to another. Business Process Server supports data migration as well as application migration.

**Performer**
An entity that executes a workstep. Depending on the workstep type, the performer can be a human user, a group of users, an adapter or other external performer, or a script.

**Presentation flow**
The flow of information and user input from one interface to the next. Typically related to a single Activity workstep in the process and generated in a BPM Workflow environment.

**Process engine**
Orchestrates the execution of business processes and also coordinates conversations among process engines based on public processes, which forms the backbone of global business collaboration.

**Business Process Modeler**
A stand-alone component that enables users to design templates for basic business processes.

**Process refresh**
A Business Process Server feature for replacing the installed process without versioning, facilitating the running process instances to refresh and seamlessly adapt to the new workflow.

**Process template**
In Business Process Server, a model of business flow that includes worksteps, connectors and dataslots. After users publish and install it as an application in Business Process Server folder structure, they can use the application to create process instances.

**Rollback**
In Business Process Server, a feature that restarts the workflow from a workstep previously selected as the rollback point in the process, performed automatically in the event of a failure.

**Role**
The actions and activities assigned to a valid application user who is a member of a group. In Business Process Server, only members of a group can be assigned a role. A role indicates the relationships of the user in a group context.

**Rule wizard**
An interactive utility that enables application users to quickly develop rules that can be applied to a business process.

**Swim lanes**
Used in workflow diagrams to organize complex processes across functional boundaries. For example, seen as horizontal lines on a process map, swim lanes can be used to place individual task steps into different categories that depend on task ownership.

**Task**
In Business Process Server, a performer is assigned one or more work items that the performer sees as tasks. There are two types of tasks: Assigned, which are assigned specifically to you; and Available, which are available to be performed by you or other members of your user group.

**User**
In Business Process Server, a valid human performer with authorized access to specific modules.

**Workflow**
The logical sequence of activities performed by human performers. Workflow includes the tasks, procedural steps, organizations or people involved, required input and output information, and tools needed for each activity in a business process.